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1: Introduction 
1.1 Preface 

Read all this information carefully before installation and operation. Follow all warnings 
and precautions as stated in this manual. Keep this manual available during procedures. 
Physicians should tell patients about all potential risks and adverse events described in 
this manual with respect to the operation of the system. 

1.2 Intended Use 
 

 

 Caution: Federal law restricts this device to sale by or on the order of a physician. 
   

The Affirm® prone biopsy system is intended for lesion location for biopsy while the 
patient is in the prone position to provide guidance for interventional purposes (such as 
biopsy, pre-surgical localization or treatment devices). 

1.2.1 Indications for Use 
The Affirm prone biopsy system combines the function of a standard x-ray 
mammography unit with that of a lesion localization system to produce a device that has 
specific application in first accurately localizing lesions in the breast in two and/or three 
dimensions, and then providing guidance for interventional purposes (such as biopsy, 
pre-surgical localization or treatment devices) for lesions determined to be suspicious 
through prior mammographic examination. 

1.2.2 Contraindications 
• Patient weighs more than 181 kg (400 pounds). 
• Inability to visualize the lesion under mammographic imaging. 
• Patient cannot remain in a prone position during the entire procedure. 

 

1.3 Essential Performance 
The essential performance requirements of the Affirm prone biopsy system is as defined 
in IEC-60601-2-45: 2005. These include: accuracy of loading factors, automatic control 
system, imaging performance, missed tissue at chest wall side, breast compression 
device, linearity of air kerma over limited intervals of loading factors, and reproducibility 
of the X-radiation output. 

Chapter 1 
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1.4 System Capabilities 
The Affirm prone biopsy system is a tomosynthesis-capable mammography system for 
performing breast biopsies on patients lying in the prone position. The system localizes 
suspicious lesions, as determined through prior mammographic examinations, using 
either stereotactic or tomosynthesis techniques. The system then affords a physician the 
capacity of performing vacuum-assisted needle core biopsy or needle (wire) localization 
of the lesion. 

Localization can be accomplished either via conventional stereotactic imaging, or by 
examination of a tomosynthesis data set. With tomosynthesis, the image plane or “slice” 
most fully containing the suspected lesion is chosen by the physician from the data set to 
identify the lesion depth within the breast. 

1.5 User Profiles 

1.5.1 Mammography Technologist 
• Meets all requirements that apply to the location in which the Mammography 

Technologist operates. 
• Completed training on the mammography system. 
• Has training in mammography positions. 
• Understands stereotactic breast biopsy procedures. 
• Understands how to operate a computer and its peripherals. 
• Understands sterile procedures. 

 

1.5.2 Radiologists, Surgeons 
• Meets all requirements that apply to the location in which the Physician operates. 
• Understands stereotactic breast biopsy procedures. 
• Understands how to operate a computer and its peripherals. 
• Understands sterile procedures. 
• Gives local anesthesia. 
• Understands basic surgical procedures for core biopsy. 

 

1.5.3 Medical Physicist 
• Meets all requirements that apply to the location in which the Medical Physicist 

operates. 
• Understands mammography. 
• Has experience with digital imaging. 
• Understands how to operate a computer and its peripherals. 
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1.6 Training Requirements 
In the United States, users must be Registered Radiologic Technologists meeting criteria 
to perform mammography. The mammography users must meet all applicable MQSA 
personnel requirements under FDA guidelines for conventional and digital 
mammography. 

The user has options available for training, which include but are not limited to: 

• Onsite applications training by a Hologic Clinical Services Specialist 
• Onsite on the job training also known as peer training  

Additionally, the user manual is a guide for directions on how to use the system. 

All users must make sure that they receive training on correct operation of the system 
before use on patients. 

Hologic does not accept the responsibility for injury or damage from incorrect system 
operation. 

1.7 Quality Control Requirements 
Perform all Quality Control tests within the correct time frame. 

1.8 Warranty Statement 
Except as otherwise expressly stated in the Agreement: i) Equipment manufactured by 
Hologic is warranted to the original Customer to perform substantially in accordance 
with published product specifications for one (1) year starting from the date of shipment, 
or if Installation is required, from the date of Installation (“Warranty Period”); ii) digital 
imaging mammography x-ray tubes are warranted for twenty-four (24) months, during 
which the x-ray tubes are fully warranted for the first twelve (12) months and are 
warranted on a straight-line prorated basis during months 13-24; iii) replacement parts 
and remanufactured items are warranted for the remainder of the Warranty Period or 
ninety (90) days from shipment, whichever is longer; iv) consumable Supplies are 
warranted to conform to published specifications for a period ending on the expiration 
date shown on their respective packages; v) licensed Software is warranted to operate in 
accordance with published specifications; vi) Services are warranted to be supplied in a 
workman-like manner; vii) non-Hologic Manufactured Equipment is warranted through 
its manufacturer and such manufacturer’s warranties shall extend to Hologic’s 
customers, to the extent permitted by the manufacturer of such non-Hologic 
Manufactured Equipment. Hologic does not warrant that use of Products will be 
uninterrupted or error-free, or that Products will operate with non-Hologic authorized 
third-party products. These warranties do not apply to any item that is: (a) repaired, 
moved, or altered other than by Hologic authorized service personnel; (b) subjected to 
physical (including thermal or electrical) abuse, stress, or misuse; (c) stored, maintained, 
or operated in any manner inconsistent with applicable Hologic specifications or 
instructions, including Customer’s refusal to allow Hologic recommended Software 
upgrades; or (d) designated as supplied subject to a non-Hologic warranty or on a pre-
release or “as-is” basis. 
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1.9 Technical Support 
Refer to the copyright page of this manual for contact information for product support. 

1.10 Product Complaints 
Report any complaints or problems in the quality, reliability, safety, or performance of 
this product to Hologic. If the device has caused or added to patient injury, immediately 
report the incident to Hologic. 

1.11 Hologic Cybersecurity Statement 
Hologic continuously tests the current state of computer and network security to 
examine possible security problems. When necessary, Hologic provides the updates to 
the product. 

For Cybersecurity Best Practices documents for Hologic products, refer to the Hologic 
Internet site at www.Hologic.com. 

1.12 Symbols 
This section describes the Symbols on this system. 

Symbol Description 

 

Type B Applied Part 

 

Potential Equalization terminal 

 

Protective Earth terminal 

 
"OFF" (power) 

 

"ON" (power) 

 
"OFF" for part of the equipment 

 
"ON" for part of the equipment 

 

Discard electrical and electronic equipment separately from standard 
waste. Send decommissioned material to Hologic or contact your service 
representative. 

http://www.hologic.com/
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Symbol Description 

 
Dangerous Voltage 

 

Manufacturer 

 

Date of Manufacture 

 

This system transmits radio frequency (RF) energy (non-ionizing radiation) 

 

Wi-Fi connection 

 

Caution—Radiation 

 Alternating current 

 

Follow operating instructions 

 

Follow the User Guide 

 

Caution 

 

Fragile, handle with care 

 

Temperature limit 

 

Humidity limitation 

 

Do not immerse in any liquid 

 

No pushing 
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Symbol Description 

 

No stepping on surface 

 

No sitting 

 

Combined weight of the equipment and its safe working load 

 
Authorized representative in the European community 

 
Catalog number 

 
Serial Number 

 

 
 

1.13 Descriptions of Warnings, Cautions, and Notes 
Descriptions of Warnings, Cautions, and Notes used in this manual: 

 
WARNING! 
The procedures that you must follow accurately to prevent possible 
dangerous or fatal injury. 

 

   
 

 

 
Warning: 
The procedures that you must follow accurately to prevent injury. 

 

   
 

 

 
Caution: 
The procedures that you must follow accurately to prevent damage to equipment, 
loss of data, or damage to files in software applications. 

 

   
 

 

 

Note 
Notes show additional information. 
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2: General Information 
2.1 System Overview 

 

 
Figure 1: Affirm Prone Biopsy System 

Figure Legend 

 1. Gantry 

2. Patient Support Platform 

3. C-Arm 

4. Acquisition Workstation 

5. Accessory Cart 

6. High Voltage Generator 
 

 

 

Note 
A radiation shield is not provided with the Affirm prone biopsy system. 

 

   
 

 

Note 
The Acquisition Workstation has wheels for ease of positioning only. The system is 
NOT a mobile unit. 

 

   
 
 

Chapter 2 
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2.1.1 C-Arm Overview 
 

 
Figure 2: C-arm Overview 

 Figure Legend 

1. Compression Arm 

2. Biopsy Arm 

3. Biopsy Device 

4. Tubehead 

5. C-arm Rotation Handle 

6. Biopsy Control Module Display 

7. Control Handle 

8. Image Receptor 

 

 
   

 



Affirm Prone Biopsy System Service Manual 
Chapter 2: General Information 

 
 
 
 

 
MAN-04482 Revision 006 Page 9 
 

2.2 Safety Information 
Read and understand this manual before you use the system. Keep the manual available 
during the patient procedures. 

Always follow all the instructions in this manual. Hologic does not accept the 
responsibility for injury or damage from incorrect system operation. Hologic can 
schedule training at your facility. 

The system has protective devices, but the Technologist must understand how to safely 
use the system. The Technologist must remember the health hazards of x rays. 

2.3 Warnings and Precautions 
 

 

 

This system is classified as CLASS I, TYPE B APPLIED PART, IPX0, permanently 
connected equipment, continuous operation with short term loading per IEC 60601-1. 
There are no special provisions to protect the system from flammable anesthetics or 
ingress of liquids. 

 

   
 

 APPLIED PARTS include Compression Paddles, Breast Platform, and Patient Platform. 
 

   
 

 

 
WARNING! 
Risk of electric shock. Only connect this equipment to supply mains 
with Protective Earth. 

 

   
 

 
WARNING! 
For North American electrical safety requirements, use a Hospital 
Grade receptacle to supply a correct Ground. 

 

   
 

 
WARNING! 
Electrical equipment used near flammable anesthetics can cause an 
explosion. 

 

   
 

 
WARNING! 
To correctly isolate the system, attach only approved accessories or 
options to the system. Only approved personnel can change the 
connections. 
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WARNING! 
Keep a 1.5 meter safe distance between the patient and any non-patient 
devices. 
Do not install non-patient system components (like the Workflow 
Manager, a diagnostic review workstation, or a hard copy printer) in 
the Patient Area. 

 

   
 

 
WARNING! 
Keep a 1.5 meter safe distance between the patient platform and the 
acquisition workstation. 

 

   
 
 

 
WARNING! 
Only trained Service Engineers authorized through Hologic can open 
any of the panels. This system contains lethal voltages. 

 

   
 

 
WARNING! 
The user must correct problems before the system is used. Contact an 
approved service representative for preventive maintenance. 

 

   
 

 
WARNING! 
After power failure, remove the patient from the system before you 
apply power. 

 

 
 
 

 
Warning: 
This device contains dangerous material. Send decommissioned material to 
Hologic or contact your service representative. 

 

   
 

 
Warning: 
C-arm movement is motorized. 

 

   
 

 
Warning: 
You increase the patient dose to high levels when you increase the AEC 
exposure adjustment. You increase the image noise or decrease image quality 
when you decrease the AEC exposure adjustment. 

 

   
 

 
Warning: 
Control the access to the equipment according to local regulations for 
radiation protection. 
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Warning: 
The disk drives installed in this system are a Class I Laser Product. Prevent 
direct exposure to the beam. Hidden laser radiation exists if the case to a disk 
drive is open. 

 

   
 

 
Warning: 
Keep your full body behind the radiation shield during the exposure. 

 

   
 

 
Warning: 
Do not move the C-arm while the system retrieves the image. 

 

   
 
 

 
Warning: 
If a paddle touches possible infectious materials, contact your Infection 
Control Representative to remove contamination from the paddle. 

 

   
 

 
Warning: 
Do not leave the patient unattended during the procedure. 

 

   
 

 
Warning: 
Keep the hands of the patient away from all buttons and switches at all times. 

 

   
   

 
Warning: 
Place each footswitch in a position where, when used, they remain in reach of 
the Emergency Off Switches. 

 

   
 

 
Warning: 
Position the footswitches to prevent accidental operation by a patient or 
wheelchair. 

 

   
 

 
Warning: 
To prevent a higher radiation dose to the patient, only put approved 
materials in the x-ray beam path. 

 

   
 

 
Warning: 
This system can be dangerous to the patient and the user. Always follow the 
safety precautions for x-ray exposures. 

 

   
 

 
Warning: 
Use protective radiation shielding with a lead equivalent of more than .08 
mm. 
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Warning: 
Do not sit on or step on the generator. 

 

   
 
 

 
Caution: 
The system is a medical device and not a normal computer. Only make approved 
changes to the hardware or software. Install this device behind a firewall for network 
security. The computer virus protection or network security for this medical device is 
not supplied (for example, a computer firewall). The network security and anti-virus 
provisions are the responsibility of the user. 

 

   
 

 
Caution: 
Do not turn off the Acquisition Workstation circuit breaker except in emergency. The 
circuit breaker can turn off the Uninterruptible Power Supply (UPS) and risk data 
loss. 

 

   
 

 
Caution: 
Risk of data loss. Do not put any magnetic media near or on devices that create any 
magnetic fields. 

 

   
 

 
Caution: 
Do not use any heat source (like a heating pad) on the image receptor. 

 

   
 

 
Caution: 
Do not block or cover the fan ports located on the rear cover of the Digital Image 
Receptor. 

 

   
 

 
Caution: 
To prevent possible damage from thermal shock to the Digital Image Receptor, 
follow the recommended procedure to turn off the equipment. 

 

   
 

 
Caution: 
The display is calibrated for compliance to DICOM standards. Do not make any 
brightness or contrast adjustments to the display. 

 

   
 

 
Caution: 
Use the least possible amount of cleaning fluids. The fluids must not flow or run. 

 

   
 

 
Caution: 
To prevent damage to the electronic components, do not use disinfectant sprays on 
the system. 



Affirm Prone Biopsy System Service Manual 
Chapter 2: General Information 

 
 
 
 

 
MAN-04482 Revision 006 Page 13 
 

 

   
 
 

2.4 Emergency Off Switches 
A red Emergency Off (E-Stop) switch is located on each side of the tube arm and on the 
x-ray remote control. The Emergency Off switch disables C-arm and Patient Platform 
movement and removes power from the Gantry. 

Do NOT use the E-Stop switches for routine system shutdown. 

 
Figure 3: Emergency Off Switch 

Functionality 

 

1. Press any of the Emergency Off switches to power 
OFF the Gantry. 

2. To reset the Emergency Off switch, turn clockwise 
approximately one-quarter turn until the switch 
pops back out. 

 

 
 

2.5 Interlocks 
• The electronic System Lock only allows C-arm movement when the System Lock 

button on the Control Handle is in unlocked mode. 
• The system does not allow x-ray exposure unless in a Ready state and the System 

Lock button on the Control Handle is in locked mode. 
• If the x-ray button is released before the end of the exposure, the exposure stops and 

an alarm message shows. 
• The system does not enter a Ready state following an exposure until the x-ray button 

is released. 
 

2.6 Compliance 
This section describes the system compliance requirements and the responsibilities of the 
manufacturer. 

2.6.1 Compliance Requirements 
The manufacturer has the responsibility for the safety, reliability, and performance of this 
equipment with the following provisions: 

• The electrical installation of the room meets all requirements. 
• The equipment is used according to the User Guide. 
• The assembly operations, extensions, adjustments, changes, or repairs are performed 

only by authorized persons. 
• The network and communication equipment is installed to meet IEC Standards. The 

complete system (network and communications equipment and the Affirm Prone 
Biopsy System) must be in compliance with IEC 60601-1. 
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Caution: 
Medical Electrical Equipment needs special precautions about EMC and must be 
installed, put into service and used according to the EMC information provided. 

 

   
 

 
Caution: 
Portable and mobile RF communications can affect medical electrical equipment. 

 

   
 

 
Caution: 
The use of unauthorized accessories and cables can result in increased emissions or 
decreased immunity. To keep the isolation quality for the system, attach only 
approved Hologic accessories or options to the system. 

 

   
 

 
Caution: 
The Medical Electrical (ME) Equipment or ME System should not be used adjacent to 
or stacked with other equipment. If adjacent or stacked use is necessary, make sure 
that the ME Equipment or ME System operates correctly in this configuration. 

 

   
 

 
Caution: 
This system is intended for use by healthcare professionals only. This system may 
cause radio interference or may disrupt the operation of nearby equipment. It may be 
necessary to take mitigation measures, such as re-orienting or relocating the 
equipment or shielding the location. 

 

   
 

 
Caution: 
Changes or modifications not expressly approved by Hologic could void your 
authority to operate the equipment. 

 

   
 

 
Caution: 
This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense. 

 

   
 



Affirm Prone Biopsy System Service Manual 
Chapter 2: General Information 

 
 
 
 

 
MAN-04482 Revision 006 Page 15 
 

2.6.2 Compliance Statements 
The manufacturer states this device is made to meet the following requirements. 

IEC: 

• IEC 60601-1: 2005 - Medical Electrical Equipment, Part 1: General requirements for 
basic safety and essential performance 

• IEC 60601-1-2: 2007 - Collateral standard: Electromagnetic compatibility - 
Requirements and tests 

• IEC 60601-1-3: 2008 - General requirements for radiation protection in diagnostic x-
ray equipment 

• IEC 60601-1-6: 2010 - Collateral Standard: Usability 
• IEC 60601-2-28: 2010 - Particular requirements for the basic safety and essential 

performance of x-ray tube assemblies for medical diagnosis 
• IEC 60601-2-45: 2011 - Particular requirements for the basic safety and essential 

performance of mammographic x-ray equipment and mammographic stereotactic 
devices 

FDA: 

• 21 CFR §900 – Mammography Quality Standards Act (MQSA) 
• 21 CFR §1020.30 – Diagnostic x-ray systems and their major components 
• 21 CFR §1020.31 – Radiographic equipment 
CE: 

• 93/42/EEC – CE marking according to MDD 
• 2006/42/EC – Machinery Directive of 17 May 2006 
• 2002/95/EC – Restriction of Hazardous Substances Directive of 27 January 2003 
• 2002/96/EC – Waste Electrical and Electronic Equipment Directive of 27 January 2003 
CAN/CSA: 

• CAN/CSA-C22.2 No. 60601-1 (2008): Medical electrical equipment - Part 1: General 
requirements for safety 

ANSI/AAMI: 

• ANSI/AAMI ES60601-1 (2005) - Medical electrical equipment— Part 1: General 
requirements for basic safety and essential performance 
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2.7 Label Locations 
 

 
Figure 4: Label Locations 
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Table 1: System Labels 

1 

 
2A 

 

2B 

 

2C 

 

3 

 

4 

 

5 

 
6 

 

7 

 

8 

 
9 
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3: Installation 
3.1 System Installation Overview 

This chapter contains procedures for unpacking, installing, and setting up the Affirm™ 
Prone Biopsy System. Also included are directions for connecting the system to a power 
source, including measuring the voltage of the input power receptacle, and tapping the 
isolation transformer. 

The unpacking procedure consists of inspecting the external package for evidence of 
shipping damage of received goods, and removing the system from the shipping crate. 

Upon receipt of the Affirm system, examine all crates, packages, and boxes for external 
damage that may have occurred during shipment. 

Note any evident damage on the shipping manifest and immediately notify the carrier of 
the incident. If you find shipping damage of a concealed nature, contact the carrier 
immediately and request an Inspection of Shipping Damage. 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

 
 

3.2 Receiving Instructions 
The Affirm Prone Biopsy System is shipped in sections on separate pallets. Each pallet is 
packed with several containers. There are containers for the: 

• Gantry/C-arm Assembly 
• Generator 
• Patient Platform 
• Acquisition Workstation 
• Accessory Cart (optional) 
• Image Detector (shipped separately; not part of any pallets) 

 
 

 

Note 
A Hologic representative must be present at the time of delivery and is responsible for 
unpacking the product. 

 

    
 

 

 

Note 
If there is a discrepancy between the contents received and the packing list or sales 
order, contact Hologic immediately. If there is any damage that has occurred during 
shipping, contact the carrier immediately. If it is necessary to repack any items for 
future installation, use the original packaging materials. 

 

    
 

 

Chapter 3 
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Note 
If shipping damage is concealed, contact the carrier immediately after discovery. 

 

    
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 

At the time of receipt, perform the following steps before opening the containers: 

1. Inspect each container for damage. 
2. Note any damage on the shipping manifest. 
3. Notify Hologic of any external shipping damage that has occurred. 

 

3.2.1 Unpack the Generator 
 

 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

    
 

 

 
Warning: 
To prevent injury to personnel and/or damage to equipment, care must be 
taken when uncrating the equipment. 

 

    
 

 

 
Warning: 
Do not sit on, step on, or push the generator. 

 

   
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 
 

1. While still in the loading area, carefully remove all shipping materials (foam 
padding, tie-downs, straps, shipping wrap, and so on) from around the Generator. 

2. Open all bags/packages stored with the Generator, and check their contents against 
the packing list and sales order. Report all discrepancies immediately. 

3. Inspect each item for damage, then safely store them near the exam site. 
4. Swing down the hinged, wood side panel of the container and carefully roll the 

Generator off the pallet. Roll the Generator from the loading area to the exam area. 
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3.2.2 Unpack the Gantry/C-Arm Assembly 
 

 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

   
 

 

 
Warning: 
To prevent injury to personnel and/or damage to equipment, care must be 
taken when uncrating the equipment. 

 

   
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 

To unpack the Gantry/C-arm assembly from the shipping container: 

1. While still in the loading area, carefully remove all shipping materials (foam 
padding, tie-downs, straps, shipping wrap, and so on) from around the Gantry 
assembly. 

2. Open all boxes removed from around the Gantry assembly, and check their contents 
against the packing list and sales order. Report all discrepancies immediately. 

3. Inspect each item for damage, then safely store them near the exam site. 
4. Use rigging to carefully remove the Gantry assembly from the crate. 
5. Transport the Gantry Assembly from the loading area to the exam area. 
6. Remove the C-arm support braces. 
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3.2.3 Unpack the Patient Platform 
 

 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

    
 

 

 
Warning: 
To prevent injury to personnel and/or damage to equipment, care must be 
taken when uncrating the equipment. 

 

   
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 

1. While still in the loading area, carefully remove all shipping materials (foam 
padding, tie-downs, straps, shipping wrap, and so on) from around the Patient 
Platform. 

2. Open all boxes removed from around the Patient Platform, and check their contents 
against the packing list and sales order. Report all discrepancies immediately. 

3. Inspect each item for damage, then safely store them near the exam site. 
4. Carefully maneuver the Patient Platform off the pallet, and transport it from the 

loading area to the exam area. 
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3.2.4 Unpack the Acquisition Workstation 
The Acquisition Workstation is crated and shipped upright. Most options and accessories 
are preinstalled on the workstation. Items such as the image display monitor, keyboard, 
and mouse are packed separately. These packages may be included in the workstation 
shipping container. The Acquisition Workstation cart comes with four casters mounted 
on the base that can be locked with integral foot brakes. 

 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

   
 

 

 
Warning: 
To prevent injury to personnel and/or damage to equipment, care must be 
taken when uncrating the equipment. 

 

   
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 

To unpack the Acquisition Workstation from the shipping container: 

1. While still in the loading area, carefully remove all shipping materials (foam 
padding, tie-downs, straps, shipping wrap, and so on) from around the workstation 
and wooden pallet. Remove any accessory boxes. 

2. Open all boxes removed from the workstation shipping container, and check their 
contents against the packing list and sales order. Report all discrepancies 
immediately. 

3. Inspect each item for damage, then safely store them near the exam site. 
4. Swing down the hinged, wood side panel of the container. Remove the wooden block 

holding the workstation in place. Unlock the casters, and carefully roll the 
workstation off the pallet. 

5. Place the keyboard and mouse at the desired location on the cart shelf. 
6. Check the display for obvious damage and loose or missing hardware. 
7. Check the control monitor screen surface for nicks, chips, scratches, cracks, or other 

damage. 
8. Check the computer for obvious damage, loose or missing screws, loose or missing 

buttons or switches, and other damage. Check for cables and boards that may have 
become dislodged during shipping. Be sure to reseat boards and connectors if 
necessary. 

9. Move the Acquisition Workstation to the exam area, and then lock the cart in place 
using the foot brakes. 
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3.2.5 Unpack the Accessory Cart 
The accessory cart is crated and shipped upright on its own pallet. The accessory cart 
comes with four casters mounted on the base that can be locked with integral foot brakes. 

 

 
Warning: 
Be sure to have the necessary machinery and personnel available to move 
heavy medical equipment safely. 

 

   
 

 

 
Warning: 
To prevent injury to personnel and/or damage to equipment, care must be 
taken when uncrating the equipment. 

 

   
 

 

 

Note 
Refer to TB-01308 that documents the Affirm Prone system unpacking with more detail 
and illustrations than what is shown in this manual. 

 

 

To unpack the accessory cart from the shipping container: 

1. While still in the loading area, carefully remove all shipping materials (foam 
padding, tie-downs, straps, shipping wrap, and so on) from around the accessory 
cart and wooden pallet. Remove any accessory boxes. 

2. Open all boxes removed from the shipping container, and check their contents 
against the packing list and sales order. Report all discrepancies immediately. 

3. Inspect each item for damage, then safely store them near the exam site. 
4. Lift the accessory cart with the handles (one person one each side) from the crate 

unto the floor. 
5. Move the accessory cart to the exam area, and then lock the cart in place using the 

foot brakes. 
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3.2.6 Unpack the Image Detector 
The image detector is shipped separately from the rest of the system in a temperature-
controlled package. 

 

 
Caution: 
Move the Detector to a controlled area prior to unpacking. 

 

 
 

 
Caution: 
To prevent damage, use extreme care to unpack the image detector. 

 

   
 

 
Caution 
Leave the plastic shipping cover on the detector until actual installation. This plastic 
cover protects the mylar surface (the shiny silver section) from damage. 

 

 
 

 

Note 
If shipping damage is concealed, contact the carrier immediately after discovery. 

 

 

To unpack the detector: 

1. Upon receipt of the detector, move it to a controlled area which meets the 
environmental requirements (see Storage Environment). 

2. Carefully open the multi-layer shipping container and check the contents for 
damage. Report all issues/discrepancies immediately. 

3. Locate and check the temperature logger: 
• If it has a blinking/steady green LED (depends on logger model), that signifies 

the package stayed within the proper temperature range during shipment. 
Continue with step 2. 

• If it has a blinking/steady bold red LED (depends on logger model), that signifies 
the package strayed outside the proper temperature range during shipment. Call 
Hologic Tech Support for the proper follow-up action. 

4. Remove the detector from its container and set aside. Leave the black plastic 
shipping covering on the detector until actual installation. 

5. Locate and set aside the plastic bag containing the detector labels and the detector 
installation hardware. 
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3.3 Setting Up and Installing Components 
The following sections detail setting up, positioning, and installing the system in the 
exam room. 

 

 
Caution: 
Make sure that there is an installed circuit breaker at the Mains that meets the 
following requirements: 

40A Breaker, UL 489, or UL HACR listed 
 

   
 

 

 
Caution 
To avoid image artifacts from occurring: 
• If the system is installed in a mobile coach, care should be exercised not to locate 

or park the mobile coach near sources of high power (such as power transmission 
lines and outdoor transformers). 

• Make sure that any mobile power generator, uninterruptable power system 
(UPS), or voltage stabilizer is at least 3 meters (10 feet) from the closest point of 
the image detector travel. 

 

 

 
 

 

 

Note 
For those installations in regions with a seismic requirement, an Affirm Prone system 
Seismic Kit (ASY-09081) is available. 

 

    
 

 

 

Note 
For mobile installations, refer to MAN-05007, FMI, Affirm Prone, Mobile Installation. 

 

    
 

 

 

Note 
The network and communications equipment must be installed to meet IEC Standards. 
The complete system must be installed to meet IEC 60601-1 and IEC 60601-1-1. 

 

    
 

 

 

Note 
Thoroughly read all procedures before starting the installation. 
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3.3.1 Exam Room Layout 
The following figure displays a typical exam room layout and the minimum clearance 
zones. 

 

 

Note 
The clearance dimensions referenced in the following figure are the minimum for general 
purposes. The customer needs to make sure that all installations meet local regulations. 

 

   
 

 

 

Note 
The system is not equipped with a radiation protection shield for the operator. The room 
must be designed to incorporate local, state, and federal guidelines for shielding. 

 

   

 
Figure 5: Typical Exam Room Layout 

 

Item Description Minimum Clearance 

1 Accessory Cart Customer accessible 

2 Gantry/Patient Platform Assembly • 30.5 cm (12 inches) at the rear 
• 91.4 cm (3 feet) on each side of table for 

head/feet of patient 
• 91.4 cm (3 feet) at front for operator and 

patient access 
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Item Description Minimum Clearance 

3 Generator Service accessible 

4 Radiation Shield (supplied by 
customer) 

Customer accessible 

5 Acquisition Workstation • 30.5 cm (12 inches) at the rear 
• 91.4 cm (3 feet) at front for operator access 

6 Wireway for Mains Circuit Breaker 
(40A Breaker, UL 489, or UL 
HACR listed) and interconnecting 
cables 

Per local regulations 

7 Doorway minimum clearance 91 cm (3 feet) 

8 Equipment-to-wall clearances Consult local regulations (if not specified in 
this table) 

 
   

 

3.3.2 Install the Gantry/Patient Platform Assembly 
Install the Patient Platform on the Gantry Assembly 

 

 
Caution: 
Before installing, make sure that the work area provides ample space to maneuver 
the patient platform into position on the Gantry. After installing, ensure that there is 
enough room around the Patient Platform for patient movement and C-arm rotation 
(refer to Exam Room Layout on page 27). 

 

 
... 

 

 
Warning: 
Lifting and installing the Patient Platform onto the Gantry requires two 
people. 

 

   

1. Move the Gantry into its final installation position. 
2. Remove the shipping dollies and return to Hologic in the container shipped with the 

Gantry. 
3. Remove the Gantry rear cover and inside metal plate (refer to Covers Removal - Gantry 

Section on page 182). 
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4. Locate the two table mounting brackets on top of the Gantry (see item 1 in the 
following figure). For each mounting bracket, loosen the: 
• six 1/8-16 allen hex bolts on top of the brackets 
• three 1/4-20 allen hex bolts on the side of the brackets 
• two 1/4-20 allen hex bolts on the bottom of the brackets 

 
Figure 6: Patient Platform Mounting Brackets on Gantry 

 



Affirm Prone Biopsy System Service Manual 
Chapter 3: Installation 
 

 
Page 30 MAN-04482 Revision 006 
 

5. Remove the two securing pins for the Gantry yellow moving handle and slide the 
moving handle out of the two platform mounting collars/catches. (See the following 
figure). 

6. Place the yellow handle in the return container shipped with the Gantry and return 
to Hologic. 

 
Figure 7: Remove Gantry yellow move handle 
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7. Verify/set the patient platform angle for each patient platform mounting bracket. Use 
TLS-05884 (Table Angle Support Setting Tool) for this procedure. 

a. Place TLS-05884 (item 1 in following figure) inside a mounting bracket flat 
against the mounting surface with the machined notch located above the 
adjustment block (item 2) as shown in the following figure. 

b. Make sure the table adjust plate meets the bottom undercut surface of TLS-05884 
(item 2 in same figure) while remaining flat on the mounting surface. 

 
Figure 8: Tool in place for platform angle verification 
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If it does not, loosen and remove the jam nut (item 1 in following figure). (Early 
models may not have this jam nut.) Adjust the setscrew (1/4", item 2) under the 
jam nut until the table adjust plate meets the bottom undercut surface of TLS-
05884. Lock the setscrew in place with the same jam nut (if available). 

 
Figure 9: Adjusting platform angle (looking from rear of Gantry) 

c.  Repeat steps a - b for the other mounting bracket. 
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8. Using two people, lift and slide the mounting arms of the Patient Platform into the 
platform mounting brackets (see item 1 in the following figure) and platform 
mounting collars/catches (see item 2 in following figure) on top of the Gantry. Make 
sure that the mounting collars/catches are up (as shown in the following figure) 
when sliding the platform into place. 

 

 
Figure 10: Patient Platform Mounting Brackets on Gantry 

Figure Legend 

1. Mounting Brackets 
for Patient Platform 

2. Mounting 
Collars/Catches for 
Patient Platform 

3. C-Arm Transport 
Lock Knob 

4. Spring-Loaded 
Plunger for C-Arm 
Transport Lock 

 

9. While the platform is being held level, tighten all Gantry mounting bolts.  
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10. Locate the C-arm transport locking mechanism in the back of the Gantry and do the 
following: 

a. Loosen the transport lock knob (see item 3 in previous figure). 

b. While loosening the knob, pull the spring-loaded plunger (see item 4 in previous 
figure). 

c. Continue loosening the knob so the locking shaft lowers to the point where it is 
flush with the block of the locking mechanism (as shown in the inset in the 
previous figure). This step allows the C-arm to move after you power up the 
system. 

11. Locate the cable light/platform control harness tucked inside the platform and 
connect it to PLJ2 and PLJ4 on the Patient Platform Control Board (see following 
figure). 

 
Figure 11: Patient Platform Control Board 
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Install the Armrest 
The armrest assembly (part of the Maximum Comfort Package) is shipped preassembled.  

1. Slide the armrest assembly into the armrest assembly holder on the bottom of the C-
arm until you hear it click into place. (See the following figure, item 4). 

2. Position the armrest assembly at the correct angle for the patient and for the C-arm 
(see following figure). 

 

 
Figure 12: Installation and adjustment of Armrest Assembly on C-arm 

Item Description Use 

1 Armrest Rotation Knob Allows you to rotate the armrest 360°. 

2 Armrest Pole Position Knob Allows you to raise/lower the armrest 
pole and rotate the support arm for the 
armrest 360°. 

3 Armrest Bottom Adjust 
Lever 

Allows you to move the armrest in and 
out from the C-arm. 

4 Release Lever for Armrest 
Assembly 

If needed, allows you to release and 
remove the armrest assembly and install 
it on the other side of the control handle. 
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Install the Footswitch 
The footswitch assembly is shipped preassembled. 

1. Place the footswitch assembly on the floor in operating proximity to the 
Gantry/Patient Platform assembly. 

2. Connect the footswitch cable to its designated port on the front base of the 
Gantry/Patient Platform assembly (see following figure). 

 
Figure 13: Installation of Footswitch in front of Gantry/Patient Platform 
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Connect the Gantry Cables 
1. Connect the cables from/to the Generator to the appropriate connectors on the rear of 

the Gantry (see following figure). 
2. Connect the cables from/to the Acquisition Workstation to the appropriate 

connectors on the rear panel of the Gantry (see following figure). 
 

 

 

Note 
If another device is near enough to the Gantry for a patient to touch both devices 
simultaneously, use the Potential Equalization Conductor nut to connect a potential 
ground cable to that other device. (See the following figure, item 2.) 

 
 
 

 
Figure 14: Cable Connections on Rear Panel of Gantry 

 

 Figure Legend 

1. Service Port 

2. Ground Conductor nut (for ground wire to Generator) 

3. CAN Bus Connector (for cable to Generator) 

4. High Voltage Connector (for cable to Generator) 

5. Rotor Connector (for cable to Generator) 

6. Filament Power Connector (for cable to Generator) 

7. Fiber Optic Connector (for cable to AWS) 

8. EPO Connector (for cable to Generator) 
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Install the Rear Step 
1. Assemble the rear step (see the following figure). 

a. Turn over the rear step and attach the back plate to the step using the five pairs 
of screws supplied. 

b. Thread a nut on the backside of each screw.  

 
Figure 15: Assemble Rear Step (shown upside down) 

 

2. Install the two step guide posts on the rear of the Gantry. (See the following figure). 
 

 
Figure 16: Install step guide posts on rear of Gantry 
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3. Carefully slide the rear step over the two step posts. (See the following figure.) 

 
Figure 17: Installation of Rear Step on Gantry 

 

4. Route the Gantry cabling underneath the rear step to avoid pinching of wires and to 
allow an unobstructed path for patient access to the rear step. (See following figure.) 

  
Figure 18: Routing of Cables under Rear Step on Gantry 

 
 

3.3.3 Install the Generator 
Configure the Isolation Transformer 
The system ships configured for 240 VAC. Configure the isolation transformer in the 
Generator to match the power source at the site. 

1. Remove the Generator top cover (refer to Remove Generator Top Cover on page 169), 
top plate (refer to Remove Generator Top Plate Under Top Cover on page 170), and rear 
cover (refer to Remove Generator Rear Cover on page 172) if not already removed. 

2. Before connecting the Generator to the AC mains of the facility, verify the source 
voltage as follows: 

a. Measure voltage at the terminal. 

b. Ask about voltage fluctuations or voltage-related problems that have occurred in 
other equipment at the site. 
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3. After determining the input voltage range, verify that the isolation transformer is set 
correctly (see following figure).  

a. Set the circuit breaker on the front of the Generator to Off. 

b. Remove the top cover of the Generator to access the input power terminal block. 

c. Verify that the isolation transformer taps are wired to match the source voltage. 
If they do not match, configure the isolation transformer input wiring and taps. 

 

 
Figure 19: Isolation Transformer Taps on Generator 
 

 

 
Caution: 
120V Demo only is not for clinical use. 
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Connect the Generator Cables 
1. Verify that the main circuit breaker of the Generator is OFF.  
2. Remove the Generator top cover (refer to Remove Generator Top Cover on page 169), 

top plate (refer to Remove Generator Top Plate Under Top Cover on page 170), and rear 
cover (refer to Remove Generator Rear Cover on page 172) if not already removed. 

3. Decide which side the cables are to enter the Generator and remove the appropriate 
(left or right) side entry plug. 

4. Connect cables for the following (see the figure Generator Connections on page 42): 
• Filament/Power to Gantry/Patient Platform 
• EPO to Gantry/Patient Platform 
• Rotor for X-Ray Tube to Gantry/Patient Platform 
• High Voltage to Gantry/Patient Platform 
• CAN to Gantry/Patient Platform 
• Ground wire to Gantry/Patient Platform 
• CAN to AWS Computer 
• Ground wire to Workstation 

5. Connect the control cable for the x-ray remote hand controller to item 6 in the figure 
Generator Connections on page 42. 
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Figure 20: Generator connections (top view, covers removed) 

 
Figure 21:  Generator connections shown from the rear (made underside when shown in top view) 

Figure Legend 
1. Fuse Panel 

2. Isolation Transformer Taps 

3. X-Ray On/Power On (for remote indication lights) 

4. A Ground Conductor Nut (for ground wire to 
Workstation) 
B Ground Conductor Nut (for ground wire to 
Gantry) 

5. X-Ray Interlock 

6. Remote X-Ray Remote Hand Controller 
connection 

7. AC Mains Cable Junction Box 

8. Filament / Power Connector (cable to Gantry)* 

9. EPO Connector (cable to Gantry) 

10. Rotor Connector (cable to Gantry)* 

11. AC Mains Cable (from the facility power source) 

12. A CAN Cable Connector (to Gantry) 
B CAN Cable Connector (to AWS Computer) 

13. High Voltage Connector (cable to Gantry) 

14. Gantry Circuit Breaker 

15. Gantry Service Port (service use only) 
*These two connectors look very similar but the cables associated with them 
are keyed so the proper cable can be connected. 
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1. Connect the AC mains power cable to the Generator: 
 

 

Note 
Some localities require a licensed electrician to make this connection. (Verify before 
proceeding.) 

 

   

a. Decide which side the AC mains cable (item 11 in the figure Generator Connections 
on page 42) is to enter the Generator. 

b. Remove the cover to the AC mains junction box (see the following figure, three 
screws) and route the AC mains cable into the box. 

 
Figure 22: Removing cover to AC mains junction box (Generator rear view) 
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c. Verify a suitable cable terminal block exists inside the junction box to connect the 
AC mains cable with the Generator mains cable (see the following figure). We 
recommend Hologic part number MEL-00875 (Terminal Block, 3 POS 500V 
57Amps Closed Back DBL Row 14.5MM Centers WO/Wire Protection) or 
equivalent if you need to obtain one. 

 
Figure 23: Connecting cables to terminal block inside AC mains junction box 

 
 

 
Caution 
When inserting the individual cables into the terminal block, make sure the cable 
strands have been twisted so that all strands are inserted completely into the block. 

 

 

d. Match up the proper cable on both sides of the terminal block and attach the 
ground wire to the ground screw as shown in the previous figure. 

e. Position and fasten the metal strain relief collars where cables enter and exit the 
junction box. 

f. Reinstall the cover to the AC mains junction box. 

2. Have a certified electrician hard wire the opposite end of the AC mains cable into the 
power source via a disconnect panel. 
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Connect Remote X-ray On/Power On Lamp 
The system supports the ability to connect remote lights that indicate when the system is 
ON and when x rays are being taken. A certified electrician installs these lights—
normally outside the exam room, above the door. The relay contacts are rated: 

• 10 A 250 VAC (normally open) 
• 10 A 30 VDC (normally open) 

1. Install the remote Power On/X-ray On lights following local guidelines. 
2. Route the remote cables from the lights to the Generator. Connect each cable to the 

appropriate location on the X-ray On/Power On terminal block inside the Generator 
(see item 3 in figure Generator Connections on page 42). 

 
 

Calibrate the Generator 
 

 

Note 
A full generator calibration is needed after installation. 

 

   

Because the length of the generator cables can vary per installation, perform a full 
generator calibration once the system is operational. Refer to Inverter Drawer Calibration 
on page 139 and use CalTool to perform Generator kV, Gen mA Task (35 kV), and LG 
Filament (20kV- 49kV) tasks. 

3.3.4 Install the Image Detector 
1. Remove the detector-end cover of the C-arm by removing two screws and pulling the 

cover out of snap fasteners. 

 
Figure 24: Removal of detector-end cover of C-arm 
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2. Remove the detector-end cover of the C-arm. (See the following figure.) 

a. Remove the two middle SEMS screws and the side screws (captive and spring-
loaded) at the bottom two corners of the cover. The cover stays on after you 
remove the screws, but use caution. 

b. Partially pull off the cover. 

c. Before you fully remove the cover, move it out of position and disconnect the fan 
control harness connector. The connector is at the center edge of the joined pinch 
guards. 

d. Remove the fan control harness connector from the joined pinch guards. 

e. Remove the p-clip that is attached to one of the joined detector pinch-point 
guards. (Do not remove the other p-clip, which is fastened to the C-arm.) 

f. Finish removing the cover. 
 

 

Note 
The top and side edges of the detector-end cover fit (without screws) into the detector- 
end of the C-arm breast platform. After you remove the screws in the previous step, 
angle the bottom of the cover and pull it off. You may feel some resistance along the 
perimeter of the cover as you remove it. 

 
 

 
Figure 25: Removal of detector-end cover of C-arm 
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3. Remove the two joined detector pinch-point guards by removing the seven screws. 
(There are two screws at each end plus three in the middle.) Then slide out each of 
the two separated pinch guards. (See the following figure.) 

  
Figure 26: Removal of detector pinch-point guards 
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4. Locate and prepare the detector interface board and the detector fiber optic cable (see 
the following figure): 

a. Unfasten the detector interface board with ribbon cable (item 1) under the 
detector mounting platform and let it hang safely out of the way. 

b. Unclip the detector fiber optic cable (item 2) and let it hang safely out of the way 
under the mounting platform. 

 
Figure 27: Preparing detector cables 
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5. Lower the detector mounting platform to obtain sufficient clearance to slide in the 
detector onto the mounting platform. (See the following figure.) 

a. Loosen the set screw (item 1) about one to two turns. 

b. Lower the two sets of u-brackets by loosening four screws (item 2) until the 
brackets are at end-of-travel. Then tighten the screws to secure the hard stops. 

c. Loosen the four screws under the mounting platform (item 3) about one to two 
turns.  

d. Back out the large height adjustment screw (item 4). Loosening this screw frees 
the mounting platform for vertical movement. 

e. Push down on the bracket (item 5) to lower the mounting platform. 
 

 
Figure 28: Loosen screws to lower detector mounting platform 
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6. Remove the plastic protective shipping cover from the detector (see the following 
figure) to expose the mylar surface (the shiny black section). 

 

 
Caution 
Avoid scratching the mylar surface (the shiny silver section) when unpacking/ 
installing the image detector. 

 

   

 

 
Figure 29: Removing protective cover from detector 

 
 

7. Install the detector on the detector platform. Use the locator slots (see arrows in 
following figure) to align the detector on the detector platform when sliding it in. 

 
Figure 30: Locator slots on platform for detector 
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8. Install the two screws that secure the detector to its mounting platform. 

 
Figure 31: Fastening the detector 
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9. Connect and secure the detector interface board and detector fiber optic cable (see 
following figure):  

a. Insert the detector interface board (item 1) and detector fiber optic cable (item 2) 
through the bottom access opening of the detector mounting platform and 
connect to the detector. 

b. Under the detector platform, fasten the interface board with a screw and secure 
the fiber optic cable to its mounting clip. 

 
Figure 32: Route and connect detector cables to detector (detector not 
shown for better clarity) 
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10. Raise the detector mounting platform back up to its original position by tightening 
the large height adjustment screw (item 4 in the following figure). 

 
Figure 33: Screws to adjust the detector mounting platform 

 

11. Tighten the four screws under the mounting platform (item 3 in previous figure) to 
secure the detector in place. Note that these four screws are also used to adjust the x-
ray field detector alignment procedure in CalTool (refer to X-Ray Field Detector 
Alignment on page 145). 

12. At this point, you can: 
• reinstall the detector covers and continue with step 13. 

OR 
• leave off the detector covers (for now). This method allows you to save time by 

not having to remove the covers later for any detector alignment that may be 
necessary after the system is powered up. This alignment is part of a series of 
procedures you perform after you install or replace a detector (refer to Replace 
Image Detector on page 207). If you do leave off the detector covers for now, refer 
back to this procedure to reinstall the detector covers after the alignment is 
complete. 

13. Reinstall the detector pinch-point guards by rejoining both halves with the seven 
screws and securing to the underside of the detector. 

14. Reinstall the p-clip and pinch screws previously removed from the joined pinch 
guard. 

15. Reconnect the fan wire harness connector. 
16. Reinstall the detector-end cover of the detector by sliding and fitting its top and side 

edges into the detector-end of the carbon fiber breast platform. 
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17. Reinstall the detector-end cover of the C-arm. 
18. When the system is fully assembled and turned on, refer to the procedure Replace 

Image Detector on page 207 to finish the software installation/configuration for the 
image detector. 

 

3.3.5 Affix the Image Detector Labels on the System 
Affix the serial number label (LBL-05175) shipped with the detector on to the Gantry 
(refer to the diagram in Label Locations on page 16). 

If you also find a safety label (LBL-05192) shipped with the detector, it is an extra copy 
and is not used (discard it). 

3.3.6 Install the Acquisition Workstation 
Configure the Isolation Transformer 
The isolation transformer on the Acquisition Workstation ships configured for 240 VAC. 
Configure the isolation transformer to match the power source at the site.  

1. Ensure that the isolation transformer power cord is unplugged from the AC mains of 
the facility. 

2. Remove the isolation transformer: 

a. Unplug the UPS power cord from the isolation transformer.  

b. Remove the nut on the front mounting tab of the isolation transformer housing 
and remove the transformer from the workstation cart.  

3. Remove the two screws holding the top cover and slide cover off towards the rear. 
4. Reconfigure the taps to match site power requirements as required (see following 

figure). 

 
Figure 34:  Isolation Transformer Taps on Acquisition Workstation  

 

5. Replace the transformer cover. 
6. Replace the isolation transformer into the workstation cart and fasten the nut on the 

front mounting tab of the isolation transformer housing. 
7. Plug the UPS power cord into the transformer. 
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Activate UPS Battery 
1. Carefully tilt up the UPS at its front while keeping its back end on the workstation. 
2. Underneath the UPS, locate and slide off the UPS battery cover. (See the following 

figure.) 
3. Insert the red positive cable into the positive terminal of the battery (item 1 in the 

following figure). 

 
Figure 35: UPS battery connection (shown from underside of UPS) 

 

4. Slide back on the UPS battery cover and carefully lower the UPS to the workstation. 
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5. If you need to disconnect the cables to the UPS and pull it out farther, use the 
following figure for reference. 

 
Figure 36: Connections on rear of UPS 

Figure Legend 

1. Computer Power Outlet 

2. Control Monitor Power Outlet 

3. Work Surface Lift Power 
Outlet 

4. Display Port Cable to 
Computer connector 

5. Image Display Monitor Power 
Outlet 

6. UPS Power Cord (plugs into 
Isolation Transformer) 

 
 

Connect the Acquisition Workstation Cables 
The Acquisition Workstation cart comes pre-installed with the isolation transformer, 
UPS, and computer. You need to connect the image display monitor and control monitor 
to the computer, as well as several cable connections coming from the Gantry and 
Generator. 

1. Connect the isolation transformer power cable to an appropriate AC mains outlet. 
Raise the work surface of the Acquisition Workstation cart to an operator level to 
allow you to make subsequent cable connections with the computer. 
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2. Install and connect these items at the back of the computer (see following figure): 
• mouse 
• keyboard 
• image display monitor 
• control monitor 
• power cable from UPS 
• USB data port cable from UPS 
• CAN cable going to/coming from the Generator 
• fiber optic cable going to/coming from the Gantry 

 
 

 
Figure 37: Rear panel of Acquisition Workstation computer 

Figure Legend 

1. CAN connector (for cable to Generator) 

2. Image Display Monitor connector 

3. Computer Power Switch, set to ON 

4. Fiber Optic connector (for cable to Gantry) 

5. Control Monitor connector 

6. UPS USB data port cable connector 

7. USB Mouse connector 

8. USB Keyboard connector 

9. Computer power cable connector 
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3. Connect the ground wire from the Generator to the left ground conductor on the rear 
of the workstation. 

 
Figure 38: Connect ground wire to left ground nut on rear of workstation 

 
 

Install Control Display Monitor 
1. Power OFF the Acquisition Workstation system. 
2. Install the control display onto the left monitor bracket (four screws). 
3. Connect the DVI cable and power cable (120 VAC) dangling from the monitor post to 

the control display. 
4. Power ON the Acquisition Workstation system. 
5. Verify proper operation of the control display monitor. 

 

Install Image Display Monitor 
1. Raise the workstation surface to its highest level. 
2. Power OFF the Acquisition Workstation system. 
3. Install the image display (Barco) monitor onto the right monitor bracket (four 

screws). 
4. Install the power supply for the image display monitor: 

 

  

Note 
The metal housing that holds the power supply of the image display monitor is located 
inside of the rear wall of the workstation cart. (See item 3 in the figure Major Serviceable 
Components of Acquisition Workstation on page 224.) The housing is sized to fit either the 
smaller 2-megapixel monitor power supply (plus a metal spacer) or the larger 3-
megapixel monitor power supply (without a spacer). 
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a. [2-megapixel monitor power supply only] Install the metal spacer in the power 
supply housing. 

b. Install the power supply on the power supply housing and secure with hook-
and-loop fastener material. 

c. Route the 120 VAC cable of the power supply to the UPS and plug it in (see 
figure Connections on rear of UPS on page 56). 

5. Locate the monitor display port cable and connect one end to the computer (see 
figure Rear panel of computer on page 228). 

6. Locate the 24 VDC power cable from the monitor power supply and monitor display 
port cable from the computer and run these cables through the e-chain cable housing 
(starting from the bottom). See the following figure (items 7 and 8) for the proper e-
chain slots to thread these cables through. 

 

 
Figure 39: Routing of power and display port cables in e-chain cable housing 
(top of e-chain shown) 

Figure Legend 

1. Power cord for 
workstation surface lift 

2. Ground cable 

3. AC power cord for 
control display monitor 

4. Mouse USB cable 

5. Keyboard USB cable 

6. Video cable for control 
display monitor 

7. Display port cable for 
(Barco) image monitor 

8. 24 VDC power cable for 
(Barco) image monitor 

 

7. From the top of e-chain cable housing, run the monitor power and display port 
cables through the bottom of the monitor post and out the post side opening. 
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8. Apply spiral wrap or use wire ties to the two cables after they leave the monitor post 
to keep the cables together. 

9. Remove the rear cover of the image display monitor and attach the 24 VDC power 
cable and display port cable. Replace the rear cover. 

10. Power ON the Acquisition Workstation system. 
11. Configure the new monitor using the on-screen menu of the monitor. (Refer to Verify 

Settings of Barco Image Display Monitor on page 60.) 
 

 

Verify Settings of Barco Image Display Monitor 
 

 

Note 
This post-installation setup verification procedure pertains only to models of Barco 
image display monitors that have advanced settings. 

 

 

1. Power ON the monitor. A single LED lights up in the lower right corner of the 
monitor frame. (See the following figure.) 

2. Wait for the LED light to go out (approximately 50 seconds after power ON). 
 

 
Figure 40: Waiting for single LED to turn OFF after power ON 
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3. Touch the monitor frame (not the screen), along the bottom near its lower right 
corner until four LED touch keys (embedded in the frame) light up. (See the 
following figure.) 

 

 

Note 
The operator of the workstation touches these LED keys to navigate and select the 
various screens, menus, and settings on the monitor. 

 

  

4. Touch the LED under the menu symbol (second from right). (See the following 
figure.) 

 
Figure 41: Touching LED under menu symbol (second from right LED) to display 
Main Menu 

 

The Main Menu is displayed. (See the following figure.) 
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5. Using the touch-sensitive LEDs, navigate and select Configuration > Image Source. 

 
Figure 42: Configuration main menu 

 Figure Legend 

1. Left key 

2. Right key 

3. Enter key (navigate into submenu) 

4. Cancel key (exit out of submenu) 

 

 
 

 

Note 
The key icons (on-screen) are displayed above the LED keys (embedded in monitor 
frame). (See the previous figure.) Each icon is adapted to the function for which it is 
used (menu dependent). 
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6. Confirm all settings in the Configuration > Image Source screen, as shown in the 
following figure. 

 
Figure 43: Confirmation of settings in Configuration > Image Source screen 

7. Return to the main menu. 
8. Navigate and select Configuration > Calibration. 
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9. Confirm all settings in the Configuration > Calibration screen, as shown in the 
following figure. 

 
Figure 44: Confirmation of settings in Configuration > Calibration screen. 

 

10. Return to the Main Menu. 
11. Navigate and select Status > Calibration. 
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12. Confirm all settings in the Status > Calibration screen, as shown in the following 
figure. 

 
Figure 45: Verifying first three settings for new install, all settings for replacement install 

 

13. In the Status > Calibration screen: 
• Confirm all settings for a replacement installation, as shown in the previous figure. 
• Confirm only the first three settings for a new installation, as shown in the 

previous figure. 
Make sure that: 
• Display Function = DICOM 
• Current Luminance = 500 cd/m2  
• Luminance Target = 500 cd/m2 
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3.3.7 Setting Proper Height Gap Between C-Arm and Patient Platform 
1. Replace all covers on the Generator. If necessary, refer to Remove Generator Top Cover 

on page 169, Remove Generator Front Cover on page 171, Remove Generator Top Plate 
Under Top Cover on page 170. 

2. Leave off the top patient padding, top cover, rear cover, and rear inside cover from 
the patient platform/Gantry for the time being. 

3. Turn ON the facility power at the circuit breaker. 
4. Turn ON the main circuit breaker of the Generator. 
5. Position the C-arm at 90 degrees to the table and slide the C-arm all the way in 

towards the Gantry. The image receptor should be centered below the patient 
platform (see the following figure). 

 
Figure 46: Positioning C-arm to verify proper upper height setting 

 

6. Use the C-arm position buttons to move the C-arm in the fully up position. 



Affirm Prone Biopsy System Service Manual 
Chapter 3: Installation 

 
 
 
 

 
MAN-04482 Revision 006 Page 67 
 

7. Test that the C-arm upper travel stops at the desired 1/4-inch distance from the 
bottom of the patient platform. This gap can be tested by inserting TLS-05884 (which 
is 1/4 inch thick) between the top of the breast platform and the bottom of the patient 
platform (see the following figure). There should be a slight drag as you slide the 
gauge in and out.  

 
Figure 47: Checking for 1/4" gap using TLS-05884 
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8. At the rear of the Gantry (see the following figure), loosen the wing nut (item 2) and 
turn the knob (item 1) to adjust the plunger (item 3) to allow adjustment of the C-arm 
upper travel switch (item 4). 

 
Figure 48: C-arm upper travel limit adjustment 

 

9. Rotate the C-arm left and right (0 -180°) to make sure that here is no contact with the 
patient platform throughout the entire rotation. 

10. When the proper gap has been established, tighten the wing nut in the rear of the 
Gantry (item 2 in figure C-arm upper travel limit adjustment on page 68) to hold the 
setting. 

11. Do the following, based on the results: 
• If the C-arm has the proper clearance, no further adjustments are necessary. 

Continue at step 14. 
• If the proper C-arm clearance cannot be attained, continue with the next step. 

12. Confirm that the maximum height travel switch is set correctly. The switch should 
stop the top of the breast platform 1/8 inch from its closest point to the bottom of the 
table top (see the following figure). 

 
Figure 49: Proper setting of maximum height switch (1/8" gap 
between breast platform top and bottom of patient platform) 
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• If the maximum height travel switch height is not correct, do the following: 

a. Loosen the two screws and move the switch ramp (see the following figure, item 
1B) to its highest position for the maximum height switch item 1A. 

b. Position the C-arm to the proper height of 1/8 inch clearance (see previous 
figure). 

c. Adjust the switch ramp item 1B to this setting (this activates the maximum 
height switch 1A). 

d. Lower the C-arm and then raise it back to the maximum height to confirm 
adjustment.  

e. When finished, go back to step 8. 

• If the adjustment cannot be obtained, go to the over-travel switch adjustment in 
step 13. 

 
Figure 50: Adjusting maximum height switch (1A) by its switch ramp (1B) 

 



Affirm Prone Biopsy System Service Manual 
Chapter 3: Installation 
 

 
Page 70 MAN-04482 Revision 006 
 

 
Caution 
If the C-arm maximum height adjustment is set too high: 
• The C-arm may activate the over-travel switch when the C-arm reaches its highest 

position and cause the system to shut down. 
• Damage may occur to the C-arm during the auto-rotation for a scout image as the 

C-arm tries to traverse its path and it binds up under the patient platform. 
 

 

13. To confirm the over-travel switch adjustment, perform these steps (see following 
figure): 

 
Figure 51: Adjusting over-travel switch (2A) by its switch ramp (2B) 

a. Mark the location of switch ramp (item 1B) used for the maximum height switch 
(item 1A). 

b. Loosen the two screws and move the switch ramp (item 1B) for the maximum 
height switch (item 1A) to it highest position. This step temporarily disables the 
maximum height switch to allow the checking of the adjustment of the over-
travel switch.  

c. Raise the C-arm to the point where the breast platform top just touches the 
bottom of patient platform without any pressure applied to the breast platform 
top (see the following figure). At this point, the over-travel switch (item 2A, see 
previous figure) should power off the Gantry. 
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If the adjustment is not correct, adjust switch ramp 2B (see previous figure) until 
switch item 2A disables power to the Generator. 

 
Figure 52: Proper setting of over-travel switch (breast 
platform top just touching bottom of patient platform) 

d. Lower the C-arm and raise the C-arm to verify the setting is correct.  

14. When done, go back to the maximum height switch adjustment in step 12.Replace 
the top patient padding, top cover, rear cover, and rear inside cover on the patient 
platform/Gantry. If necessary, refer to Covers Removal - Gantry Section on page 182. 

 

3.3.8 Return the Shipping Container to Hologic 
Return the image detector shipping container and the temperature monitoring device to 
Hologic as per the instructions in the container. 
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4: System Controls and Indicators 
4.1 System Power Controls 

 
 

  
Figure 53: System Power Controls 

 Figure Legend 

1. Uninterruptible Power Supply (UPS) 
Power/Reset Button 

2. Isolation Transformer Power Switch 

3. Computer Power On/Reset Button 

4. Emergency Off (E-Stop) Switches 

5. Generator Circuit Breaker 

 

 
 

Chapter 4 
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4.2 C-Arm Controls 
 

 
Figure 54: C-arm Controls and Displays 

 Figure Legend 

1. Emergency Off (E-Stop) Switch 

2. Manual Compression Adjust Knob 

3. Control Handle 

4. Biopsy Control Module Touch Screen Display 

5. Biopsy Arm Motor Enable Button 

6. Manual Biopsy Device Advance/Retract Knob 

7. Task Lighting On/Off 

8. C-arm Rotation Handle 

9. C-arm Sweep – Away from User 

10. C-arm Sweep – Toward User 
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4.2.1 Biopsy Arm Controls 
 
 

 
Figure 55: Biopsy Arm – Detailed View 

 Figure Legend 

1. Biopsy Device Mount Knob 

2. Manual Needle Advance/Retract Knobs 

3. Biopsy Control Module Touch Screen Displays 

4. Biopsy Control Module Motor Enable Buttons 

 

 
 

 

Note 
Refer to the Affirm Prone Biopsy System User Guide for information on using the Biopsy 
Control Module touchscreen display. 

 

    
 

 

 

Note 
The Biopsy Control Module motor enable buttons consist of two pairs of buttons 
located on either side of the Biopsy Control Module. Each pair is located back to back 
on one of the module cover extensions and is meant to be pinched with one hand. To 
enable the Biopsy Control Module motor, press and hold one of the Motor Enable 
button pairs. 
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4.2.2 Control Handle Controls 
 

  

 
Figure 56: Control Handle -- Detailed View 

Button Function 

 
C-arm Translate 
(horizontal plane) 

 C-arm Up 

 C-arm Down 

 System Lock 

 Patient Platform Up 

 Patient Platform Down 
 

   
 

 

4.2.3 Footswitch Controls 
 

 

 
Warning: 
Place each footswitch in a position where, when used, they remain in reach of 
the Emergency Off Switches. 

 

   
 

 

 
Warning: 
Position the footswitches to prevent accidental operation by a patient or 
wheelchair. 

 

   
 
 

 

 
Figure 57: Footswitch – Detailed View 

Figure Legend 

1. C-arm Down 

2. C-arm Up 

3. Compression Release 

4. Compression Apply 
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4.3 Patient Platform Controls 
 

 

 
Figure 58: Patient Platform Controls 

 Figure Legend 

1. Patient Platform Up 

2. Patient Platform Down 

3. Task Light On/Medium/Low/Off 

4. Patient Platform Up Limit (Full Height) 
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4.4 Acquisition Workstation Controls 
 

 

 
Figure 59: Acquisition Workstation Controls 

Figure Legend 

1. Control Monitor 
2. Image Display Monitor 
3. Keyboard 
4. Mouse 
5. Workstation Work Surface Up and Down 

Controls 
6. Uninterruptible Power Supply (UPS) 

Power Button 
7. Isolation Transformer Power Switch 
8. Computer Power On/Reset Button 

9. CD/DVD Drive 
10. Emergency Off/X-ray Activation Remote 

A.  Power On Light 
B.  X-ray Active Light 
C.  System Alert Light 
D.  Emergency Off Switch 
E.  Ready for X-ray Light 
F.  X-ray Activation Button 

 
 



Affirm Prone Biopsy System Service Manual 
Chapter 4: System Controls and Indicators 

 
 
 
 

 
MAN-04482 Revision 006 Page 79 
 

4.5 How to Start the System 

4.5.1 Preparation 
1. Verify that there are no obstructions to C-arm, Patient Platform movement, or to the 

view of the Operator. 
2. Make sure that all three Emergency Off switches are in the reset position (unpushed). 

 
Figure 60: Turn to Reset the Emergency Off 
Switches 

 

3. Make sure that the Generator circuit breaker is in the ON position. 
 

4.5.2 Startup 
1. Ensure that the Isolation Transformer power switch is in the ON position. 
2. Ensure that the UPS is powered ON. 
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3. Press the Power/Reset button on the computer. The computer powers on and the 
Startup screen appears on the Acquisition Workstation Control monitor. The Gantry 
then automatically powers on. 

 

 
Figure 61: Startup Screen 

 
 

 

Note 
The Startup screen includes a Shutdown button that turns off the system, and a Reboot 
button that restarts the system. 

 

    
 

 

 

Note 
See the figure System Power Controls on page 73 for the locations of power buttons. 
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4.5.3 Log In 
1. Select the Log In button on the Startup screen. 
2. The Select an Operator (Log In) screen opens and shows a list of Manager and 

Technologist user names. Select the Show All button to list the Service, Applications, 
and Physicist user names. 

3. Choose an operator by selecting the applicable button. 
 

 
Figure 62: Select an Operator (Log In) Screen 
 

4. Select the Password field and type in the password. 
5. Select Log In. 
 

 

 

Note 
If Quality Control tasks are due, the Select Function to Perform screen opens. Perform the 
quality control tasks or select Skip. 

 

 
 

 

4.6 Perform Functional Tests 
Perform the functional tests as described in the User Guide. 
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4.7 Confirm Licensing 
Confirm the licensed features for this system. In the system application, go to Admin > 
About screen > Licensing tab and verify the features and options installed. 

If any additional features are required, locate the Sales Order number of the feature(s) 
and follow the directions in Add Licensed Features on page 109. 

4.8 How to Turn Off the System 
1. Close any open patient procedures. 
2. From the Select Patient screen, select the Log Out button. 
3. From the Startup screen, select the Shutdown button. 
4. Select Yes in the confirmation dialog box. 

 

4.8.1 How to Remove All Power from the System 
1. Turn off the system. 
2. Press the UPS power/reset button to power off the UPS. 
3. Turn OFF the Isolation Transformer power switch. 
4. Turn OFF the Generator circuit breaker. 
5. Turn OFF the Facility Mains circuit breaker. 
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5: Setup, Configuration, and Connectivity 
5.1 About Screen 

The About screen provides information about the machine, such as system level, IP 
address, licensed features, and serial number. This type of data can be useful when 
working with Hologic to configure the system or resolve a system issue. 

The screen is accessed in two ways: 

• From the Select Patient screen - select the Gantry icon (on Taskbar), then select 
About… 

• From the Admin screen - select About (in System Grouping) 

 
Figure 63: About Screen with the System Tab Showing (Service Login) 

There are six tabs on the About screen: 

• System Tab (default) - lists system configuration information 
• Licensing Tab - lists the Hologic-licensed options installed on this machine 
• Institution Tab - lists the name and address of the organization assigned to this machine 
• Dose Tables Tab - lists the dose tables used on the system 
• Copyright Tab - lists the copyrights of Hologic and third-party software installed on 

this machine 
• UDI Tab - lists the unique device identifier(s) of this machine 

 

Chapter 5 
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5.2 The Admin Screen 
The Admin screen provides access to system calibrations, tests, and reports. To access 
this screen, do the following. 

1. At the Acquisition Workstation, log in to the system Capture application as Service. 
2. At the Select Patient screen, select the Admin button. 
3. The Admin screen opens. 

 
Figure 64: Admin Screen (Service Login) 

   

Refer to the following table for descriptions of the Admin screen functions. 

 

Note 
Depending on the license settings for your system, you may not see all the buttons 
listed here. 

 

 
 

Table 2: Admin Screen Functions 
Section Button Name Function 

Operators Manage Operators Add, delete, or change Operator information 

My Settings Change the information for the current Operator, including 
worklist settings 

Procedures Procedure Editor Add or edit the procedures, or change the view order for each user 

Procedure Order View and change the order for “Procedures” within a specific 
“Procedure Group” (such as Conventional, Tomo, etc.) 

View Editor Add or edit the views 

QAS Access the QAS Test screen 
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Table 2: Admin Screen Functions 
Section Button Name Function 

Quality Control Quality Control Select a Quality Control (QC) task to perform or mark completed 

QC Report Create a Quality Control (QC) Report 

Test Patterns Select and send the test patterns to output devices 

Reject and Repeat 
Report 

Create a Reject and Repeat Report 

System System Tools The interface provided for Service to configure the Affirm Prone 
biopsy system based on customer site required workflow. 
Configuration information within System Tools may also assist in 
troubleshooting with devices interfaced to the system. 

System Defaults Set the Gantry default values 

System Diagnostics Displays the status of all subsystems and provides the ability to 
turn on or off the Gantry and to restart the detector 

Preferences Set the system preferences 

About Describes the system (refer to About Screen on page 83) 

Exposure Report Create a report of the number of exposures by modality. 

Biopsy Devices Set and manage the biopsy devices. 

Log Viewer Review the system log files. 

Turn NPT On Puts the system in non-patient test mode (NPT), used specifically 
for system Node testing. When put into NPT mode, Gantry and 
Detector Nodes are put in a state unsuitable for clinical purposes. 

STX Calibration Maps the needle coordinates to the detector space for the standard 
approach of a biopsy device 

Connectivity Query Retrieve Configure the Query/Retrieve devices 

Import Import the data from a DICOM source. 

Manage Output 
Groups 

Add, delete, or edit output groups. 

Incoming Log Shows log entries for images that do not import during manual 
import or DICOM store. 

Archive Send local studies to networked storage or export to removable 
media devices. 

You must have permission to access all features. The permission level controls the functions you can change. 
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5.3 Operating System Settings 

5.3.1 Adjust the Time Zone for Locale 
The default time zone for the system is Eastern Standard Time for the USA. The time 
zone is changed through the Windows Control Panel. Follow these instructions to change 
the time zone as required. 

1. Close the system application. 
2. Open the Windows Control Panel (Start > Control Panel). 
3. In the upper right-hand corner, make sure View by: is set to Category. 
4. Select Clock, Language and Reason. 
5. Under Date and Time, select Change the time zone. 
6. On the Date and Time screen and tab, select Change time zone... 

 
Figure 65: Windows Date and Time screen 
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7. Select the appropriate the time zone from the drop-down list and click OK. 

 
Figure 66: Time Zone selection 

 

8. On the Date and Time screen, verify the correct time. Select Apply, then select OK. 
9. Restart the system application for the changes to take effect. 
 

 

5.3.2 Adjust the Time and Date Formats 
The system defaults to a 12-hour clock format and M/d/yyyy date format. The time and 
date formats are changed through the Windows Control Panel. Follow these instructions 
to change the time and date presentation as required. 

1. Close the system application. 
2. Open the Windows Control Panel (Start > Control Panel). 
3. In the upper right-hand corner, make sure View by: is set to Category. 
4. Select Clock, Language and Reason. 
5. Under Region and Language, select Change the date, time, or number format. 
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6. Under the Formats tab, make the appropriate choices (see the following figure): 

a. Select the desired language and country from the Format drop-down list (item 1). 

b. Select the desired date format from the Short date and Long date drop-down lists 
(item 2). 

c. Select the desired time format from the Short time and Long time drop-down 
lists (item 3). 

 
Figure 67: Windows Formats screen  

 

7. Select Apply, then select OK. 
8. Restart the system application for the changes to take effect. 

 

5.3.3 Configure Network Parameters 
The system application derives network identification parameters from entries you make 
using the Network and Sharing Center in Windows Control Panel. Use this procedure to 
enter the server host name, DNS server, IP address, subnet mask, and default gateway.  

1. Close the system application. 
2. Access the network properties in Windows by either of these two methods: 

• Right-click the desktop network icon and select Properties. 
       OR 
• Navigate via Windows Control Panel. 

a. Select Start > Control Panel. 

b. In the upper right-hand corner, make sure View by: is set to Category. 

c. Under Network and Internet, select View Network Status and Tasks. 
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3. On the Network and Sharing Center screen, select Local Area Connection. 

 
Figure 68: Network and Sharing Center screen 

 

4. On the Local Area Connection screen, select Properties. 

 
Figure 69: Local Area Connection screen 
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5. On the Networking screen, select Internet Protocol Version 4(TCP/IPv4) and click 
Properties.  

 
Figure 70: Networking screen 

 

6. On the Internet Protocol Version 4 (TCP/IPv4) Properties screen, select the Use the 
following IP address option, and then enter the site IP address, Subnet mask, 
Default gateway, and DNS server address. 

7. Click OK, then click Close. 
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8. Use the following substeps to change the system host name per conventions, guided 
by the customer IT staff of the customer, your Regional Connectivity Specialist, or 
your own convention consistent with Hologic training. Consult with the site IT 
administrator before changing the server host name. 

a. Access the Systems Properties screen by either of these methods. 

• On the desktop, right-click the Computer short-cut icon and select 
Properties. 

      OR 
• Go to Start, right-click on Computer, and select Properties. Click Advanced 

system settings.  

 
Figure 71: My Computer screen 

 

b. On the System Properties screen, click the Computer Name tab, then click 
Change. 

 
Figure 72: System Properties screen, Computer Name tab 
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c. On the computer Name/Domain Changes screen, enter the host name in the 
Computer name field. 

 
Figure 73: Computer Name Changes screen 

 

d. Click OK (twice) to return the System Properties screen, then click Close. 

e. On the System Settings Change screen, click Restart to restart the system. 
 

5.4 Hologic Connect Configuration 
Hologic Connect™ is a multi-functional, cloud-server based platform that provides 
system status via real-time monitoring as well as remote connection capabilities for any 
connected device. Hologic Connect allows Hologic Tech Support, Field Service, 
Applications, and Software Development to remotely access into a system for 
troubleshooting, maintenance, training, and data reporting purposes. 

The following set of procedures explain how to configure Hologic Connect on the system 
using the Hologic Connect configuration tool. 

5.4.1 Accessing Hologic Connect 
1. From any system applications screen, press the Windows key. 

 
Figure 74: Windows Key on Keyboard 
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2. Right-click on the clock displayed in the tool bar in the lower right-hand side of the 
screen and select Show the desktop. 

 
Figure 75: Show the Desktop 

3. Find the Hologic Connect icon on the desktop and double-click it. 

 
Figure 76: Hologic Connect Icon 
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5.4.2 Enter Site Information for Hologic Connect 
1. Select the Site Details tab at the top of the Hologic Connect Control Panel screen. 
2. Enter the specific site information consistent with corporate naming conventions. If 

in doubt, consult the sales order or corporate system such as Oracle and Salesforce. 
Be attentive to names used for other equipment and/or locations. For example, do not 
use "St." at one location and "Saint" at another. Always use the standard two letter 
abbreviation for the state (such as "TX" for Texas). 

 
Figure 77: Hologic Connect Control Panel - Site Details 
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5.4.3 Enter Product Information for Hologic Connect 
1. Select the Control tab at the top of the screen. 

If the Hologic Connect process is running, click the Stop button. 

 
Figure 78: Hologic Connect Control Panel - Control Tab 

 

2. In the Model field, choose Affirm Prone Biopsy System from the dropdown list. 

 
Figure 79: Hologic Connect Control Panel - Model Drop-Down Box 

 

3. Deselect the Use the MAC Address checkbox (see the following figure). 
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4. Enter the System Serial Number in the Hologic Connect Serial Number field. 

 
Figure 80: Hologic Connect Control Panel - Use MAC Address 
checkbox 

 

5. Under the Remote Connections section at the bottom, the "Allow LAN access over 
VNC" field is normally left unchecked (for not to enable this feature). 
If the customer needs the system to communicate via a LAN going over a VNC 
(which is not as secure as a regular LAN, but may be needed in certain 
circumstances), select this option.  

 
Figure 81: Hologic Connect Control Panel - Allow LAN access 
over VNC checkbox 
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6. Do the following, based on the situation: 
• If a proxy server is used by the site, continue with Configure a Proxy Server (If 

Needed). 
• If no proxy server is used by the site, proceed to Test/Verify Hologic Connect 

Internet Access on page 98. 
 

5.4.4 Configure a Proxy Server (If Needed) 
A proxy server may sit between a client and the Internet. It serves as an intermediary 
gateway to pass acceptable requests from clients, then forwards those requests to other 
servers. Refer to the Connectivity Site Survey for proxy server information. 

 

Note 
If no proxy server is used with this system, proceed to Test/Verify Hologic Connect 
Internet Access on page 98. 

 

   

1. From the Hologic Connect Control Panel, select the Control tab. Select the 
appropriate proxy type from the Proxy field dropdown list. 

 
Figure 82: Hologic Connect Control Panel - Proxy Type 

• None—No Proxy Server 
• HTTP—The session connects through a Hypertext Transfer Protocol (HTTP) 

proxy server. HTTP is a communications protocol used to transfer information 
on intranet and the World Wide Web. 

• SOCKS{4I5}—The session connects through SOCKS version 4 or 5 proxy server. 
SOCKS is an abbreviation for SOCKetS, and is an Internet protocol that allows 
client-server applications to transparently use network firewall services. 
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2. Enter the appropriate IP Address, Port, User Name, and Password for the proxy 
server of the customer. 

3. Click Apply to save the settings. The server displays Please restart the following service: 
Hologic Connect. 

4. Reboot the system. 
5. Verify the Internet connection (refer to Test/Verify Hologic Connect Internet Access on 

page 98). 
 

5.4.5 Test/Verify Hologic Connect Internet Access 
1. After making changes in Hologic Connect, restart the system. 
2. Launch Internet Explorer.  

If Internet Explorer is not easily accessible from the taskbar or as a desktop shortcut, 
do the following: 

a. Right-click on the Windows start icon [ ] and click Search. 

b. In the search box, type iexplore. 

c. Under Programs, click iexplore.exe. 

 
Figure 83: Searching for iexplore 
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3. The web browser opens. Go to http://www.hologic.com and verify that the website 
launches. 

 

 

Note 
If the website does not appear, there is no connection to the internet. Verify the Ethernet 
cable is attached to a working LAN port and refer to Configure Network Parameters on 
page 88 and Configure a Proxy Server (If Needed) on page 97 to review your network 
settings. 

 

 

4. To update customer records, email Customer Support at 
BreastHealth.Support@hologic.com. Please include: 
• customer name 
• system serial number 
• MAC address for each system 

5. To contact Hologic Technical Support, call 1.800.760.8342, or email 
imgsupport@hologic.com. 

 

5.5 System (Service) Tools 
 

 

Note 
If the Acquisition Workstation software is not in operation, you can start the System 
(Service) Tools from the shortcut on the desktop. 

 

   

System (Service) Tools provides access to system configurations and settings. To access 
this application, do the following. 

1. At the Acquisition Workstation, log in to the system application as Service. 
2. At the Select Patient screen, select the Admin button. 
3. At the Admin screen, select System Tools. 

http://www.hologic.com/
mailto:BreastHealth.Support@hologic.com
mailto:imgsupport@hologic.com
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4. The System Tools screen displays. 
 

 
Figure 84: System Tools (Service Login) 

 
 

Refer to the following table for descriptions of the System (Service) Tools functions. 
 

Table 3: System (Service) Tools Functions (Service Login) 
Item Topic Description 

Getting Started About Introduction to using the service tool 

 FAQ List of frequently asked questions 

 Glossary List of terms and definitions 

 Platform List of directories, software version numbers, 
and system software statistics 

 Index Alphabetical list of topics 

 Shortcuts List of Windows® shortcuts 
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Table 3: System (Service) Tools Functions (Service Login) 
Item Topic Description 

(AWS) 
Acquisition 
Workstation 

Connectivity Provides the ability to install, list, and 
configure output devices as related DICOM 
functionality   

 Film and Image 
Information 

View, import, and edit image processing 
parameters 

 Licensing List, add, and remove licenses 

 Notices Configure export settings 

 Import Configure DB mappings and Filters 

 JSS View JSS Dispatcher Job Type information 

 Hanging Protocol Configure Hanging Protocol 

 Reclaimer Configure Reclamation defaults 

 Procedures Configure Procedure parameters 

 DICOM Configure DICOM settings 

 User Interface Configure UI defaults 

 Simulation  

 Internationalization Configure language and culture 

 Global Configure system, Repository (sets threshold 
of hard drive capacity remaining before 
system message displays), Institution settings 

 QC Procedure, periodicity, calibrations, phantom 
thickness 

 AWM Enable AWM Cluster 

Peripherals Removable Media Configure image types exported to media 
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Table 3: System (Service) Tools Functions (Service Login) 
Item Topic Description 

Hardware Paddles Lists Paddle IDs 

 Calibration Lists calibration parameters 

 Subsystem (Global) Acquisition Workstation Settings, Mag 
settings, Gantry distances, temperature limits 

 Biopsy Device List Device list 

 Biopsy Config Biopsy, QAS configuration parameters 

 Monitors Heartbeat, exposure count, monitors 

 Detector 
Configuration 

Maximum pixel value for conventional and 
tomographic images 

 Tube Filter Outputs Lists Filter Tube Output and HVL tables 

 Tube Loading   Configure tube load parameters 

System Tools 
Settings 

 Idle Timeout 

Notes from 
Hologic Service 

 Allows entry of Service PM/install notes in a 
database to track work done on visits 

Troubleshooting Acquisition 
Workstation 

Self-tests, Database Viewer/Setup, Mappings, 
Role Permissions, Tagged Images, DICOM 
dump, Get Images/Quality files 

 Computer Windows Services/Processes, System 
Management, Network information 

 Log Log: downloader, Flags, Config, Management, 
Viewer, Audit Viewer, Screen image 
download 

 Backups Backup: Create, Restore, Management, 
Parameters 
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5.5.1 Configure System Institution and Locale Information 
The system Capture application start-up and login screens have their own locale settings 
separate from any locale settings done through the Windows operating system. The 
locale settings for the system Capture application start-up and login screens are 
determined by settings in the Institution Information screen of System Tools. 

 

Note 
After logging in to the system Capture application, the locale of screens used by an 
operator are determined by the settings in Manage Operators feature. If you need to 
change this locale, go to Admin > Manage Operators. Select an operator, then go to Edit 
operator > Next screen and select a Locale. 

 

There are also other settings in the Institution Information screen which are displayed 
within the Capture application and used to populate DICOM fields. 

Perform the following instructions to configure the institution and locale information for 
the Capture application. 

1. In System Tools, navigate to AWS > Global > Institution (see following figure). 

 
Figure 85: System Tools > AWS > Global > Institution 
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2. Enter Name and Address values consistent with corporate customer naming 
conventions, or as directed by the customer to populate DICOM fields and text 
printed on film. 

3. Enter a Station name consistent with the desired DICOM Station Name field content. 
This field may be used by Modality Worklist and Print interfaces and should be 
noted among support records. 

 

 

Note 
Station name is a case sensitive field. 

 

   

4. Use the Department Name field to indicate location information more specific than 
the Address field. 

5. In the Locale field (item 1 in following figure), select the desired Locale from the 
dropdown list, then select Update (item 2). 

 

 

Note 
The Locale change does not take effect until the system application is restarted. 

 

   
 

 
Figure 86: Updating Locale in Institution Information 
 

6. Select Back to exit System Tools. 
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7. Select Back to exit the Admin screen. 
8. Select Logout to log out of the system Capture application. 
9. Close the system Capture application: 

a. On the Login screen, press Ctrl and select Shutdown simultaneously. 

b. On Startup screen, press Ctrl and select Exit simultaneously. 

10. Restart the system Capture application. The start-up and login screens should now 
reflect the new locale (see the following figures). 

 
Figure 87: System Capture application startup screen with new locale 

 

 
Figure 88: System Capture application login screen with new locale 
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5.5.2 Configure Serial Number in System Settings 
Perform the following instructions to configure the system serial number. This setting 
populates the serial number in the DICOM header, which are used by other systems to 
identify its licensed systems. 

1. In System Tools, navigate to AWS > Global > System Settings. 
2. In the Serial Number field, enter the System Serial Number and click Update. 

 
Figure 89:  System Tools > AWS > Global > Global Configuration > Serial Number field 

   
 

5.5.3 Configure Reclaimer Settings compatible with Storage Commitment 
Settings 
The default Reclaimer settings are compatible with the choice NOT to configure DICOM 
Storage Commit services with a connected archive device. The default is compatible with 
most customer choices not to activate Storage Commitment.   
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Perform the following instructions ONLY if Storage Commitment is enabled and the 
customer wants images to be protected from deletion until storage confirmation has been 
received from the archive device. 

1. In System Tools, navigate to AWS > Reclaimer > System Level. 
2. The System Level Reclamation Settings screen opens. Scroll to the bottom of the 

configuration screen. 

 
Figure 90: System Tools > AWS > Reclaimer > System Level 

 

3. If Storage Commitment is being used with an archive device, and the customer wants 
images to be protected until a Storage Commitment acknowledgment is received, 
select one of the Storage Commitment choices as shown in the following figure. Click 
Update. 

 
Figure 91:  System Level screen, Storage Commitment fields 
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Note 
By default, Storage Commitment is not enabled. 

If a Storage Commitments Ack becomes the selected choice, the system may need to 
remain on at all times, depending upon the operation of the archive device. Some 
archives perform permanent storage operations overnight.  

If Storage Commitment is NOT in use with any active output, ensure that the Storage 
Commitment settings are NOT checked. Otherwise, images are not reclaimed and the 
hard drive could eventually fill to capacity. 

 

   
 

4. Navigate to AWS > Reclaimer > User Level. 
5. The User Level Reclamation Settings screen opens. If Storage Commitment is being 

used with an archive device, select the desired "Requires Storage Commitment" 
setting for Radiologist, Technologist, and Manager users and other users of interest. 
Click Update. 

 
Figure 92: System Tools > AWS > Reclaimer > User Level Reclamation Settings  

 
 

 

Note 
By default, Storage Commitment is not enabled. 

If Storage Commitment is NOT in use with any active output, ensure that the Storage 
Commitment settings are NOT checked for any users. Otherwise, images are not 
reclaimed and the hard drive could eventually fill to capacity 
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5.6 Add Licensed Features 
When installing a new licensed feature on a system, or doing a new software install as 
part of a computer replacement in the workstation, follow these steps. 

1. Obtain the following, based on the situation: 
• Installing a new feature - Obtain the Sales Order number for that feature. 
• New software installation as part of a computer replacement - Obtain the SN# of the 

system (on the back of the Gantry) 
2. In the system Capture application, launch System (Service) Tools (Admin screen > 

System Tools). 
3. Log in as hologic service and type the appropriate password. 
4. Go to the AWS > Licensing page. 
5. Generate a feature request file (xxxxxx.holx). This file includes all the features 

currently activated on the system and the MAC address of the computer. 

a. Click Export. 

b. Right-click on Right-Click to Download. 

c. Select Save as target. 

d. Navigate to the folder where you want to save the xxxxxx.holx file. 

e. Make sure HOLX File is selected as file type. 

f. Click Save. 

6. Create an email and do the following, based on the situation: 
• Installing a new feature - Include the Sales Order # of the feature in addition to 

attaching the generated xxxxx.holx file. The Sales Order # is the only place where 
the new feature is identified in the license request procedure. 

• New software installation as part of a computer replacement - Include the SN # of the 
system in addition to attaching the generated xxxxx.holx file. 

7. Send email to 3D@Hologic.com. 
8. Receive a return email from 3D@Hologic.com with a new activation file (xxxxxx.holx). 

This file includes all the features currently activated on the system plus the new 
requested feature(s). 

9. In the same screen as in step 4, import the new activation file. 

a. Select Choose File. 

b. Navigate to the folder containing the new activation file, select the file, and click 
Open. 

c. Click Import. 

10. Exit from System Tools and reboot the computer. 
11. In the system Capture application, go to Admin > About screen >Licensing tab and 

verify that the new software feature or the correct system software level is installed. 
 

 

mailto:3D@Hologic.com
mailto:3D@Hologic.com
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5.7 DICOM Interface Configurations 

5.7.1 Configure System AE Title 
1. In System Tools, navigate to AWS > Connectivity > Connectivity (Global). 
2. In the System AE Title field, enter the System AE Title (collected in the Connectivity 

Site Survey). 
3. Scroll down to the bottom of the screen and click Update. 

 

 

Note 
It is necessary to restart the system Capture application for the change to take place. 
Complete the connectivity configurations, then restart the system Capture application. 

 

   
 

5.7.2 Configure the Store Output Devices 
Install/Test an Archive Interface 
The system on its own is not designed to provide permanent storage for patient images. 
Install an interface to a PACS or other DICOM storage devices that will archive the 
images sent from the Affirm Prone system. 

1. In System Tools, navigate to AWS > Connectivity > Install a device. 
2. In the Category field, select Archive from the dropdown list. 

 
Figure 93: System Tools > AWS > Connectivity > Install a Device > Archive 
Category field 
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3. In the dropdown list of the Model field, select the appropriate Archive choice for the 
environment of the customer. 

 
Figure 94: System Tools > AWS > Connectivity > Install a Device > Model field 

 

• Conventional (with Markers) – Use this model file for all 2D-only installations 
where the customer has a preference for burned-in markers (not recommended). 
The burned in marker feature on the Affirm Prone system includes the image’s 
laterality and view type. The control for marker settings can be found in 
Advanced Store Settings on page 121. 

• Conventional (with Markers) & Tomo BTO – Use this model file for 3D systems 
where the customer has a preference for burned-in markers (not recommended) 
and where the Storage device supports DICOM Breast Tomosynthesis Objects 
(BTO). 

• Conventional (with Markers) & Tomo SCO – Use this model file for 3D systems 
where the customer has a preference for burned-in markers (not recommended) 
and where the Sales Order indicates a customer request to use the DICOM 
Secondary Capture Object (SCO) to store proprietary 3D Mammography slice 
data. Use this model file when the customer environment does not support 
DICOM Breast Tomosynthesis Objects or when BTO data size is a concern. 

• Conventional (without Markers) – Use this model file for all 2D-only installations. 
• Conventional (without Markers) & Tomo BTO –  Use this model file for 3D systems 

where the where the Storage device supports DICOM Breast Tomosynthesis 
Objects (BTO). 

• Conventional (without Markers) & Tomo SCO – Use this model file for 3D systems 
where the Sales Order indicates a customer request to use the DICOM Secondary 
Capture Object (SCO) to store proprietary 3D Mammography slice data. Use this 
model file when the customer environment does not support DICOM Breast 
Tomosynthesis Objects or when BTO data size is a concern. 

• Generic PACS – Use this model file where no indication is given on the Sales 
Order of a particular type of archive device. 
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Caution: 
Be cautious using SCO to archive 3D Mammography images. The 3D SCO 
Mammography images are NOT stored in an interoperable format. Only Hologic 
products can display these images. Future charges may apply to convert 3D 
Mammography SCO tomosynthesis slice data to an interoperable format. 

 

 

4. Click Install this device.   
5. In the New Archive Installed screen, mouse over Basic, then click Basic Store. 

 
Figure 95: System Tools > AWS > Connectivity > Install a Device > New Archived 
Installed > Basic Store 
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6. In the Archive: Basic Store screen, enter the following information: 

 
Figure 96: System Tools > AWS > Connectivity > Install a Device > Archive : Basic Store 

• Name - the name used in the Output Group to identify the device 
• Manufacturer - the manufacturer of the device (such as GE, Philips, Agfa) 
• Model - the model (such as Centricity, IntelliSpace, Impax) 
• Host - the IP address of the device 
• Port - the TCP listening port on the archive device 
• Called AE Title - the AE Title of the archive device 

7. Do one of the following: 
• If System AE Title is being used, select the Use System Calling AE Title 

checkbox. The system AE Title displays on the bottom of the screen. Note that 
the System AE Title is configured at AWS > Connectivity > Connectivity (Global) 
screen. 

• If the System AE Title is not being used, enter the Store SCU application AE Title 
to use with this specific device in the Calling AE Title text box. 

8. Click Update. 
9. Click << Back. 
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10. In the Install a Device screen, mouse over Ping, then click Ping Store. The system 
indicates if the ping was successful or failed. If the ping failed, check the Host IP 
address entered for that device. 

 
Figure 97: System Tools > AWS > Connectivity > Install a Device > Ping Store 

 



Affirm Prone Biopsy System Service Manual 
Chapter 5: Setup, Configuration, and Connectivity 

 
 
 
 

 
MAN-04482 Revision 006 Page 115 
 

11. Mouse over Dicom Ping,then click Dicom Ping Store. The system indicates if the 
DICOM ping was successful or failed. If the DICOM ping failed, check the Called AE 
Title, Calling AE Title and/or Port field; and Host IP address. 

 
Figure 98: System Tools > AWS > Connectivity > Install a Device > Dicom Ping Store 

 

12. Repeat these steps for other direct send interfaces to workstation devices. 
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Install/Test a Workstation Interface 
Workstations may receive images in different ways; directly from the Affirm Prone 
system, through a PACS, or through an intermediary device (such as a SecurXchange 
router). Follow these instructions to install the proper type of workstation for your 
system. 

1. In System Tools, navigate to Welcome > AWS > Connectivity > Install a device. 
2. In the Category field, select Workstation from the dropdown list. 

 
Figure 99: System Tools >AWS > Connectivity > Install a Device > Workstation 
Category field 

 

3. In the dropdown list of the Model field, select the most appropriate default for the 
environment of the customer. 

 
Figure 100: System Tools >AWS > Connectivity > Install a Device > Model Field 
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Generic (non-Hologic) Workstations 
Typically, PACS workstations access mammography images through the PACS 
interface. If it is necessary to send image data directly to a Non-Hologic workstation, 
select one of the following models:  
• Generic Workstation Conventional (with Markers) – Use this option where the 

customer has a preference for burned-in markers (not preferred by most 
customers for biopsy procedures). The burned in marker feature on the Affirm 
Prone system includes the image’s laterality and view type. The control for 
marker settings can be found in Advanced Store Settings on page 121. 

• Generic Workstation Conventional (without Markers) – This option is the preferred 
model file for Non-Hologic workstations for all 2D-only installations. 

• Generic Workstation Conventional with BTO – This option is the preferred model 
file for Non-Hologic workstations for 3D installations. Note that if 3D 
Mammography Slices are sent to PACS and PACS workstations using the (BTO) 
object, any SecurView configurations must also be configured for BTO, else 
Annotations and Markings made on SecurView SCO images will not show up on 
the BTO images stored in PACS or displayed on Non-Hologic workstations. 

SecurView (Hologic) Workstations 
SecurView Workstation model files include sending both 3D Mammography Slice 
images (BTO or SCO format) and 3D Mammography projection images in SCO 
format. For more information on supported image types, refer to Advanced Store 
Settings on page 121. 
• SecurView Conventional & Tomo BTO – This option is the preferred model file for 

3D installations sending to SecurView workstations. 
• SecurView Conventional & Tomo SCO – Use this option when the Sales Order 

indicates the customer’s request to store 3D Mammography slice data as DICOM 
Secondary Capture Objects (SCO) to storage devices. This option should only be 
used when the environment of the customer cannot support the DICOM Breast 
Tomosynthesis Object or BTO data size is a concern. Keep in mind that when 
using this option, future charges to the customer may apply to convert this 
proprietary 3D format to the standardized BTO format. 

• SecurView Conventional Only – This model file is for SecurView workstations for 
2D-only installations. 

4. Click Install this device.   
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5. In the New Workstation Installed screen, mouse over Basic, then click Basic Store. 

 
Figure 101: System Tools >AWS > Connectivity > Install a Device > Basic Store 
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6. In the Workstation: Basic Store screen, enter the following information: 

 
Figure 102: System Tools > AWS > Connectivity > Install a Device > Workstation: Basic 
Store 

• Name - the name used in the Output Group to identify the device 
• Manufacturer - the manufacturer of the device (such as GE, Philips, Agfa) Model - 

the model (such as Centricity, Intellispace, Impax) 
• Model - the model (such as Centricity, IntelliSpace, Impax) 
• Host - the IP address of the device 
• Port - the TCP listening port on the device 
• Called AE Title - the AE Title of the device 

7. Do one of the following: 
• If System AE Title is being used, select the Use System Calling AE Title 

checkbox. The system AE Title displays on the bottom of the screen. 
• If the System AE Title is not being used, enter the Store SCU application AE Title 

to use with this specific device in the Calling AE Title text box. 
8. Click Update. 
9. Click << Back. 
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10. Mouse over Ping, click Ping Store. The system indicates if the ping was successful or 
failed. If the ping failed, check the Host IP address entered for that device. 

 
Figure 103: System Tools > AWS > Connectivity > Install a Device > Ping Store 
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11. Mouse over Dicom Ping, click Dicom Ping Store. The system indicates if the DICOM 
ping was successful or failed. If the DICOM ping failed, check the Called AE Title, 
Calling AE Title and/or Port fields; and Host IP address. 

 
Figure 104: System Tools > AWS > Connectivity > Install a Device > Dicom Ping Store 

 

12. Repeat these steps for other direct send interfaces to workstation devices. 
 

Advanced Store Settings 
Use these instructions to customize settings related to Transfer Syntaxes or Supported 
Image Types. Technical Support or Connectivity Specialists may require editing of 
Advanced Store settings. 

1. In System Tools, navigate to Welcome > AWS > Connectivity > List Installed 
Devices. 
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2. In the Device field, select the device to be configured from the dropdown list. 
Make sure the device to be configured is highlighted in the List Installed Devices 
window. 

 
Figure 105: System Tools >AWS > Connectivity > List of Installed Devices > Select Device 

 

3. Mouse over Advanced, then click Advanced Store. 

 
Figure 106: System Tools >AWS > Connectivity > List of Installed Devices > Advanced option 
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4. The Advanced screen opens. Scroll to the bottom of the screen. 
 

 
Figure 107: System Tools >AWS > Connectivity > List of Installed Devices > Advanced Store screen 

 

To Change Transfer Syntax Settings 
Transfer syntaxes determine how the data is encoded into bytes when transmitted 
over a network. Some transfer syntax selections also apply standardized compression 
algorithms before transmission. The transfer syntaxes negotiated with a device are 
listed in the Transfer Syntaxes (Selected) column. Choices are presented to the 
connected device from the bottom up. When sending data, the system chooses from 
the top to the bottom of the list among those syntaxes supported by the connected 
device (indicated though a DICOM association response). 
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a. Locate the Transfer Syntax configuration section under the Network section of 
the Advanced Store configuration screen. 

 
Figure 108: Transfer Syntax Configuration section in Advanced Store screen 

• To add a selected transfer syntax, click the unselected choice to highlight. 
Click the > arrow to move the selection to the Transfer Syntax (Selected) box. 

• To remove a selected transfer syntax, click the Transfer Syntax (Selected) 
choice to highlight. Click the < arrow to move the selection to the Transfer 
Syntax (Selected) box. 

b. Click Update at the bottom of the configuration screen. 

 

To Change DICOM Image Type Settings 
Selected Dicom Image Type settings determine which types of image data are and 
are not sent to a specific device. If the Selected Support Dicom Types control box does 
not include an Image Type necessary to satisfy workflow requirements at the 
customer site, move the ImageType from the Unselected Support Dicom Types control 
box to the Selected Support Dicom Types control box. 

a. Locate the DICOM Type configuration section under the Config section of the 
Advanced Store configuration screen. 

 
Figure 109: Dicom Types section in Advanced Store screen 

b. Move the image types to their proper selection box: 

• To send a DICOM image type to the device, click the unselected choice to 
highlight. Click the > arrow to move the selection to the Selected Dicom 
Types box. 

• To NOT send a DICOM image type to the device, click the Selected Dicom 
Type choice to highlight. Click the < arrow to move the selection to the 
Unselected Dicom Types box. 

c. Click Update at the bottom of the configuration screen. 
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5.7.3 Configure Query/Retrieve (Optional) 
1. In System Tools, navigate to Welcome > AWS > Connectivity > Install a device. 
2. In the Category field, select QR from the dropdown list. 

 
Figure 110: System Tools >AWS > Connectivity > Install a Device > QR Category field 

 

3. In the Model field, select the most appropriate model for the environment of the 
customer from the dropdown list. 

 
Figure 111: System Tools >AWS > Connectivity > Install a Device > QR Model field 
• MIMS – This model is based on the relational query model. Use this model only if the 

DICOM conformance statement of the device confirms support for and recommends 
using relational queries. SecurXchange and MIMS support relational queries. 

• Query and Retrieve – Hierarchical Query – This model is based on the hierarchical 
query model, which DICOM query providers must support by default. Use this 
model unless the DICOM conformance statement of the device confirms support 
for and recommends using a relational query. 
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4. Click the Install this device. 
5. In the New QR Installed screen, mouse over Basic, then click Basic Query. 
6. Enter/change the following information: 

• Name - the name used to identify this query device 
• Manufacturer - the manufacturer of the query device (such as GE, Siemens, 

Phillips) 
• Model - the model and software version (such as Centricity, Syngo, IntelliSpace) 
• Host - the IP address of the query device 
• Port - the TCP listening port on the query/retrieve device 
• Called AE Title - the AE Title of the query/retrieve device 

7. Do one of the following: 
• If the System Calling AE Title is being used for queries, select the Use System 

Calling AE Title checkbox. The system AE Title displays on the bottom of the 
screen. 

• If a customized Calling AE Title needs to be used for queries, uncheck Use 
System Calling AE Title and enter the appropriate Calling AE Title. 

8. Click Update. Notice the global AE Title in red being used at the bottom. 
9. Do one of the following: 

• If the query device is the same as the retrieve device: 

a. Select Set Retrieve address to this. The message “Retrieve address now 
matches the Query address field on this screen” appears at the top of the 
screen. 

b. Click << Back (at the upper left side of the window). 
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• If the query device is different from the retrieve device: 

a. Click << Back (at the upper left side of the window). 

b. Mouse over Basic, then click Basic Retrieve. 

c. Enter the following information: 
Name - the name used to identify the retrieve device 
Host - the IP address of the device from which to retrieve (this address may or 
may not be the same as the IP address of the query device) 
Port - the port of the retrieve device (this port may or may not be the same as 
the query device) 
Called AE Title - the AE Title of the retrieve device (this title may or may not 
be the same as the query device) 

d. Do one of the following: 
• If the System AE Title is being used, select the Use System Calling AE 

Title checkbox. The system AE Title displays on the bottom of the screen. 
• If the System AE Title is not being used, enter the Retrieve SCU 

application AE Title to use with this specific device in the Calling AE 
Title text box. 

e. Click Update. 

f. Click << Back. 
 

10. Mouse over Advanced, then click Advanced Retrieve. 
11. To set the Move Destination for the retrieve request, do one of the following: 

• If the System AE Title is to be used as the Move Destination, select the Use 
System Calling AE Title checkbox. The system AE Title displays on the bottom 
of the screen. 

• If the Retrieve Service is using a customized Calling AE_Title (set under the Basic 
Retrieve configuration screen), select Use Retrieve AE Title If Possible to allow 
the customized Calling AE Title as the Move Destination.  

• If a Move Destination is different than the System AE Title and any customized 
retrieve service Calling AE Title, uncheck Use System AE Title, uncheck Use 
Retrieve AE Title If Possible, and enter the retrieve destination AE Title in the 
Move Destination field 

12. Click Update. 
13. Navigate to AWS > Connectivity > SCP > Server. 
14. Enter the following information: 

• SCP Listening Port: should be 104 
15. Click Update. 
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5.7.4 Configure Modality Worklist (Optional) 
1. In System Tools, navigate to Welcome > AWS > Connectivity > Install a device. 
2. In the Category field, select MWL. 

 
Figure 112: System Tools > AWS > Connectivity > Install a device > MWL Category field 

 

3. In the Model field, click the down arrow and select the MWL Provider of the 
customer (such as Sectra). If the specific MWL provider is not listed, select Default 
Query. 

 
Figure 113: System Tools >AWS > Connectivity > Install a Device > MWL Model field 

 

4. Click Install this device. 
5. In the New MWL Installed screen, click Basic.  
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6. Enter the following information in these fields:  
• Name - the human readable name assigned to the worklist (such as Agfa). 
• Manufacturer - the name of MWL provider vendor 
• Model - the model name of the MWL provider application (such as Impax) 
• Host - the IP Address of the MWL (Modality Worklist) provider 
• Port - the TCP listening port on the MWL provider 
• Called AE Title - the AE (Application Entity) Title used by the MWL provider 

7. Make the appropriate choice for the service of the worklist AE Title. 
• If System AE Title is being used for Modality Worklist, select the Use System 

Calling AE Title checkbox. The system AE Title displays on the bottom of the 
screen. 

• If the System AE Title is not being used for Modality Worklist, enter the Store 
SCU application AE Title to use with this specific device in the Calling AE Title 
text box. 

8. Click Update. Verify any calling AE Title changes at the bottom of the screen. 
9. Click << Back. 
10. Click Advanced. 
11. Check that the Study Code field matches the field used by the MWL Provider for RIS 

codes. 
• If uncertain, set to the IHE framework choice. Click the down arrow and change 

the default value of Req Proc Code Seq, Code Val to SPS Seq, Sched Prot Code Seq, 
Code Val. 

• If interfacing to older McKesson worklist providers (which do not provide RIS 
codes), click the down arrow and change the default value of Req Proc Code Seq, 
Code Val to SPS Seq, SPS Desc. 

12. Click Update. 
13. Click << Back. 
14. Click Ping (An indication is presented if the test was successful or failed). 
15. Click DICOM Ping to test. (An indication is presented if the test was successful or 

failed). 
16. Click Perform a Query and use the right scrollbar to scroll until the query is visible. 
17. Click Query. 
18. In the Results window, the C-FIND-RQ sent to the MWL provider is displayed. If the 

MWL Provider returned any scheduled patients, the C-FIND-RSPs are also displayed 
in the Results window. Use this information to confirm the tag selected for the Study 
Code field. 

19. Repeat these steps if another modality worklist source is required by the customer. A 
maximum of two MWL providers may be configured. 

 



Affirm Prone Biopsy System Service Manual 
Chapter 5: Setup, Configuration, and Connectivity 
 

 
Page 130 MAN-04482 Revision 006 
 

5.7.5 Configure Printers (Optional) 
1. In System Tools, navigate to Welcome > AWS > Connectivity > Install a device. 
2. In the Category field, select Printer from the dropdown list. 

 
Figure 114: System Tools >AWS > Connectivity > Install a Device > Printer Category 
field 

 

3. In the Model field, select the printer model from the dropdown list for the 
environment of the customer. Contact Technical Support if the model is not listed. 

 
Figure 115: System Tools >AWS > Connectivity > Install a Device > Printer Model field 
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4. Click the Install this device. 
5. In the New Printer Installed screen, mouse over Basic and click. 

 
Figure 116: System Tools >AWS > Connectivity > Install a Device > New Printer 
Installed 

 

6. Enter/change the following information: 
• Name - the name used in the Output Group to identify the printer 
• Manufacturer - the manufacturer of the device (such as Agfa, Carestream, etc.) 
• Model - the model (such as DryStar 4500M, DryView 6800, etc.) 
• Version - the version at the time of configuration of this device 
• Host - the IP address of the printer 
• Port - the TCP listening port on the printer 
• Called AE Title - the AE Title of the printer 
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7. Do one of the following: 
• If System AE Title is being used, select the Use System Calling AE Title 

checkbox. The system AE Title displays on the bottom of the screen. 
 

 

Note 
Using the correct AE Title. Printed images may looked washed out and not have the 
proper LUT applied if an incorrect AE Title is used. 

 

   

• If the System AE Title is not being used, enter the Store SCU application AE 
Title to use with this specific device in the Calling AE Title text box. 

8. Click Update. 
9. Click << Back. 
10. In the New Printer Installed screen, mouse over Supported Film Sizes and click. 

 
Figure 117: System Tools >AWS > Connectivity > Install a Device > New Printer 
Installed > Supported Film Sizes Field 
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11. On the Printer Supported Film Sizes screen, you can: 
• Add film sizes not listed - Contact Technical or Connectivity Support for assistance 

on correct settings and syntax. 
• Remove film sizes not stocked by the site - Follow these steps to delete film sizes:  

a. Use the dropdown labeled Select to choose the film size to delete. 

 
Figure 118: System Tools >AWS > Connectivity > Install a Device > Printer > 
Supported Film Sizes 
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b. Make sure that the film size you want to delete is highlighted in purple. Click 
Delete. 

 
Figure 119: System Tools >AWS > Connectivity > Install a Device > Printer > 
Supported Film Sizes to Delete 

 

12. Click << Back. 
13. Do the following tests: 

• To test the network communication, mouse over Ping and click. The system 
indicates if the ping was successful or failed. If the ping failed, check the IP 
address entered for that device. 

• To test the DICOM communication, mouse over Dicom Ping and click. The 
system indicates if the DICOM ping was successful or failed. If the DICOM ping 
failed, check the Called AE Title, Calling AE Title and/or Port fields. 

14. Repeat these steps for other printers as needed. 
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6: System Calibration and Performance Tests 
6.1 System Calibration and Tests Overview 

This chapter outlines the Preventive Maintenance schedule, calibration procedures, and 
performance tests.  

Most system calibrations use the Calibration Tool (CalTool) (refer to Calibration Tool 
(CalTool) on page 138), while some adjustments use software tools from the Admin screen 
(refer to The Admin Screen on page 84). 

 

Note 
The procedures in this chapter are written for conventional (invasive) testing 
equipment. To use non-invasive testing equipment and techniques, follow the 
instructions provided by the manufacturer of the test equipment. 

 

Before calibrating/testing the system, have on hand the Affirm Prone Service Tool Kit 
(TLS-05909). 

Table 4: Service Tool Kit for Affirm Prone (TLS-05909) 
Part Number Description Quantity 

ASY-03949 ASSY, AFFIRM BGM QAS NEEDLE 1 

ASY-08307 ASSY. TARGETING PHANTOM 1 

ASY-08871 KIT, FUSES, HV GENERATOR 1 

ASY-09944 ASSY, KIT, COLLIMATION ALIGNMENT, 
AFFIRM PRONE BIOPSY 

1 

ASY-09945 ASSY, CASE, AFFIRM PRONE BIOPSY, 
COLLIMATION ALIGNMENT 

1 

MME-01182 PIN, DOWEL .1251DIA+.0002/-.0000X1" LG+/-
.010 STEEL RC 58-62  

1 

TLS-05434 C-FRAME SUPPORT STOP-SERVICE 1 

TLS-05884 TABLE ANGLE SUPPORT SETTING TOOL 1 

TLS-05908 TOOL, AFFIRM C-ARM / DETECTOR 
ALIGNMENT (6" X 5/16") 

1 

TLS-05910 TOOL, AFFIRM C-ARM / DETECTOR 
ALIGNMENT (2-1/2" X 5/16") 

1 

TLS-05913 TOOL, 5/64" T HANDLE 1 

TLS-06106 TOOL, EXTENSION SET 3/8" DRIVE QUICK 
RELEASE LOCKING, 3 PC (3", 6" & 10"LG) 

1 

 
 
 

Chapter 6 
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6.2 Preventive Maintenance Schedule 
  

 

 

Note 
The Preventive Maintenance Schedule for the User is in the Affirm Prone Biopsy System 
User Guide. 

 

   
   

Table 5: Service Engineer Preventive Maintenance 

Maintenance Task Description 
Recommended Frequency 

Semiannually Annually 

Clean and inspect the Gantry, Detector, and Acquisition 
Workstation 

x  

Check all primary power connections x  

Check interlocks, safety, and limit switches x  

Inspect C-arm and lubricate drive lead screw x  

C-arm / Verify all C-arm buttons x  

Verify Compression Force Calibration x  

Verify Detent Angle Calibration x  

Verify C-arm Angle Calibration x  

Perform C-arm Brake verification x  

Verify Tomo Arm Positioning x  

Verify kV Calibration and Tube Current Calibration x  

Check HVL Evaluation x  

Verify AEC Performance/Scaling x  

Verify X-ray Tube Alignment x  

Inspect/Lubricate Patient Platform Up/Down Drive Screws x  

Perform System Resolution Test x  

Perform Phantom Image Quality Evaluation x  

Perform Image Artifact Evaluation x  

Perform System Backup including Node Calibrations x  

Empty Reject Bin x  

Check UPS performance status x  
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Table 5: Service Engineer Preventive Maintenance 

Maintenance Task Description 
Recommended Frequency 

Semiannually Annually 

Voltage Verification (via CalTool) x  

Replace Detector Fan Filters x  

Service Filter Wheel x  

Service X-ray Tube x  
 

   
   

 

6.3 System Calibration 
 

 

 

Note 
For dose calibration, refer to MAN-05621 Affirm Prone system Dose Calibrations, 
CalTool. 

 

   

The primary software tool is the Calibration Tool (CalTool). This software application is 
resident on the Acquisition Workstation. 

 

Note 
Contact Hologic Technical Support for assistance using this tool if required. 

 

   
 

 



Affirm Prone Biopsy System Service Manual 
Chapter 6: System Calibration and Performance Tests 
 

 
Page 138 MAN-04482 Revision 006 
 

6.3.1 Calibration Tool (CalTool) 
 

 

A dongle needs to be connected to start the Calibration 
Tool (CalTool). If you do not have a dongle, contact 
3D@hologic.com and request a code for a temporary 
license. 
1. Launch CalTool (CalTool.bat) from the normal 

location/directory. 
2. In the InitialForm, for CAN Mode, select Real 

Gantry. 

 
Figure 120: CalTool Initial Form screen 

3. For Role, select Field Service. 
Role options include: 
• Biomed 
• Manufacturing 
• Field Service 
• Upgrade 
• Array Test 
• Developer 
The Field Service role is used for all Hologic service 
calibrations. 

4. Select Go to open CalTool. 
5. Click the TASK BAR to view tasks. 
6. Select a task. 
7. Perform the task. 

Click Help for more information. 

 
Figure 121: CalTool Task Bar 

 

mailto:3D@hologic.com
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Note 
Depending on Licensing (2D or 3D™), CalTool notifies availability of selected 
calibrations.  

 

   
 

6.3.2 Inverter Drawer Calibration 
Required Equipment/Tools 
• Standard Tool Set 
• High Voltage Divider Tanks or High Voltage probe 
• Oscilloscope 
• Digital Volt Meter (DVM) 
• mAs meter 
 

 

 

Note 
The Inverter (ASY-07006) and Multiplier (ASY-06980) pair require adjustments to 
ensure proper waveform flatness. 

 

   

Procedure 
1. For access to adjustments, remove the plastic cover on the front panel of the Inverter. 
2. kV leading waveform edge (Multiplier trim pot adjust). 

a. Use a Divider Tank to monitor kV waveforms with an Oscilloscope. 

b. Using CalTool, take 35kV, 100mA, 65mAs, Manual, LFS exposures and monitor 
the waveform. 

c. Adjust the feedback trim pot located on the Multiplier assembly above the mAs 
plug to obtain a square leading-edge waveform. (See the following figure.) 

 
 

 

Note 
The KV wave form must be adjusted before KV voltage adjustment. 

 

 
 

 
Figure 122: Correct Square Edge 

 
Figure 123: Undershoot, Adjustment 
Required 

 
Figure 124: Overshoot, Adjustment 
Required 
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3. Standby voltage (Inverter): Filament idle current (standby voltage) is factory set to 
2.5 amps. Verify the following: 

a. Monitor Filament idle current sense at TSTH1 pins 1-2 with voltmeter = 0.25 v 
(0.1 v = 1 amp) 

b. Acceptable range is 2.48 - 2.52 amps. Adjustment is done with FIL ADJ R14. If 
necessary, adjust before performing filament calibration. 

 

 
Figure 125: Front Panel Inverter Drawer (ASY-07006) 
 

4. kV voltage (Inverter): 

a. "kV" output voltage adjustment is done with potentiometer R196 HV ADJ. 

b. Monitor the waveform levels using a tank and oscilloscope or measure voltage 
with a DVM. 

c. Use CalTool to verify Generator kV. 

5. Tube current (Inverter): 

a. Tube current adjustment is done with MA ADJ R209. This potentiometer is 
factory set; adjust only if the measured mA is not correct. 

b. Use CalTool to verify Generator mA. 

6. Grid voltage (Inverter): 

a. Grid voltage is a legacy parameter and is not used. The voltage is factory set to -5 
(± 3) volts by jumper on KJ6 pins 2 and 4. 

b. Verify with voltmeter (+) to TSTH1 pin 4, voltmeter (-) to TSTH1 pin 7. 
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6.4 System Performance Tests 

6.4.1 X-Ray Tube Current Calibration 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• mAs Meter (invasive mAs meter or equivalent) 
• Tube Current Exposure Time Product Form—see Tube Current/Exposure Time Product 

Forms on page 283. 
 

Setup 
1. Turn the Generator Power OFF. 

 

 
WARNING! 
To reduce the risk of hazardous electrical shock, do not attempt service 
until the Red LED on the HV Inverter is extinguished (this takes 
approximately 5 minutes). Once the Red LED is extinguished, do not 
proceed until an additional 1 minute has elapsed. 

 

   

2. Remove the mA shorting jumper and insert the mAs meter probe. 
3. Cover the image receptor with lead. 

 

Test 
1. Turn the Generator power ON. 
2. Configure the Exposure Techniques: 

Mode Filter 

MAN Ag  

3. Refer to the Tube Current / Exposure Time Product Form. Configure the mAs and kV 
as shown in the first row and column—10 mAs, 25 kV. 

4. Take an exposure and record the mAs output measured in the Form. 
5. Reset the mAs meter for the next measurement. 
6. Repeat the previous exposure sequence for each of the remaining mAs and kV 

combinations. Do not take an exposure for any of the cells which are grayed out. 
7. Turn the Generator power OFF. 
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WARNING! 
To reduce the risk of hazardous electrical shock, do not attempt service 
until the Red LED on the HV Inverter is extinguished (this takes 
approximately 5 minutes). Once the Red LED is extinguished, do not 
proceed until an additional 1 minute has elapsed. 

 

   

8. Remove the mAs meter probes and replace the mAs shorting jumper. 
 

6.4.2 X-Ray Tube Voltage 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• Invasive high voltage divider or a non-invasive system 
• Digital voltmeter 
• Coaxial cable and BNC to banana plug 
• Adapter cable to connect the divider to the test receptacle on the HV Generator 
• Peak Tube Potential Form—see Peak Tube Potential Form on page 283. 
 

 

 
WARNING! 
To reduce the risk of hazardous electrical shock, do not attempt service 
until the Red LED on the HV Inverter is extinguished (this takes 
approximately 5 minutes). Once the Red LED is extinguished, do not 
proceed until an additional 1 minute has elapsed. 

 

   
 

Setup 
1. Turn the entire system OFF. 
 

 

 
WARNING! 
To reduce the risk of hazardous electrical shock, do not attempt service 
until the Red LED on the HV Inverter is extinguished (this takes 
approximately 5 minutes). Once the Red LED is extinguished, do not 
proceed until an additional 1 minute has elapsed. 

 

2. Connect a DC voltmeter to the low voltage terminals of a 1000:1 Voltage Divider 
using a coaxial cable and a BNC to banana plug splitter. 

3. Position the meter where it can be read from behind the radiation shield. 
4. Connect the ground lug of the high voltage divider to a chassis ground point located 

on the HV Multiplier Assembly. 
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Test 
1. Power ON the entire system. 
2. Boot up the computer, close out all applications, and open CalTool. 
3. Click Advanced Form, then click the Technique tab. 
4. Set up the manual mode KVs and mAs accordingly. Click the Arm button. 
5. Using the Peak Tube Potential (kV) Form make an exposure at the first kV, mAs 

setting in the table, and record the meter reading. 
6. Confirm that the meter reading falls into the range shown on the Form. 
7. Repeat steps 4 and 5 for each of the remaining exposures. 
8. Shut down the system. 
 

 

 
WARNING! 
To reduce the risk of hazardous electrical shock, do not attempt service 
until the Red LED on the HV Inverter is extinguished (this takes 
approximately 5 minutes). Once the Red LED is extinguished, do not 
proceed until an additional 1 minute has elapsed. 

 

9. Remove the test equipment. 
 

6.4.3 Half Value Layer (HVL) 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

    
 

Follow the HVL (Half Value Layer) Spot Check test in CalTool. Record the results in 
CalTool also. 

6.4.4 Linearity 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• Radiation Meter (for example, Rad Cal 2026C Series, Unfors, or equivalent) 
• Linearity Form—see Linearity Form on page 284. 
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Setup 
1. Connect the radiation probe per product the instructions of the manufacturer. 
2. Place the readout/logic module where it can be easily read. 
3. Select exposure in milliroentgen on the function switch. 
4. Cover the image receptor with a lead shield.  
5. Position the x-ray meter probe on the breast tray centered along the chest wall and 1 

cm from the edge of the receptor. The plane of the probe surface must be aligned so 
that it is perpendicular to the x-ray beam axis. 

 

Test 
1. Configure the Exposure Techniques: 

Mode Filter kV 

MAN Ag 35 

2. Set the mAs to 10 and take an exposure. 
3. Record the milliroentgen output on the Form. 
4. Reset the meter. 
5. Repeat the exposure sequence for each of the remaining mAs settings. 
6. Remove the meter from the breast tray. 

 

6.4.5 Reproducibility 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• Radiation Meter (for example, Rad Cal 2026C Series, Unfors, or equivalent) 
• Rad Cal 20x6-6 mm Probe (or equivalent) 
• Reproducibility Form—see Reproducibility Form on page 284. 

 

Setup 
1. Connect the radiation probe per product manufacturer's instructions. 
2. Place the readout/logic module where it can be easily read. 
3. Select exposure in milliroentgen on the function switch. 
4. Cover the image receptor with a lead shield.  
5. Position the x-ray meter probe on the breast tray centered along the chest wall and 1 

cm from the edge of the receptor. The plane of the probe surface must be aligned so 
that it is perpendicular to the x-ray beam axis. 
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Test 
1. Configure the Exposure Techniques: 

Mode Filter kV 

MAN Ag  25 

2. Take an exposure and record the milliroentgen output measured on the Form. 
3. Reset the Meter. 
4. Reset the kV and mAs settings to values different than those listed in the table, and 

then return them to their original values. 
5. Repeat the exposure sequence as indicated previously until 10 complete exposures 

have been taken. 
6. Calculate the Coefficient of Variation for all 10 readings: 

Coefficient of Variation = (Standard Deviation/Mean) 
7. Remove the meter from the breast tray. 

 

6.4.6 X-Ray Tube Alignment 
The X-Ray Tube Alignment is performed to ensure that the x-ray tube is properly 
positioned over the collimator and detector. 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• Geometry Cal Phantom (ASY-08265) 
 

Procedure 
Follow the X-Ray Tube Alignment procedure listed in CalTool. 

6.4.7 X-Ray Field Detector Alignment 
The X-Ray Field Detector Alignment is performed to ensure that the X-ray field falls on 
the correct portion of the detector. 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• X-ray Field and Detector Alignment Paddle (TLS-05650) 
 

Procedure 
Follow the X-Ray Field Detector Alignment procedure listed in CalTool. 
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6.4.8 X-Ray Field Collimator Alignment 
The X-Ray Field Collimator Alignment is performed to ensure that the collimator 
properly shapes the X-ray field. 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   

Required Equipment/Tools 
• X-ray Field and Detector Alignment Paddle (TLS-05650) 
 

Procedure 
Follow the X-Ray Field Collimator Alignment procedure listed in CalTool. 

6.4.9 Leakage from Diagnostic Source Test 
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

    
 

 

 

Note 
Make sure that the system is operational and all covers are installed. 

 

 

Required Tools/Equipment 
• Any radiation survey probe capable of reading exposure in mR/hr. For example: 

• Unfors Xi Base Unit (Unfors #8201021-H) 
• Unfors Xi Survey Detector (Unfors #8202060-C) 

• Floor Stand 
• X-ray Shield 
• X-ray Booth or Shields 
 

Procedure 
1. Verify that there is at least six feet between the Remote X-Ray Switch to the X-Ray 

Tube. 
2. Lower the Patient/Platform Gantry to its lowest position. 
3. Remove any paddles from the stage assembly if they are present. 
4. Attach a lead blocker to the X-ray port. 
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5. Place the Radiation Probe onto a tripod and position the probe so that it is located 
two feet from the tubehead directly in front of the detector. The probe positions are 
shown in the following figure. 

 

 
Figure 126: Probe positions from side of tubehead 

 

 

 

 

 
Figure 127: Probe position above 
tubehead 

 

6. Adjust the probe height so that the center of the probe is in line with the Focal Spot of 
the Tube. 

7. Place the readout / logic module onto the AWS. 
8. Select exposure in milliRoentgen on the function switch. 
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9. Refer to the criteria in the following table. 
 

Table 6: Leakage from Diagnostic Source (49kV, 140ma, 140mAs) 
Probe 

Position 
(see 

previous 
figure) 

Location μR 
Measured 

in Dose 
Mode 
Meter 

Output 
(μR) 

Exposure 
Scale 
Factor 

Exposures 
In One 
Hour 

Calculated 
Value 
(mR) 

Safety 
Margin 

Calculated 
Value 
(mR) 

--------------- 
1.25* 

Max 
Allowed 
(mR) in 

One 
Hour 

Results 

1 Front  2 48  1.25  100  

2 Left Side  2 48  1.25  100  

3 Back  2 48  1.25  100  

4 Right Side  2 48  1.25  100  

5 Top  2 48  1.25  100  

* Calculated (mR) x 1.25 = [(Measured Dose (microroentgen) x 2 x 48 x 1.25) / 1000] 
 

10. Open the Calibration Tool. 
11. Configure the Exposure Techniques as indicated in the table below. 

Modality Mode Filter kV mA mAs 

Conv. MAN Ag 28 160 200 
   

12. Take three warm-up exposures 45 seconds apart. 
13. Configure System to take Leakage Exposure. 
14. Configure the Exposure Techniques as indicated in the table and Image below. 

Modality Mode Filter kV mA mAs 

Tomo MAN Al 49 140 140 
 

15. In the Advanced Form, click the Tomo tab. 
16. Set the Tomo Arc Mode to Zero in order to prevent the tube from moving during the 

exposure. 
17. Configure the probe to take a measurement in dose mode.  
18. Press the Dose button and then take an exposure. 
19. Record the reading into the appropriate area of the Leakage from Diagnostic Source 

table. 
20. Verify that the reading is within acceptable limits. 
21. Repeat the exposure measurement sequence for each of the remaining probe 

locations indicated. 
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22. Record the pass/fail results in the Expected Results table. 

Table 7: Expected Results 
Probe Position 
(see previous 

figure) 

Probe 
Location 

Radiation 
measured in 
Dose Mode  

Pass/Fail 

1 Front < 100 mR  

2 Left < 100 mR  

3 Back < 100 mR  

4 Right < 100 mR  

5 Top < 100 mR  
 

 

6.4.10 Image Artifact Evaluation 
Follow the "Artifact Evaluation" test in the 1999 ACR QC Manual for Stereotactic Breast 
Biopsy. 

6.4.11 System Resolution Test 
Follow the "Focal Spot Performance and System Limiting Spatial Resolution" test in the 
1999 ACR QC Manual for Stereotactic Breast Biopsy. 

6.4.12 Phantom Image Quality Test 
Follow the "Image Quality Evaluation" test in the 1999 ACR QC Manual for Stereotactic 
Breast Biopsy. 

6.4.13 AEC Function Performance/Scaling Test 
Follow the "Automatic Exposure Control (AEC) or Manual Exposure Function 
Performance Assessment" test in the 1999 ACR QC Manual for Stereotactic Breast Biopsy. 

6.4.14 Target Dose Verification 
Follow the "Breast Entrance Exposure, Average Glandular Dose, and Exposure 
Reproducibility" test in the 1999 ACR QC Manual for Stereotactic Breast Biopsy. 

For locations following ACR standards, verify that the dose is set for: 

• Stereotactic Biopsy Dose - 1.60 mGy 
• Tomosynthesis Dose, 30 projections - 1.80 mGy 
For more dose calibration information, refer to MAN-05621 Affirm Prone system Dose 
Calibrations, CalTool. 

6.4.15 Signal-to-Noise Ratio Test 
Follow the "Digital Receptor Uniformity" test in the 1999 ACR QC Manual for Stereotactic 
Breast Biopsy. 
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6.4.16 Standard System Test 
Required Equipment/Tools 
• Mammography Phantom 
 

Procedure 
1. Turn system on. 
2. Confirm system boots up and application loads correctly. 
3. Acquire an image using a Mammography Phantom. 
4. Verify that the image on the Acquisition Workstation meets the requirement of 5 

Fibers, 4 Specs, and 4 Masses. 
 

6.5 Biopsy Module Calibration 
This section describes the tools and procedures required to perform the Biopsy module 
subsystem calibrations. 

The Guidance Hardware calibrations do not involve imaging and can be implemented by 
using CalTool. The Geometry and STX calibrations require image capture. 

6.5.1 Required Tools and Equipment 
 

Description Image Part Number 

QAS Phantom Needle 
 

ASY-03949 

Tomosynthesis QAS Phantom 

 

ASY-06255 

5 x 5 Standard Biopsy Paddle 

 

ASY-08175 

Geometry Calibration Phantom 

 

ASY-08265 

Stage Arm (Biopsy Arm) Calibration 
Tool  

TLS-05629 
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Description Image Part Number 

X-ray Field and Detector Alignment 
Paddle 

 

TLS-05650 

Biopsy Device with Holder 

 

 

Needle Guide 

 

 

 
 

 
 

6.5.2 Front Needle Guide Alignment 
The purpose of this procedure ensures that the movable needle guide does not cause 
deflection of the needle in the XY plane as the guide is moved in Z direction. The Target 
Space-Guidance Space Transform Calibration makes sure that the Biopsy Guidance 
Module stage (and the biopsy device holder) is aligned to Target Space, but it cannot 
account for deviation of the device needle caused by movable needle guide alignment. 

Required Equipment/Tools 
• X-ray Field and Detector Alignment tool (TLS-05650) 
• Biopsy Device with Holder 
• Needle Guide 
 

Procedure 
1. Install the Needle Guide on the front Needle Guide mount. 
2. Install the Biopsy Device with an appropriate gauge biopsy needle (inspect for bent 

or damaged needle) on the Biopsy Guidance Module so that the needle passes 
through the front Needle Guide. Tighten the Biopsy Guidance Module knob to 
secure the Biopsy Device in place. 

3. Turn the Z-axis adjustment to position the Biopsy Guidance Module mount to the 
top of its travel. 

4. Place the X-ray Field and Detector Alignment tool (TLS-05650) on the breast tray, 
ensuring the front locating pins are flush against the tray. 

5. Slide the front Needle Guide fully toward the breast tray. 
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6. Using the Biopsy Control Module XY jog functions, move the X- and Y-axes until the 
needle tip is positioned over the QAS Needle Zero Reference point on the fixture. 
Use the Z-axis adjustment to position the needle tip just over the Reference point line 
intersection; it may be necessary to jog Y while adjusting Z. 

7. Slowly slide the front Needle Guide upward until just short of full travel. 
8. Observe the needle tip; if the position of the tip relative to the fixture Reference point 

line intersection has deviated in X, Y, or both axes: 

a. Loosen the screws securing the front Needle Guide. 

b. Move the Needle Guide to return the needle tip to the Reference point. 

c. Tighten the screws and recheck the needle movement. 

9. Repeat as necessary until the needle tip does not deviate between the top and bottom 
front Needle Guide positions. 

 

6.5.3 Biopsy Guidance Hardware Procedures 
The Biopsy guidance hardware calibration consists of three procedures located in the 
Biopsy section of CalTool. The procedures are done in the order they are listed: 

a. Detent Calibration 

b. Guidance Hardware Limits* 

c. Guidance Hardware Zero 

Follow the directions in CalTool to perform these procedures. 

*The Guidance Hardware Limits calibration can be done using the method described in 
CalTool, or it can be done by an alternate method as described later in this section. 

Required Equipment/Tools 
• Stage Arm (Biopsy Arm) Calibration Tool (TLS-05629) 
 

 

 
WARNING! 
These procedures require power to be connected to the system while 
certain covers are removed. Be careful to avoid contacting high-voltage 
components. 

 

 
 

 
Caution: 
Do not advance the X-axis or Y-axis assemblies past the point indicated in these 
procedures or damage to components may result. 

 

 
 

 

Note 
Perform these procedures after installing or servicing Biopsy Control Module 
hardware. 
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Cover Removal to Perform Tests 
1. Rotate the Biopsy Control Module so it is perpendicular to the C-arm. 
2. Remove the following covers: 

• Biopsy Arm front-end cover (refer to Remove Front-end Cover of Biopsy Control 
Module on page 192)  

• Biopsy Arm rear-end cover (refer to Remove Rear-end Cover of Biopsy Control 
Module on page 193) 

• Biopsy Control Module display covers (both sides, but only have one removed at 
any given time) (refer to Remove Displays/Covers of Biopsy Control Module on page 
190 ) 

• Biopsy Control Module display bottom cover (refer to Remove Bottom Cover of 
Biopsy Control Module Display on page 194) 

3. Keep power applied to system, as it is needed to perform the calibration. 
 

 

Note 
You can use the jog controls in CalTool or the controls on the Biopsy Control Module 
screen to jog the X-axis assembly and Y-axis assembly as prompted in these procedures. 
In either case, however, you must have at least one Biopsy Control Module display 
connected to be able to jog the X-axis and Y-axis assemblies. Consequently, you may 
need to alternate the removal and replacement of the Biopsy Control Module displays 
so there is as at least one display connected at all times during the setting of the min 
and max endpoints. 

 

 

Alternate Method - Guidance Hardware Limits Calibration 
The Guidance Hardware Limits calibration sets the minimum (min) and maximum (max) 
endpoints of the X-, Y-, and Z-axis. The following procedure uses a slightly different 
method to determine these endpoints than the steps shown in CalTool, but this alternate 
procedure stills use CalTool and the Stage Arm (Biopsy Arm) Calibration Tool (TLS-
05629). 
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1. At the Acquisition Workstation, in CalTool, go to Biopsy > Guidance Hardware 
Limits. 

2. Jog the X-axis assembly to the right until the X-axis support shaft bearing just meets 
the beginning of the flat on the support shaft (see arrow in the following figure).  

 
Figure 128: Moving X-axis assembly to reach max 
endpoint  

Legend 

1.  Support Shaft Bearing 
2.  Flat of the Support Shaft 

 

3. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the X-axis "max" endpoint. 
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4. Click Next in CalTool. Jog the Y-axis assembly up until two screw threads on the Y-
axis drive screw are just visible (see following figure). 

 
Figure 129: Moving Y-axis assembly to reach max endpoint 

 

5. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the Y-axis "max" endpoint. 

6. Click Next in CalTool. Rotate counterclockwise the needle advance/retract knob 
(representing the Z-axis) so the needle assembly is moving away from the breast 
platform (see following figure). Do this rotation until it reaches a hard stop.  

 
Figure 130: Moving Z-axis to determine min and max endpoints 

 

7. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the Z-axis "max" endpoint. 
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8. Click Next in CalTool. Jog the X-axis assembly to the left until the X-axis support 
shaft bearing just meets the beginning of the flat on the support shaft (see the 
following figure). 

 
Figure 131: Moving X-axis assembly to reach min 
endpoint 

Legend 

1.  Support Shaft Bearing 
2.  Flat of the Support Shaft 

 

9. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the X-axis "min" endpoint. 
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10. Click Next in CalTool.  

a. Before you start the next (Y-axis "min" endpoint) calibration, move the X-axis 
assembly back to the "max" endpoint position (as done in step 2) for better access. 

b. Slip the calibration tool (TLS-05629) between the bottom of the drive screw and 
bottom gear (see the following figure). Jog the Y-axis assembly down until it 
meets the calibration tool. 

 

 
Figure 132: Moving Y-axis assembly to reach min endpoint with calibration tool 

 

11. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the Y-axis "min" endpoint. 

12. Remove the calibration tool (you may need to jog up the Y-axis assembly slightly). 
13. Click Next in CalTool. Rotate clockwise the needle advance/retract knob so the 

needle assembly is moving towards the breast platform (see figure from step 6). Do 
this rotation until it reaches a hard stop. 

14. When this point has been reached, click Apply under the Execute Procedure tab in 
CalTool. This step sets the Z-axis "min" endpoint. 

15. When finished, replace the: 
• Biopsy Control Module display bottom cover 
• Biopsy Control Module displays (both sides) 
• Biopsy Arm front-end cover  
• Biopsy Arm rear cover 
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6.5.4 Geometry Calibration Procedure 
Geometry calibration is required semiannually. Perform this calibration using the 
Geometry phantom supplied with the system. 

Required Equipment/Tools 
• Geometry Calibration Phantom (ASY-08265) 
 

Procedure 
1. Inspect the calibration phantom for damage. 
2. Select the Admin > Quality Control > Technologist tab > Geometry Calibration 

procedure on the Acquisition Workstation. 
3. Select Start. 
4. Follow the instructions on the screen and take the predefined exposure. Do not 

change the preselected techniques. 
5. Accept the image. When you see the message that the geometry calibration was 

completed successfully, click OK. 
6. Select End Calibration. 
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6.5.5 STX Calibration 
The STX calibration is used to map the needle coordinates to the detector space. The STX 
calibration requires moving the QAS needle to pre-defined coordinates and uses the QAS 
needle (not the QAS phantom). Keep in mind that you need to bring your own QAS 
needles, as they are not supplied to customers. 

 

Note 
You must be logged in as Service to be able to calibrate all 15 STX positions. 

 
 

 

Note 
Before you start the STX calibration, ensure that the Biopsy Hardware Calibrations have 
been performed first (refer to Biopsy Guidance Hardware Procedures on page 152). These 
calibrations ensure that the encoder hardware components in the biopsy arm are 
accurately calibrated. 

 

   

Required Equipment/Tools 
• QAS Phantom Needle (ASY-03949) 
 

Procedure 
1. Install the QAS needle on the Gantry and lock in place. 
2. From the AWS, press the Admin button, then the STX Calibration button. The first 

target is automatically sent to the Biopsy Control Module. 
3. Move to the first target by holding the motor enable buttons on the front and rear of 

the Biopsy Control Module. 
4. Manually dial in the Z axis until you reach the target. 
5. Take the first exposure. 
6. Accept the image. 

 

 
Tip: 

For the following steps, use the zoom and/or magnification feature to enlarge the target 
area. 

 
 

7. Accept the target. 
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8. Select the next stereo pair, and repeat steps 4 through 7 for the first five exposures. 
9. After the first five exposures, move to the biopsy-arm angle shown on the 

Acquisition Workstation. Refer to the following table. 
Table 8: Calibration Target List (for reference only) 

 C-Arm Angle Biopsy Arm Angle X Y Z 

1 +90.0° 0.0° Center  30.0  5.0  5.0 

2 +90.0° 0.0° Center  30.0 45.0 95.0 

3 +90.0° 0.0° Center -30.0 40.0  5.0 

4 +90.0° 0.0° Center -30.0 15.0 95.0 

5 +90.0° 0.0° Center     0 15.0 30.0 
 C-Arm Angle Biopsy Arm Angle X Y Z 

6 +90.0° +90.0° Right  30.0  5.0 20.0 

7 +90.0° +90.0° Right  30.0 45.0 60.0 

8 +90.0° +90.0° Right -30.0 40.0 20.0 

9 +90.0° +90.0° Right -30.0  5.0 60.0 

10 +90.0° +90.0° Right     0 15.0 30.0 
 C-Arm Angle Biopsy Arm Angle X Y Z 

11 +90.0° +90.0° Left  30.0  5.0 20.0 

12 +90.0° +90.0° Left  30.0 40.0 60.0 

13 +90.0° +90.0° Left -30.0 45.0 20.0 

14 +90.0° +90.0° Left -30.0  5.0 60.0 

15 +90.0° +90.0° Left     0 15.0 30.0 
 

 

 

Note 
If the points used during the STX calibration cannot be reached, perform the Guidance 
Hardware Zero procedure in CalTool. If that does not suffice, perform the Biopsy Arm 
hardware calibration (refer to the Hardware Range Calibration on page 285 in the 
appendix), then perform the Guidance Hardware Zero procedure in CalTool. When 
finished, restart at step 1 of this STX calibration. 

 

10. When the 15 exposures are complete, rotate the biopsy arm to 0° (center position).  
11. Press End QC to end calibration. 
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6.5.6 Biopsy Calibration Interaction 
The interaction between the calibrations related to Guidance and Geometry is listed in 
the following table. Note that the only interdependency is that of the STX Calibration on 
the Guidance Hardware Calibration. 

Table 9: Calibrations 
A change to... ...affects this calibration 

 Guidance 
Hardware Cal 

Geometry 
Cal 

STX Cal 

Guidance Hardware Cal Yes No Yes 

Geometry Cal No Yes Yes 

STX Cal No No Yes 

 

An STX Calibration is necessary if a Guidance Hardware Calibration Limits or Guidance 
Hardware Zero is performed from CalTool, or if the QAS Test fails. The Geometry Cal is 
the only Biopsy subsystem calibration the customer is expected to perform. 

6.5.7 The QAS Test 
Perform the Quality Assurance Standard (QAS) Test procedure to make sure of accurate 
alignment and performance of the needle guidance system when you use the system. 

 

Note 
You can use Auto C-Arm Stereo Mode or Manual C-arm Stereo Mode for the QAS Test. 
For more information about these modes, refer to the User Guide. 

 

    
 

 
Caution: 
When you use a QAS Needle Phantom, do not extend the needle unless it is attached 
to the Biopsy Guidance Module and the module is installed on the C-arm. Always 
retract the QAS Needle Phantom before moving the biopsy arm. 

 

 

Required Equipment/Tools 
• QAS Phantom Needle (ASY-03949) 
• Tomosynthesis QAS Phantom (ASY-06255) 
 

Procedure 
1. From the console, select Admin, then QAS. 
2. Do not change the preselected technique. 
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3. On the QAS screen, select the Biopsy tab. Verify that Affirm QAS appears in the 
Device field (see following figure). 

 
Figure 133: Affirm QAS Device Selected in Biopsy Tab 

 

4. Move the Biopsy Arm to the Standard 0 degree approach. 
5. Remove the Compression Paddle. 
6. Move the Z-axis slide rail to 55 mm and 65 mm. 
7. Attach the QAS Phantom Needle (ASY-03949) at the top end of the Z-axis slide rail, 

fully extend the needle. 
8. Select the QAS view. 
9. Press and hold a right or left Motor Enable button on the Biopsy Control Module. 

The QAS Phantom Needle moves automatically to pre-programmed X and Y 
positions. 

10. Turn the Z-axis Control Knob to show 0.0 (+/- 0.1) on the Differential line in all three 
columns of the Biopsy Control Module. 

11. Acquire and Accept the first view in the procedure. The Auto-Accept feature is not 
enabled during the QAS procedure, and targeting on the QAS Phantom Needle 
occurs automatically. 

12. Select Create Target to send the target to the Biopsy Control Module. Verify that the 
target coordinates are within ± 1 mm of X, Y, and Z numbers on the current line of 
the Biopsy Control Module. 

13. Retract the QAS Phantom Needle. 
 

 
Caution: 
If the targeting coordinates are not within ± 1 mm, contact Technical Support. Do not 
try to adjust the system. Do not perform any biopsy procedure with the Affirm until 
Technical Support indicates that the system is ready for use. 

 

 
 

 
Caution: 
The user or a Service Engineer must correct problems before the system is used. 
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14. Move the Biopsy Arm to the -90 degree approach. 
15. Extend the QAS Phantom Needle. 
16. Select the QAS Lateral -90 view. 
17. Press and hold a right or left Motor Enable buttons on the Biopsy Control Module. 

The QAS Phantom Needle moves automatically to pre-programmed X and Y 
positions. 

18. Turn the Z-axis Control Knob to show 0.0 (+/- 0.1) on the Differential line in all three 
columns of the Biopsy Control Module. 

19. Acquire and Accept the view. The Auto-Accept feature is not enabled during the 
QAS procedure, and that targeting on the QAS Phantom Needle occurs 
automatically. 

20. Select Create Target to send the target to the Biopsy Control Module. Verify that the 
target coordinates are within ± 1 mm of X, Y, and Z numbers on the current line of 
the Biopsy Control Module. 

21. Retract the QAS Phantom Needle. 
22. Move the Biopsy Arm to the +90 degree approach. 
23. Extend the QAS Phantom Needle. 
24. Select the QAS Lateral +90 view. 
25. Press and hold a right or left Motor Enable buttons on the Biopsy Control Module. 

The QAS Phantom Needle moves automatically to pre-programmed X and Y 
positions. 

26. Turn the Z-axis Control Knob to show 0.0 (+/- 0.1) on the Differential line in all three 
columns of the Biopsy Control Module. 

27. Acquire and Accept the view. The Auto-Accept feature is not enabled during the 
QAS procedure, and that targeting on the QAS Phantom Needle occurs 
automatically. 

28. Select Create Target to send the target to the Biopsy Control Module. Verify that the 
target coordinates are within ± 1 mm of X, Y, and Z numbers on the current line of 
the Biopsy Control Module. 

29. Retract and remove the QAS Phantom Needle. 
30. Select the Biopsy tab. 
31. Move the Biopsy Arm to the Standard 0 degree approach. 
32. Select the Tomo Biopsy view. 
33. Install the tomosynthesis QAS Phantom (ASY-06255). 
34. Press and hold a right or left Motor Enable buttons on the Biopsy Control Module. 

The QAS Phantom Needle moves automatically to pre-programmed X and Y 
positions. 

35. Turn the Z-axis Control Knob to show 0.0 (+/- 0.1) on the Differential line in all three 
columns of the Biopsy Control Module. 
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36. Acquire and Accept the view. The Auto-Accept feature is not enabled during the 
tomosynthesis QAS procedure, and that targeting on the tomosynthesis QAS 
Phantom occurs automatically. 

37. Select Create Target to send the target to the Biopsy Control Module. Verify that the 
target coordinates are within ± 1 mm of X, Y, and Z numbers on the current line of 
the Biopsy Control Module. 

38. Remove the tomosynthesis QAS Phantom. 
39. Select End QC on the Acquisition Workstation screen. 
 

 

6.5.8 Biopsy Calibration - Maximum Compression Force 
Required Equipment/Tools 
• 5 cm x 5 cm Standard Biopsy Paddle (ASY-08175) 
• Force gauge 

Procedure 
1. Attach the Standard Biopsy Paddle to the Biopsy Arm. 
2. In CalTool, run the Max Compression Force test to verify the compression force of 

the paddle. 
3. Use the Z knob on the biopsy arm control to move Z to the position furthest away 

from the breast tray. This step allows motorized compression over the full range of 
the force calibration. 

4. Hold the force gauge fixture on breast tray with the pressure plate towards the 
paddle. Compress using motorized compression until compression stops (use the 
foot switch to drive the compression down). Do NOT further compress by hand. 

5. Examine the force gauge (the current reading is the maximum motorized 
compression force). The standard maximum is 16 lbs (71 Newtons). If the current 
reading is not 16, change the maximum current to the motor. Click Change and 
follow the instruction in the prompt. 

 

 

Note 
If your site requests a lower maximum motorized force, change the motor current until 
you achieve that force instead of 16 lbs. 

 

 

6. When you are satisfied with the max compression force settings, the calibration is 
complete. 
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6.5.9 Compression Thickness Calibration 
Required Equipment/Tools 
• 5 cm x 5 cm Standard Biopsy Paddle (ASY-08175) 
• 4 cm of BR12 (or equivalent) 

Procedure 
1. Attach the Standard Biopsy Paddle to the Biopsy Arm. 
2. Place the BR12 on the breast platform. 
3. In CalTool, run the Compression Thickness tool to calibrate the compression 

thickness of the paddle. 
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7: System Maintenance - Generator 
7.1 Introduction 

This chapter describes maintenance information and instructions for the Generator, 
including: 

• Component identification 
• Cover removal 
• Component replacement procedures 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

    
 

 

 
Caution: 
Always obey Electrostatic Discharge (ESD) precautions when working with 
electronics and electronic components. 

 

    
 

 

 

Note 
If a procedure instructs you to remove any covers or panels, do not install the covers 
until all required procedures are completed. 

 

   
 

Only Hologic-authorized, trained Service Engineers can service this system. The system 
is designed for module-level repair. 
 
 

 
 

Chapter 7 
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7.2 Major Serviceable Components of Generator (Illustrated) 
The following figure illustrates the major serviceable components of the Generator. 

 
Figure 134: Major serviceable components of Generator 

 Figure Legend 

1. High Voltage Multiplier 
Assembly 

2. Inverter Drawer 

3. Power Distribution Drawer 
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7.3 Covers Removal 
To access components in the Generator, several covers must be removed. See the 
following topics, which illustrate the removal of the covers and panels. 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

 

7.3.1 Remove Generator Top Cover 
1. Remove the two screws that are located above the Generator circuit breaker switch, 

at the upper left corner of the front cover. (See the following figure.) 
2. Remove the top cover by lifting it up and separating it from the four ball stud 

fasteners that secure it to the top plate. 

 
Figure 135: Removal/replacement of top cover of Generator 
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7.3.2 Remove Generator Top Plate Under Top Cover 
1. Remove the top cover (refer to Remove Generator Top Cover on page 169). 
2. Loosen (but do not remove) the four screws that secure the top plate to the Generator 

frame. (See the following figure.) 
3. Remove the top plate by grabbing its handles and lifting it up from the frame. 

 
Figure 136: Removal of top plate under top cover of Generator 
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7.3.3 Remove Generator Front Cover 
 

 

 

Note 
The Generator top cover must be removed before removing the front cover. 

 

1. Remove the Generator top cover (refer to Remove Generator Top Cover on page 169). 
2. There are no fasteners to loosen on the front cover. Simply grasp the front cover from 

the bottom (see the arrows in the following figure) and pull out. 
3. When reinstalling, slide the cover up and into place. 

 
Figure 137: Removal of front cover of Generator 
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7.3.4 Remove Generator Rear Cover 
1. Remove the five screws that secure the rear cover to the Generator frame. (See the 

following figure.) 
2. Remove the rear cover from the Generator. 

 
Figure 138: Removal of rear cover of Generator 
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7.4 Component Replacement Procedures 

7.4.1 Replace Inverter Drawer 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    
 
 

Removal 

1. Power OFF the system and power OFF at the facility disconnect box.  
2. Ensure that the Generator circuit breaker is in the OFF position. 
3. Remove the top cover (refer to Remove Generator Top Cover on page 169), front cover 

(refer to Remove Generator Front Cover on page 171), and top plate (refer to Remove 
Generator Top Plate Under Top Cover on page 170). 

4. Disconnect all cable connections to the Inverter Drawer. Make note of each 
connection and its location. 

5. Remove the four screws that secure the Inverter Drawer into place. (See the following 
figure.) 

6. Slide the Inverter Drawer out from its location in the Generator. 
 

 
Figure 139: Removal/replacement of Inverter Drawer of Generator 
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Replacement 

1. Install the new Inverter Drawer by sliding it into place. (See the previous figure.) 
2. Secure the drawer with the four screws. 
3. Restore all cable connections to the new Inverter Drawer. 
4. Reinstall the previously removed covers to the Generator. 
5. Power ON at the facility disconnect box and power ON the system. 
6. Verify proper operation of the system. 
 

 

7.4.2 Replace High Voltage Multiplier Assembly 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    
 

Removal 

1. Power OFF the system and power OFF at the facility disconnect box.   
2. Ensure that the Generator circuit breaker is in the OFF position. 
3. Remove the top cover (refer to Remove Generator Top Cover on page 169), front cover 

(refer to Remove Generator Front Cover on page 171), and top plate (refer to Remove 
Generator Top Plate Under Top Cover on page 170). 

4. Disconnect all cable connections to the High Voltage Multiplier Assembly. (Make 
note of each connection and its location.) 
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5. Remove the four screws that secure the rear panel of the Multiplier Assembly to its 
mounting bracket. (See the following figure.) 

6. Remove the ground wire that is attached to one of the four screws removed in the 
previous step. (Not shown.) 

7. Remove the two screws that secure the Multiplier Assembly to its mounting strip. 
(See the following figure.) 

8. Remove the Multiplier Assembly by lifting it up and out from its location in the 
Generator. 

 

 
Figure 140: Removal/replacement of High Voltage Multiplier Assembly 
 

Replacement 

1. Install the new Multiplier Assembly by lowering it into place. (See the previous 
figure.) 

2. Secure the rear panel of the multiplier to its mounting bracket (four screws). 
Reconnect the ground wire to one of the four screws. 

3. Secure the top of the multiplier to its mounting strip (two screws). 
4. Reinstall the previously removed covers to the Generator. 
5. Power ON at the facility disconnect box and power ON the system. 
6. Verify proper operation of the system. 
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7.4.3 Replace Power Distribution Drawer 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    
 
 

Removal 

1. Power OFF the system and power OFF at the facility disconnect box.  
2. Ensure that the Generator circuit breaker is in the OFF position. 
3. Remove the top cover (refer to Remove Generator Top Cover on page 169), front cover 

(refer to Remove Generator Front Cover on page 171), and top plate (refer to Remove 
Generator Top Plate Under Top Cover on page 170). 

4. Disconnect all cable connections to the Distribution Drawer. Make note of each 
connection and its location. 
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5. Remove the four screws that secure the Distribution Drawer into place. (See the 
following figure.) 

6. Slide the Distribution Drawer out from its location in the Generator. 
 

 
Figure 141: Removal/replacement of Power Distribution Drawer of Generator 
 

Replacement 

1. Install the new Distribution Drawer by sliding it into place. (See the previous figure.) 
2. Secure the drawer with the four screws. 
3. Restore all cable connections to the new Distribution Drawer. 
4. Reinstall the previously removed covers to the Generator. 
5. Power ON at the facility disconnect box and power ON the system. 
6. Verify proper operation of the system. 
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8: System Maintenance - Gantry/Patient Platform 
Assembly/C-arm 

8.1 Introduction 
This chapter describes maintenance information and instructions for the Gantry/Patient 
Platform/C-arm, including: 

• Component identification 
• Covers removal 
• Component replacement procedures 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   
 

 

 
Caution: 
Always obey Electrostatic Discharge (ESD) precautions when working with 
electronics and electronic components. 

 

   
 

 

 

Note 
If a procedure instructs you to remove any covers or panels, do not install the covers 
until all required procedures are completed. 

 

   
 

Only Hologic-authorized, trained Service Engineers can service this system. The system 
is designed for module-level repair. 

 

Chapter 8 
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8.2 Major Serviceable Components (Illustrated) 
 

 
Figure 142: Major serviceable components of C-arm 

 
 
 

Figure Legend 

1. Filter Wheel Assembly 

2. Biopsy Arm Motor Drive Board 

3. Compression Arm Control Board 

4. Magnetic Rotary Encoder Board Assemblies 

5. Image Detector 

6. Stage Arm Control Board 
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Figure 143: Major serviceable components of Gantry 

 
 

Figure Legend 

1. VTA Control Board 
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8.3 Covers Removal - Gantry Section 
To access components in the Gantry/Patient Platform, one or more covers must be 
removed. See the following figures, which illustrate the removal of the covers and panels. 
The top cover must be removed before the rear cover, and the rear cover before the inside 
metal plate. 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Removal of Top Cover 

1. Pull up on the patient padding (held on by hook and loop fasteners) and remove the 
top cover. (See the following figure, item 1.) 

2. Unfasten the four screws and remove the top cover. (See the following figure, item 2.) 
 

 
Figure 144: Removal of Gantry top covers 
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Removal of Rear Cover/Inside Metal Plate 

1. Remove the top cover. (Refer to the previous procedure.) 
2. Unfasten the four screws on top and three screws on each side to remove the rear 

cover. (See the following figure, item 1.) 
3. Unfasten the three screws on each side to remove the metal plate behind the rear 

cover. (See the following figure, item 2.) 
 

 
Figure 145: Removal of Gantry rear cover and inside metal plates 
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8.4 Covers Removal - C-Arm Section 
To access components in the C-arm, one or more covers must be removed. See the 
following figures, which illustrate the removal of the covers and panels. 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

 
 

8.4.1 Remove Top Cover of Tube Arm Mechanism 
1. Rotate the Biopsy Arm so that it is perpendicular to the Tube Arm Mechanism. (See 

the following figure, item 1.) 
2. Remove the eight screws that secure the top cover from under the Tube Arm 

Mechanism. 
3. Remove the top cover from the Tube Arm Mechanism. (See the following figure, item 

2.) 

 
Figure 146: Removal of top cover of Tube Arm Mechanism 
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8.4.2 Remove Rear Cover of Tubehead 
1. Remove the two screws from the bottom of the Tubehead. 
2. Pull the rear cover down and away to remove it from the Tubehead. (See the 

following figure.) 
 

 
Figure 147: Removal of rear cover of Tubehead 
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8.4.3 Remove Front Cover of Tubehead 
1. Remove the rear cover of the Tubehead. (Refer to Remove Rear Cover of Tubehead on 

page 185.) 
2. Rotate the Biopsy Arm so it is perpendicular to the Tube Arm Mechanism. (See the 

following figure, item 1.) 
3. Shutdown power to the system. 
 

 

 
Caution: 
System power must be OFF before disconnecting the harnesses to the LED boards 
(for the task lights on either side) inside the front tubehead cover. Otherwise, 
damage to the tubehead control board that the LED boards plug into may occur. 

 

 

4. Disconnect the harnesses to the LED boards and side switches mounted to the front 
cover. 

5. Remove the four screws that secure the front cover from the rear of the Tubehead. 
6. Remove the front cover from the Tubehead. (See the following figure, item 2.) 

 

 
Figure 148: Removal of front cover of Tubehead 
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8.4.4 Remove Detector-end Cover of Tube Arm Mechanism 
1. Remove the two screws under the Tube Arm Mechanism that secure the Detector-

end cover. (See the following figure.) 
2. Remove the Detector-end cover by pulling it out to the side (not down). (See the 

following figure.) 
 

 

Note 
As you begin to remove the Detector-end cover, if you feel some resistance from the 
snap fasteners, continue to remove the cover. 

 

   

 
Figure 149: Removal of Detector-end cover of Tube Arm Mechanism 
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8.4.5 Remove Detector-end Cover of Compression Arm 
1. Remove the four screws on the bottom of the Detector-end cover of the Compression 

Arm. (Two screws are held captive, as indicated with arrows in the following figure, 
at left, two are spring-loaded.) 

2. Partially pull off the cover, disconnect the fan control harness connector, and then 
finish removing the cover. 

 
Figure 150: Removal of Detector-end cover of Compression Arm 
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8.4.6 Remove Front-end Cover of Compression Arm 
1. Rotate the Biopsy Arm so it is perpendicular to the C-arm. (See the following figure, 

item 1.) 
2. Remove the two screws under the rear-end (knobs-end) of the Compression Arm 

that secure the rear-end cover. (See the following figure, item 2.) 
3. Remove the rear-end cover of the Compression Arm. 

 
Figure 151: Removal of rear-end cover of Compression Arm 
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8.4.7 Remove Displays/Covers of Biopsy Control Module 
1. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
2. Remove the two screws from under the display cover of the Biopsy Control Module. 
3. Disconnect the cables at the back of the display. 
4. Remove the display cover. 
5. Repeat the previous steps for the other side, if necessary. (See the following figure.) 

 
Figure 152: Removal of displays/covers of Biopsy Control Module 
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8.4.8 Remove Top Cover of Biopsy Arm 
1. Remove the two displays and their covers from the Biopsy Control Module. (Refer to 

Remove Displays/Covers of Biopsy Control Module on page 190.) 
2. Remove the front-end cover of the Biopsy Control Module. (Refer to Remove Front-

end Cover of Biopsy Control Module on page 192.) 
3. Loosen the four screws under the Biopsy Arm that secure the top cover. This action 

frees the top cover for removal. (See the following figure.) 
4. Remove the top cover of the Biopsy Arm by lifting it up slightly, then sideways, 

away from the Biopsy Arm. (See the following figure.) 
 

 
Figure 153: Removal of top cover of Biopsy Arm 
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8.4.9 Remove Front-end Cover of Biopsy Control Module 
1. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
2. Remove the two screws under the front end of the Biopsy Control Module that 

secure the front-end cover. 
3. Remove the front-end cover. (See the following figure.) 

 
Figure 154: Removal of front-end cover of Biopsy Control Module 
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8.4.10 Remove Rear-end Cover of Biopsy Control Module 
1. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
2. Remove the four screws (two under the Biopsy Arm, one from the side, and one from 

the top). (See the following figure.) 
3. Remove the rear-end cover of the Biopsy Control Module. (See the following figure.) 
 

 
Figure 155: Removal of rear-end cover of Biopsy Control Module 
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8.4.11 Remove Bottom Cover of Biopsy Control Module Display 
1. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
2. Remove the four screws under the Biopsy Control Module that secure the bottom 

cover. 
3. Remove the bottom cover of the Biopsy Control Module. (See the following figure.) 

 
Figure 156: Removal of bottom cover of Biopsy Control Module 
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8.4.12 Remove Bottom Plate of Support Arm 
1. Disconnect the Control Handle cable that is plugged into the external underside of 

the bottom plate of the Support Arm. 
2. Remove the (sixteen) screws from the bottom plate. (See the following figure.) 

 

 

Note 
As you remove the 16 screws from the bottom plate, move the Control Handle as 
needed in order to obtain sufficient room to remove each screw. 

 

   

3. Remove the bottom plate from the Support Arm. 

 
Figure 157: Removal of bottom plate of Support Arm 
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8.5 Component Replacement Procedures 

8.5.1 Replace the Filter Wheel Assembly 
 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Removal 

1. Power OFF the system. 
2. Rotate the Biopsy Arm so that it is perpendicular to the C-arm. 
3. Remove the rear cover of the Tubehead. (Refer to Remove Rear Cover of Tubehead on 

page 185.) 
4. Remove the Tubehead front cover. (Refer to Remove Front Cover of Tubehead on page 

186.) 
5. Locate the Filter Wheel Assembly (see the following figure) and disconnect all 

assembly harnesses. Note the type and location of each connection. 
6. Remove the four screws that secure the Filter Wheel Assembly (including mounting 

bracket) to the Tubehead. (See the following figure.) 
7. Remove the Filter Wheel Assembly. 

 
Figure 158: Removal/replacement of Filter Wheel Assembly 
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Replacement 

1. Install the replacement Filter Wheel Assembly to the Tubehead, using the four 
screws. (See the previous figure.) 

2. Reconnect the assembly harnesses. 
3. Reinstall the front cover of the Tubehead. 
4. Reinstall the rear cover of the Tubehead. 
5. Rotate the Biopsy Arm so it is parallel with the C-arm. 
6. Power ON the system and verify proper operation. 
 

 

8.5.2 Replace Biopsy (Stage) Arm Motor Drive Board 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Removal 

1. Power OFF the system.  
2. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
3. Remove the rear cover of the Biopsy Control Module. (Refer to Remove Rear-end Cover 

of Biopsy Control Module on page 193.) 
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4. Locate the Biopsy Arm Motor Drive Board and disconnect all harnesses/cables. (See 
the following figure.) 

5. Unfasten the screws that secure the board to the Biopsy Arm assembly and remove 
the board. (See the following figure.) 

 
Figure 159: Removal/replacement of Biopsy Arm Motor Drive Board 

 

Replacement 

1. Secure the new motor drive board to the Biopsy Arm assembly. 
2. Reconnect all harnesses/cables. 
3. Reinstall the rear cover to the Biopsy Control Module. 
4. (Optional) Rotate the Biopsy Control Module so it is parallel with the C-arm. 
5. Power ON the system and verify proper operation. 
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8.5.3 Replace Compression Arm Control Board 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Removal 
1. Power OFF the system. 
2. Remove the covers and components necessary to gain access to the Compression 

Arm Control Board. 

a. Remove the Detector-end cover of the Tube Arm Mechanism. (Refer to Remove 
Detector-end Cover of Tube Arm Mechanism on page 187.) 

b. Remove the Detector-end cover of the Compression Arm. Refer to (Remove 
Detector-end Cover of Compression Arm on page 188.) 

c. Remove the Image Detector. (Refer to Replace Image Detector on page 207.) 

d. Remove the cover at the rear-end of the Breast Platform of the Compression Arm 
by removing the two screws underneath. (See the following figure.) 

 
Figure 160: Removal of rear-end cover and knobs of Compression Arm 

 

e. Remove the two rotation release knobs from the Compression Arm platform by 
fully removing—not merely loosening—the two set screws for each knob. (See 
the previous figure.) 

f. Move the Paddle Mount as far as possible toward end-of-travel at the rear-end of 
the Breast Platform of the Compression Arm. (See the previous figure.) 
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g. Remove the six screws that secure the carbon fiber Breast Platform of the 
Compression Arm. (See the following figure, items 1, 2, and 3.) 

• Two screws at the bottom corners of the Detector-end of the breast platform 
(item 1). 

• Two screws in the central internal area (item 2). 
• Two screws under the rear-end (item 3). 

 
Figure 161: Removal of screws for Breast Platform of Compression Arm 

 

h. Remove the entire carbon fiber Breast Platform of the Compression Arm—from 
Detector-end to rear-end—by pulling it out in the direction of the Detector-end. 
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3. Locate the Compression Arm Control Board (see the following figure) and 
disconnect all harnesses/cables. 

4. Remove the Compression Arm Control Board (four screws). (See the following 
figure.) 

 
Figure 162: Removal/replacement of Compression Arm Control Board 

 

Replacement 

1. Install the new Compression Arm Control Board. (See the previous figure.) 
2. Reconnect all harnesses/cables to/from the new board. 
3. Reinstall the covers and components previously removed. 
4. Power ON the system and verify proper operation. 
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8.5.4 Replace the Magnetic Rotary Encoder Assembly 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

Refer to items 1, 2, and 3 in the following figure for a general view of where the three 
Magnetic Rotary Encoder Board assemblies are located. For each of the three encoder 
board assemblies, remove the appropriate covers or components in order to gain access 
to its location. 

 
Figure 163: Locations of Magnetic Rotary Encoder Board Assemblies 

Figure Legend 

1. Inside Biopsy Arm 

2. Inside Tube Arm 
Mechanism 

3. Inside Support Arm 

 
 

Removal 

1. Power OFF the system. 
2. Perform one of the following subset of steps that pertain to the encoder board 

assembly you are removing/replacing. 
 

 

Tip 
When removing the encoder board assembly, separate the assembly from any gear/belt 
by simply loosening the two screws of the encoder assembly bracket. This action 
provides you with sufficient slack to lift away the belt and remove/replace the encoder 
board assembly. 
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Removal of Encoder Board  
Inside Biopsy Arm 

a. Remove the top cover of the 
Biopsy Arm. (Refer to  Remove 
Top Cover of Biopsy Arm on 
page 191.) 

b. Remove the entire encoder 
assembly (magnet, board, and 
bracket) by removing the two 
screws that secure the bracket 
to the frame. (See the adjacent 
figure.) 

c. Remove the two screws that 
secure the encoder board 
assembly to the encoder. 

d. Disconnect all connections 
to/from the encoder board 
assembly. 

e. Remove the encoder board 
assembly. (See the adjacent 
figure.) 

 
Figure 164: Magnetic Rotary Encoder Board 
Assembly inside Biopsy Arm 
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Removal of Encoder Board  
Inside Tube Arm Mechanism 

a. Remove the Detector-end 
cover of the Tube Arm 
Mechanism (two screws). 
(Refer to Remove Detector-end 
Cover of Tube Arm Mechanism 
on page 187.) 

b. Remove the entire encoder 
assembly (magnet, board, and 
bracket) by removing the two 
screws that secure the bracket 
to the frame. (See the adjacent 
figure.) 

c. Remove the two screws that 
secure the encoder board 
assembly to the encoder. (See 
the adjacent figure.) 

d. Disconnect all connections 
to/from the encoder board 
assembly. 

e. Remove the encoder board 
assembly. 

 
Figure 165: Magnetic Rotary Encoder Board Assembly inside 
Tube Arm Assembly 

 
 

Removal of Encoder Board  
Inside Support Arm 

a. Remove the bottom plate from 
the Support Arm. (Refer to  
Remove Bottom Plate of Support 
Arm on page 195.) 

b. Remove the two screws that 
secure the encoder board 
assembly to the encoder. (See 
the adjacent figure.) 

c. Disconnect all connections 
to/from the encoder board 
assembly. 

d. Remove the encoder board 
assembly. 

 
Figure 166: Magnetic Rotary Encoder Board Assembly inside 
Support Arm 
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Replacement 

1. Install the new Magnetic Rotary Encoder Board assembly to the encoder. (See the 
previous figures in this section.) 

2. Restore all connections to/from the encoder board and related components. 
3. Reinstall the previously removed cover or plate. 
4. Power ON the system and verify proper operation. 
 

 

8.5.5 Replace Biopsy (Stage) Arm Control Board 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 
 

1. Using the control handle, pull the C-arm away from the Gantry/patient platform as 
much as possible. 

2. Rotate the Biopsy Arm so it is perpendicular to the C-arm. 
3. Power OFF the system. 
4. Unfasten the four screws for the bottom cover under the Biopsy Control Module and 

remove the cover. 

 
Figure 167: Removal of bottom cover of Biopsy Control Module 
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5. Locate the Stage Arm Control Board (see the following figure) and disconnect all 
harnesses/cables. 

6. Unfasten the four screws that secure the Stage Arm Control Board and remove the 
board. 

 
Figure 168: Removal/replacement of Stage Arm Board 

 

7. Secure the new Stage Arm Board (four screws). 
8. Reconnect all harnesses/cables. 
9. Reinstall the bottom cover of the Biopsy Control Module. 
10. Power ON the system. 
11. Rotate the Biopsy Control Module and verify proper arm detent positions. 
12. Perform the QAS test from the Admin menu (refer to The QAS Test on page 161). 
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8.5.6 Replace Image Detector 
  

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Quick Checklist When Replacing the Image Detector 

 A. Check for custom changes to image processing parameters (refer to A. Check for 
Custom Changes in Image Processing Parameters on page 208). 

 B. Power down system (refer to How to Remove All Power from the System on page 
82). 

 C. Remove Image Receptor (refer to C. Remove the Image Detector on page 208). 

 D. Install new Image Receptor (refer to D. Install the New Image Detector on page 
213). 

 E. Power up system (refer to How to Start the System on page 79). 

 F. Copy detector files from CD to %M35_DET_DIR% (refer to F. Copy Detector 
Files from CD to M35_DET_DIR on page 214). 

 G. Determine and Load the Proper Detector Software (refer to G. Determine and 
Load the Proper Detector Software on page 215). 

 H. Verify correct detector versions and ROS have been loaded (refer to H. Verify 
Correct Detector and ROS Versions Have Been Loaded on page 216). 

 I. In CalTool, perform the Detector tasks (Dark Offset, Goaltab Generation, 
Goaltab Scale, and Tomo Biopsy Scale Factor). Follow the steps listed in each task. 
(To access CalTool, refer to Calibration Tool (CalTool) on page 138). 

 J. In CalTool, perform AEC Scaling Verification. Follow the steps listed in that 
task. 

 K. Enter custom image processing parameters (if needed). Refer to K. Enter 
Custom Image Processing Parameters (If Needed) on page 218. 

 L. Perform a system Gain Calibration (see the User Guide). 

 M. In CalTool, perform the X-ray Field Detector Alignment (refer to X-Ray Field 
Detector Alignment on page 145). 

 N. Perform Geometry calibration (refer to Geometry Calibration Procedure on page 
158). 

 O. Perform STX calibration (refer to STX Calibration on page 159). 
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A. Check for Custom Changes in Image Processing Parameters 
1. From the Acquisition Workstation, select Admin. 
2. Go to System Tools > Film and Imaging > Image Processing > 2D > Edit Parameters. 
3. Check for any custom changes (bold values) to the image processing parameters and 

record those values and its parameter name. Take a screen shot if it is easier to 
capture (see following figure). 

 
Figure 169: Custom Value (in bold) in Image Processing Parameters in System Tools 

 

4. Exit System Tools and shutdown the application. 
 

B. Power Down the System 
Refer to How to Remove All Power from the System on page 82. 

C. Remove the Image Detector 
1. Remove the Detector-end cover of the Tube Arm Mechanism (by removing two 

screws and pulling the cover out of snap fasteners). (See the following figure.) 

 
Figure 170: Removal of Detector-end cover of Tube Arm Mechanism 
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2. Remove the Detector-end cover of the Compression Arm. (See the following figure.) 

a. Remove the two middle SEMS screws and the side screws (captive and spring-
loaded) at the bottom two corners of the cover. The cover stays on after you 
remove the screws, but use caution. 

b. Partially pull off the cover. 

c. Before you fully remove the cover, move it out of position and disconnect the fan 
control harness connector. The connector is at the center edge of the joined pinch 
guards. 

d. Remove the fan control harness connector from the joined pinch guards. 

e. Remove the p-clip that is attached to one of the joined pinch guards. (Do not 
remove the other p-clip, which is fastened to the Compression Arm.) 

f. Finish removing the cover. (Refer to the following note.) 
 

 

Note 
The top and side edges of the Detector-end cover fit (without screws) into the Detector- 
end of the Compression Arm Breast Platform. After you remove the screws in the 
previous step, angle the bottom of the cover and pull it off. You may feel some 
resistance along the perimeter of the cover as you remove it. 

 
 

 
Figure 171: Detector-end cover of Compression Arm 
(left), Image Detector (upper right) 
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3. Remove the two joined pinch guards by removing the seven screws. (There are two 
screws at each end plus three in the middle.) Then slide out each of the two 
separated pinch guards. (See the following figure.) 

  
Figure 172: Removal of pinch guard from Image Detector 
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4. Disconnect the two cable connectors (electrical and fiber optic) from the Detector (see 
the following figure:  

a. Unfasten the detector interface board (one screw) with ribbon cable (item 1) 
under the detector mounting platform and let it hang safely out of the way. 

b. Unclip the detector fiber optic cable (item 2) and let it hang safely out of the way 
under the mounting platform. 

 
Figure 173: Disconnecting detector cables to detector 
(detector not shown for better clarity) 
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5. Lower the Detector mounting platform to obtain sufficient clearance at the top of the 
Detector to slide it out horizontally from under the Compression Arm platform: 

a. Loosen the set screw on the left side of the bracket that houses the height adjust 
screw for the Detector mounting platform. (Loosen the set screw about one to 
two turns.) (See the following figure. The height adjust screw is in the center of 
the illustration and is indicated with an arrow.) 

b. Lower the two U-brackets (under the Detector mounting platform) by loosening 
four screws (two in left bracket, two in right) until the brackets are at end-of-
travel. Then tighten the screws to secure the hard stops. (See following figure.) 

c. Loosen the four screws under the Detector mounting platform, as indicated with 
four arrows in the following figure. (Loosen about one to two turns.)  

d. Loosen the fifth screw (indicated in the center of the following figure with an 
arrow) until the mounting platform height begins to lower. This screw is the 
height adjust screw for the Detector mounting platform. Loosening this screw 
frees the platform for vertical movement. 

e. Continue to lower the mounting platform until there is sufficient clearance at the 
top of the Detector. 

 

 
Figure 174: Loosen these screws to lower Detector mounting platform for removal 
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6. Remove the two screws that secure the Detector to its mounting platform. (See the 
following figure.) 

7. Remove the Detector by pulling it horizontally out of its location. (See the following 
figure.) 

 

 
Figure 175: Removal of Detector from its platform 
 

 

D. Install the New Image Detector 
1. Install the new Detector on its platform and secure with its screws. 
2. Reconnect the electrical and fiber optic connectors. 
3. Raise the Detector mounting platform to its original height (see the figure Adjusting 

Detector Mounting Platform on page 212 for the mounting screw locations). 
4. Reinstall the pinch guard by rejoining both halves with the seven screws and 

securing to the underside of the Detector. 
5. Reinstall the p-clip and pinch screws previously removed from the joined pinch 

guard. 
6. Reconnect the fan wire harness connector. 
7. Reinstall the Detector-end cover of the Detector by sliding and fitting its top and side 

edges into the Detector-end of the carbon fiber Breast Platform. 
8. Reinstall the Detector-end cover of the Tube Arm Mechanism. 
 

E. Power Up the System 
Refer to How to Start the System on page 79. 



Affirm Prone Biopsy System Service Manual 
Chapter 8: System Maintenance - Gantry/Patient Platform Assembly/C-arm 
 

 
Page 214 MAN-04482 Revision 006 
 

F. Copy Detector Files from CD to M35_DET_DIR 
1. Verify that the serial number on the CD supplied with the detector matches the serial 

number of the detector. 
2. Copy the Image Receptor files from the CD. 

a. From any Applications screen, press the Windows key. 

 
Figure 176: Windows Key on Keyboard 

 

b. Type %M35_DET_DIR% into the command box and press Enter. 

 
Figure 177: Accessing M35 Detector Directory 

 

c. If the command is typed correctly, the M35 Folder appears. 

 
Figure 178: M35 Folder 

 

d. Copy the six detector files from the Image Receptor CD to the M35 folder. 
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G. Determine and Load the Proper Detector Software 
1. Exit and close the application by selecting LOGOUT and holding down the CTRL 

key and clicking through the SHUTDOWN, then EXIT buttons. 
2. Navigate to the CalTools.bat file and launch CalTool. 
3. Select Upload Code under the Diagnostics section on the left side of the CalTool 

window. 
4. Select the Execute Procedure tab. 
5. Select Auto Select in the Node to update selection box. 
6. Select Next Step. 
7. If Auto Select succeeds, proceed to Step 8 to load the readout sequence. 

If Auto Select fails, the node software must be loaded manually by following the 
substeps. The following software needs to be loaded: 

• loader-mfd_DESIRED VERSION.package 
• mfd_DESIRED VERSION.package 
• mfd-mac-fpga-fDESIRED VERSION-hpDESIRED VERSION.package 

a. Select DET in the Node to update selection box. Refer to the software list in 
previous three bullets. 

b. Browse to the first software file on the list corresponding to the detector family 
and select Open to upload the file. 

c. Select Next to continue the procedure. The download begins automatically. Be 
patient, as the download and detector configuration may take some time, 
depending on the package. It is normal for the detector to reboot after 
completion of the operation. 

d. When the download has completed successfully, the bottom right message 
window displays something similar to the following: 

Status:Success(0x00) 
If the output contains the word "fail", repeat the download process. To repeat the 
download, click the Next button until you are at the DET node selection, then 
repeat the steps b - d. 
Sometimes the detector may not come back on. Wait some time and then cycle 
the Gantry power off and back on. 

e. Select Next again.  

f. At the prompt Do you wish to perform another software upgrade?, click Yes. 

g. Repeat Steps a – f for the remaining software package files.  
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8. Load the readout sequence. The readout sequence is not loaded as a part of Auto 
Select and must be loaded separately. 

a. Select DET in the Node to update selection box. The following readout sequence 
needs to be loaded: 

• MFD_DESIRED VERSION.ros.package 

b. Browse to the desired readout sequence package and select Open to download 
the file. 

c. Select Next to continue the procedure. The download begins automatically. 

d. When the download has completed successfully, the bottom right message 
window displays something similar to the following: 

END NODE DOWNLOAD 
Status:Success(0x00) 
If the output contains the word "fail", repeat the download process. To repeat the 
download, click the Next button until you are at the DET node selection, then 
repeat the steps b - d. 

 

H. Verify Correct Detector and ROS Versions Have Been Loaded 
1. While still in CalTool in the Upload Code, Execute Procedure tab, click Advanced 

Form. 
2. Check the Nodes window and verify versions. 

 
Figure 179: Verifying Versions in Nodes Window 
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3. Click the DET tab (item 1 in following figure); then click the Settings tab (item 2). 
4. Verify the proper versions in the fields called out in items 3 and 4 in the following 

figure. 

 
Figure 180: Verifying Versions in Settings Tab 

 

5. Allow the detector time to stabilize. 
 

I. Perform Detector Tasks using CalTool  
In CalTool, under the Detector group in the Task Bar, perform the tasks of Dark Offset, 
Goaltab Generation, Goaltab Scale, and Tomo Biopsy Scale Factor in that order. Follow 
the steps listed for each task. To access CalTool, refer to Calibration Tool (CalTool) on page 
138. 

J. Perform AEC Scaling Verification using CalTool  
In CalTool, under the Verification group in the Task Bar, perform AEC Scaling 
Verification. Follow the steps listed in the task. To access CalTool, refer to Calibration Tool 
(CalTool) on page 138. 



Affirm Prone Biopsy System Service Manual 
Chapter 8: System Maintenance - Gantry/Patient Platform Assembly/C-arm 
 

 
Page 218 MAN-04482 Revision 006 
 

K. Enter Custom Image Processing Parameters (If Needed) 
1. Exit CalTool. 
2. Start the application and log in as Service. 
3. If custom image processing parameters were found in step A. Check for Custom 

Changes in Image Processing Parameters, go to System Tools > Film and Imaging > 
Image Processing > 2D > Edit Parameters. 

4. Modify as needed to replace the default values with the custom values previously 
recorded. 

L. Perform System Gain Calibration 
Refer to the User Guide. 

M. Perform X-Ray Field Detector Alignment using CalTool 
Refer to X-Ray Field Detector Alignment on page 145. 

N. Perform Geometry Calibration 
Refer to Geometry Calibration Procedure on page 158. 

O. Perform STX Calibration 
Refer to STX Calibration on page 159. 
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8.5.7 Replace the VTA Control Board 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
    

Removal 

1. Power OFF the system. 
2. Remove the rear cover and rear inside cover from the Gantry assembly. Refer to 

Covers Removal - Gantry Section on page 182. 
3. Locate the VTA Control Board (See the following figure.) 
4. Disconnect all cable connections to/from the board. Note the type and location of 

each connection. 
5. Remove the VTA Control Board (four screws).  

 
Figure 181: Removal/replacement of VTA Control Board of Gantry 

 

Replacement 

1. Install the new VTA Control Board (four screws). (See the previous figure.) 
2. Restore all cable connections to the new board. 
3. Reinstall the rear cover and inside metal plate to the Gantry. 
4. Power ON the system and verify proper operation. 
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8.6 Maintenance Procedures 

8.6.1 Replace Detector Fan Filter 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
 

Removal 

1. Power OFF the system. 
2. Remove the Detector-end cover of the Tube Arm Mechanism (by removing two 

screws and pulling the cover out of snap fasteners). (See the following figure.) 

 
Figure 182: Removal of Detector-end cover of Tube Arm Mechanism 
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3. Remove the Detector-end cover of the Compression Arm. (See the following figure.) 

a. Remove the two middle SEMS screws and the side screws (captive and spring-
loaded) at the bottom two corners of the cover. The cover stays on after you 
remove the screws, but use caution. 

b. Partially pull off the cover. 

c. Before you fully remove the cover, move it out of position and disconnect the fan 
control harness connector. The connector is at the center edge of the joined pinch 
guards. 

d. Remove the fan control harness connector from the joined pinch guards. 

e. Remove the p-clip that is attached to one of the joined pinch guards. (Do not 
remove the other p-clip, which is fastened to the Compression Arm.) 

f. Finish removing the cover. (Refer to the following note.) 
 

 

Note 
The top and side edges of the Detector-end cover fit (without screws) into the Detector- 
end of the Compression Arm Breast Platform. After you remove the screws in the 
previous step, angle the bottom of the cover and pull it off. You may feel some 
resistance along the perimeter of the cover as you remove it. 

 
 

 
Figure 183: Detector-end cover of Compression Arm 
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4. Locate the two wedge-shaped filter stoppers (see item 1 in the following figure). 
Unfasten and remove the stoppers (one screw each).  

5. Pull down and out the old filters (item 2, ASY-09689). 

 
Figure 184: Replacing Detector fan filters 

 

Replacement 

1. Install the new fan filters by sliding each up at an angle into the filter receptacle (see 
the previous figure.) 

2. Refasten the two wedge-shaped filter stoppers (one screw each side). 
3. Reinstall the Detector-end cover. 
4. Reinstall the Detector-end cover of Tube Arm Mechanism. 
5. Power ON the system and verify proper operation. 

 



Affirm Prone Biopsy System Service Manual 
Chapter 9: System Maintenance - Acquisition Workstation 

 
 
 
 

 
MAN-04482 Revision 006 Page 223 
 

9: System Maintenance - Acquisition 
Workstation 

9.1 Introduction 
This chapter describes maintenance information and instructions for the Acquisition 
Workstation, including: 

• Component identification 
• Component replacement procedures 
 

 

 
WARNING! 
Verify that the system is disconnected from the AC line before 
performing any removal or replacement procedures. 

 

   
   

 

 
Warning: 
Always follow the safety precautions for x-ray exposures. 

 

   
 

 
Caution: 
Always obey Electrostatic Discharge (ESD) precautions when working with 
electronics and electronic components. 

 

   
 

 

Note 

If a procedure instructs you to remove any covers or panels, do not install the covers 
until all required procedures are completed. 

 

   

Only Hologic-authorized, trained Service Engineers can service this system. The system 
is designed for module-level repair. 

 
 

Chapter 9 
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9.2 Major Serviceable Components (Illustrated) 
 

 

Figure Legend 

1. Control display monitor 

2. Image display monitor 

3. Power supply for image 
display monitor 

4. Computer 

Figure 185: Major serviceable components of Acquisition Workstation 
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9.3 Component Replacement Procedures 

9.3.1 Replace Control Monitor 
Removal 

1. Power OFF the Acquisition Workstation system. 
2. Disconnect the power cable and video cable from the rear of the control display 

monitor. 
3. Remove the control display monitor from its mounting bracket (four screws). 
 

Replacement 

1. Install the new monitor onto the monitor bracket (four screws). 
2. Connect the video cable and power cable to the new monitor. 
3. Power ON the Acquisition Workstation system. 
4. Verify proper operation of the monitor. 
 

 

9.3.2 Replace Image Display Monitor 
Removal 

1. Power OFF the Acquisition Workstation system. 
2. Remove the rear cover of the image display (Barco) monitor and disconnect the 

power cable and video cable. 
3. Remove the image display monitor from its mounting bracket (four screws). 
4. Do the following, based on the situation: 

• If you are swapping out a monitor with an exact replacement (say, a 2-megapixel 
display with a 2-megapixel display) and there is no need to change monitor 
cables, go to the following Replacement (No Cabling Involved) procedure. 

• If you are changing the monitor with a different model (say, an upgrade from 2-
megapixels to 3-megapixels display) and/or you need to replace the power 
supply/power cable/video cables as well as the monitor, go to the following 
Replacement (Cabling Involved). 

Replacement (No Cabling Involved) 

1. Install the replacement image display monitor onto the right monitor bracket (four 
screws). 

2. Remove the rear cover of the monitor and attach the 24 VDC power cable and 
display port cable. Replace the rear cover. 

3. Power ON the Acquisition Workstation system. 
4. Configure the new monitor using the on-screen menu of the monitor. (Refer to Verify 

Settings of Barco Image Display Monitor on page 60.) 
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Replacement (Cabling Involved) 

1. Remove any spiral wrap/wire ties to the 24 VDC power cable and display port cable 
above the monitor post. Pull both cables through the monitor post and out the 
bottom of the post. 

2. Remove the 24 VDC power cable and display port cable from e-chain cable housing. 
See the following figure (items 7 and 8) for the e-chain slots to remove these cables. 

 

 
Figure 186: Routing of power and display port cables in e-chain cable housing 
(top of e-chain shown) 

Figure Legend 

1. Power cord for 
workstation surface 
lift 

2. Ground cable 

3. AC power cord for 
control display 
monitor 

4. Mouse USB cable 

5. Keyboard USB cable 

6. Video cable for 
control display 
monitor 

7. Display port cable for 
(Barco) image 
monitor 

8. 24 VDC power cable 
for (Barco) image 
monitor 

 

3. Disconnect the display port cable at the computer. 
4. If you are changing the monitor power supply, do the following: 

 

  

Note 
The metal housing that holds the power supply of the image display monitor is located 
inside of the rear wall of the workstation cart. (See item 3 in the figure Major Serviceable 
Components of Acquisition Workstation on page 224.) The housing is sized to fit either the 
smaller 2-megapixel monitor power supply (plus a metal spacer) or the larger 3-
megapixel monitor power supply (without a spacer). 
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a. Disconnect the 120 VAC cable of the monitor power supply from the UPS. 

b. [If upgrading  from a 2-megapixels to 3-megapixels display] Remove the metal 
spacer that was installed with the 2-megapixel power supply. 

c. Remove the hook-and-loop fastener strip that secures the power supply within 
the housing and remove the power supply. 

d. Install the replacement power supply into the housing. 

e. Secure the power supply with hook-and-loop fastener material. 

f. Route the 120 VAC cable of the replacement power supply to the UPS and plug it 
in (see figure Connections on rear of UPS on page 56). 

5. Locate the replacement display port cable and connect one end to the computer (see 
figure Rear panel of computer on page 228). 

6. Locate the 24 VDC power cable from the monitor power supply and monitor display 
port cable from the computer and run these cables through the e-chain cable housing 
(starting from the bottom). See items 7 and 8 in figure Routing of power and display port 
cables in e-chain cable housing (top of e-chain shown) on page 226 for the proper e-chain 
slots to thread these cables through. 

7. From the top of e-chain cable housing, run the monitor power and display port 
cables through the bottom of the monitor post and out the top side opening. 

8. Apply spiral wrap or use wire ties to the two cables after they leave the monitor post 
to keep the cables together. 

9. Install the replacement image display monitor onto the right monitor bracket (four 
screws). 

10. Remove the rear cover of the monitor and attach the 24 VDC power cable and 
display port cable. Replace the rear cover. 

11. Power ON the Acquisition Workstation system. 
12. Configure the replacement monitor using the on-screen menu of the monitor. (Refer 

to Verify Settings of Barco Image Display Monitor on page 60.) 
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9.3.3 Replace Computer 
Removal 

1. Power OFF the Acquisition Workstation system. 
2. Tilt or slide the computer forward to gain easier access to its rear panel. 
3. Disconnect all cable connections to/from the rear panel. Take note of the location of 

each cable connection. (See the following figure.) 
4. Remove the computer from the workstation cart. 
 

 

Figure Legend 

1. CAN connector (for cable to Gantry) 

2. Image display monitor 

3. Computer power switch, set to ON 

4. Fiber optic connector (for cable to 
Gantry) 

5. Control display monitor 

6. USB connector for cable to/from 
Uninterruptible Power Supply (UPS) 

7. USB connector for mouse 

8. USB connector for keyboard 

9. Computer power cable that connects to 
Uninterruptible Power Supply (UPS) 

 

Figure 187: Rear panel of Acquisition Workstation computer 
 

Replacement 

1. Temporarily place the new computer near its ultimate location on the workstation 
cart. Allow yourself enough room to access the rear panel. 

2. Make all cable connections to the rear panel of the computer. (See the previous 
figure.) 
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3. Fit the computer into its intended location on the workstation cart. 
4. Power ON the Acquisition Workstation system. 
5. Verify proper operation of computer. 
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Appendix A   Specifications 
 

A.1  Product Measurements 
 

 

 
Figure 188: Gantry and Generator Dimensions 

 

   
 

Gantry/Patient Platform Dimensions 

A. Height 107 cm (42 inches) 

B. Width 229 cm (90 inches) 

C. Depth with C-arm 178 cm (70 inches) 

D. Overall Depth 198 cm (78 inches) 

 Total Weight 445 kg (980 pounds) 

Generator Dimensions 

E. Height 63 cm (25 inches) 

F. Width 87 cm (34 inches) 

G. Depth 55 cm (22 inches) 

 Weight 136 kg (300 pounds) 
 

 

Appendix A 
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Figure 189: Acquisition Workstation Dimensions 
 

Acquisition Workstation Dimensions 

A. Height 138.4 cm (54.5 inches) 

 Overall Height Range 138.4 cm (54.5 inches) to 179.1 cm (70.5 inches) 

 Height Range (floor to 
work surface) 

71.1 cm (28 inches) to 111.8 cm (44 inches) 

B. Width 85.4 cm (34 inches) 

C. Depth 75.1 cm (30 inches) 

 Total Weight 114 kg (252 pounds) 
 

 
 

 

A.2  Operation and Storage Environment 
 

A.2.1  General Conditions for Operation 
  

Temperature Range 10 °C (50 °F) to 30 °C (86 °F) 

Relative Humidity Range 10% to 80% without condensing moisture 

BTU Output less than 5700 BTU per hour 
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A.2.2  General Conditions for Transport and Storage 
  

Temperature Range 10 °C (50 °F) to 35 °C (95 °F) 

Relative Humidity Range 10 to 80%, not packaged for outdoor storage 
 

   
 

A.3  Electrical Input 
 

A.3.1  Generator/Gantry 
 

Mains Voltage 200/208/220/230/ 240 VAC ±10% 

Mains Impedance Maximum line impedance not to exceed 0.20 ohms for 
208/220/230/240 VAC, 0.16 ohms for 200 VAC 

Mains Frequency 50/60 Hz ±5% 

Average Current over 24 Hours < 5 A 

Line Current 4 A (65 A maximum for < 5 seconds)  
 

 
 

A.3.2  Acquisition Workstation 
 

Mains Voltage 100/120/200/208/220/230/240 VAC ±10% 

Mains Frequency 50/60 Hz ±5% 

Power Consumption < 1000 watts 

Duty Cycle 13.3% ~ 8 minutes per hour or 2 minutes on, 13 minutes off 

Line Current 2.5 A 
 

   
 

A.4  Gantry Technical Information 
 

A.4.1  C-arm 
  

Rotation Range 180° 

Source-to-Image Distance (SID) 80 cm 

Stereo Range ±15° 

Tomosynthesis Range ±7.5° 
 

   
 

A.4.2  Compression System 
  

Manual Compression Force 300 N (67.4 lb) maximum  

Motorized Compression Force 62.3 N (14.0 lb) minimum 

200 N (45.0 lb) maximum  
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A.4.3  Biopsy Guidance Module 
Accuracy of Biopsy Arm Controller maximum deviation: 1 mm in either 

direction of target coordinate 

Combined Accuracy of Biopsy Guidance 
Module and Biopsy Device 

maximum deviation: 2 mm in either 
direction of target coordinate 

 
 

A.4.4  X-ray Tube 
   

Focal Spot Large (0.3 mm) Nominal 

Tube Voltage 20-49 kVp in 1 kVp increments 

Anode Material Tungsten 

X-ray Window 0.63 mm Beryllium  

Reference Angle 
(angle of the reference axis to the plane of 
the image reception area) 

90° 

 

   
 

A.4.5  X-ray Beam Filtration and Output 
 

Filtration Aluminum, 0.70 mm (nominal) 

 Silver, 0.050 mm ±10% 
 

   
 

kV/mA Range 
Table 10: Maximum mA as a Function of kV 

kV LFS mA  kV LFS mA 

20 100  35 200 

21 110  36 190 

22 110  37 180 

23 120  38 180 

24 130  39 180 

25 130  40 170 

26 140  41 170 

27 150  42 160 

28 160  43 160 

29 160  44 150 

30 170  45 150 
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Table 10: Maximum mA as a Function of kV 
kV LFS mA  kV LFS mA 

31 180  46 150 

32 190  47 140 

33 200  48 140 

34 200  49 140 
 

   
 

A.4.6  X-ray Generator 
  

Type Constant potential, three-phase, high frequency inverter 

Rating 7.0 kW (large focus) maximum, mid focus 4.08 KW(120 mA 
at 34kV) 

Electrical Power Capacity 9.0 kW maximum 

kV Range 20-49 kVp in 1 kVp increments 

kV Accuracy ±5% 

mA Range 10-200 mA 

mAs Accuracy ±(10% + 0.2 mAs) 

mAs Range 3-500 mAs, 45 steps: 3.2, 3.6, 4, 4.5, 5, 5.6, 6.3, 7.1, 8, 9, 10, 
11, 12.5, 14, 16, 18, 20, 22, 25, 28, 32, 36, 40, 45, 50, 56, 63, 
71, 80, 90, 100, 110, 125, 140, 160, 180, 200, 220, 250, 280, 
320, 360, 400, 450, 500 mAs 

 

   
 

A.4.7  Image Receptor Technical Information 
  

Dimensions  

     Height 33 cm (13 inches) 

     Width 21.5 cm (8.46 inches) 

     Depth 10 cm (3.94 inches) 

     Weight 7.3 kg (16 pounds) 

Imaging Area 14 cm x 12 cm 

Effective Field of View 12.4 cm x 10.2 cm at the Breast Platform 

Image Device Direct conversion amorphous Selenium coated TFT array 

Pixel Count 2048 (H) x 1792 (V) 

Pixel Size 70 µm (H) x 70 µm (V) 

Digitizing Resolution 14 bit data 
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Detective Quantum Efficiency (DQE) Not less than 50% at 0.2 lp/mm (stereotactic mode) 
Not less than 30% at 0.2 lp/mm (tomosynthesis mode) 
Not less than 15% at 7.1 lp/mm (stereotactic and 
tomosynthesis modes) 

Modulation Transfer Function (MTF) Not less than 40% at 7.1 lp/mm 

Synchronization Interlocked with x-ray control signal 
 

   
 

A.4.8  Shielding 
 

Operator Radiation shield (customer supplied) between patient platform 
and handheld remote for x-ray activation 

Patient The patient platform provides the necessary radiation 
protection. 

 
 

A.5  Acquisition Workstation Technical Information 
 

A.5.1  Network Environment 
 

Network Interface 100/1000 BASE-T Ethernet 
 

 

A.5.2  Acquisition Workstation Cart 
   

Monitor Arm Weight Rating 11.3 kg (25 pounds) 
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Appendix B   System Messages and Alerts 
B.1  Error Recovery and Troubleshooting 

Most faults and alert messages are cleared without result to your workflow. Follow the 
instructions on the screen or fix the condition then clear the status from the Taskbar. 
Some conditions require a system restart or indicate that more action is necessary (for 
example, to call Hologic Technical Support). This appendix describes the message 
categories and your actions to return the system to normal operation. If errors repeat, 
contact Hologic Technical Support. 

B.2  Types of Messages 
 

B.2.1  Fault Levels 
Each Message has a particular set of the following characteristics: 

• Aborts an exposure in progress (yes/no) 
• Prevents an exposure from starting (yes/no) 
• Displays a message to the user on the Acquisition Workstation (yes/no) 
• May be reset by the user (yes/no) 
• May be reset automatically by the system (yes/no) 

 

Displayed Messages 
All displayed messages will be shown in the user’s selected language. 

Any message which aborts an exposure or prevents an exposure from starting will 
always display a message directing the user’s actions required to proceed. 

Additional Message Information 
Technical information about the message is available in the log file. 

Some messages always show as a critical fault (a system restart is necessary). These 
messages result from a condition which prevents an exposure, and which cannot be reset 
by the user or the system. 

B.2.2  System Messages 
When the following system messages show, do the step shown in the User Action 
column to clear the message and allow the next exposure. 

Table 11: System Messages 

Icon Message User Action 

Appendix B 
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Table 11: System Messages 

Icon Message User Action 

 

Waiting for Detector No action needed. 

 

(C-arm) Lockout Switch activated Release the C-arm handle. 

 

(System) Lockout Switch not 
activated 

Press the System Lock button on the 
control handle to lock the system. If 
necessary, unlock and relock. 

 

Biopsy STX cal required Install the gain paddle and perform Gain 
Calibration. 

 

Biopsy geometry calibration 
required 

Install the geometry paddle and perform 
Geometry Calibration. 

 

Invalid detector calibration: Repeat 
flat field calibration 

Repeat Gain Calibration. 

 

Invalid geometry calibration: 
Repeat geometry calibration 

Repeat Geometry Calibration. 

 

Invalid use of compression paddle Install the correct paddle. 

 

Configuration file is missing Call Service. 

 

An E-Stop has been pressed When safe, turn the Emergency Off 
switch one-quarter turn to reset the 
switch. 
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Table 11: System Messages 

Icon Message User Action 

 

Tube needs to be manually 
positioned (move to 0 degrees) 

Manually rotate the C-arm to 0 degrees. 

 

Tube needs to be manually 
positioned (moved to +15 degrees) 

Manually rotate the C-arm to the right. 

 

Tube needs to be manually 
positioned (moved to -15 degrees) 

Manually rotate the C-arm to the left. 

 

The needle needs to be moved to 
the correct location 

Move the needle to the correct location. 

 

The stage arm needs to be moved 
to either the lateral left or right 
position 

Move the biopsy arm to either lateral left 
or right. 

 

The stage arm needs to be moved 
to the -90 position 

Move the biopsy arm to -90 degrees 
approach. 

 

The stage arm needs to be moved 
to the +90 position 

Move the biopsy arm to +90 degrees 
approach. 

 

The stage arm needs to be moved 
to the standard approach 

Move the biopsy arm to 0 degree 
approach. 

 

The stage arm control is not locked Lock the biopsy arm. 

 

Compression too low for tomo 
reconstructions 

Move the Compression Paddle to greater 
than 0.5 cm. 
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Table 11: System Messages 

Icon Message User Action 

 

Compression is less than 4.5 cm 
during calibration 

Move the Compression Paddle to greater 
than 4.5 cm. 

 

*not licensed A license is necessary to use this feature 
or function. (Call Service to install the 
license.) 

 

   
 

B.3  UPS Messages 
 

 

 

Note 
The User Guide for the UPS is supplied with the system. Refer to the UPS User's Guide 
for complete instructions. 

 

   

The LCD Display Interface in the Uninterruptible Power Supply (UPS) shows the status 
of various utility and battery backup conditions. 

 
Figure 190: UPS LCD Display 

Figure Legend 

1. On Line Power 

2. Power-Saving Mode On 

3. Load Capacity 

4. Battery Charge Level 

5. UPS Overload 

6. Event 

7. Automatic Voltage Regulation 

8. Input/Output Voltage 

9. System Fault 

10. Mute 

11. Replace Battery 

12. On Battery Power 

 

 

If the UPS battery expires, the Replace Battery icon shows. Contact 
your service representative to replace the battery.  
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Appendix C   Field Replaceable Units 
 

C.1  Replacement Parts List 
The Parts Lists are located in the following tables, with each part listing a: 

• Part Number: The order number for the Field Replaceable Unit/part. Hologic Service 
Support requires this number when placing an order. 

• Description: The name of the Field Replaceable Unit/part 
• Refer To: The section and page number in this manual for the removal and 

replacement procedures for that Field Replaceable Unit/part. 
 

Table 12: Generator Parts List 
Part Number Description Refer To 

ASY-06980 High Voltage (HV) Multiplier 
Drawer Assembly 

Replace High Voltage Multiplier 
Assembly on page 174 

ASY-06981 Capacitor and Bridge 
Assembly 

 

ASY-07006 Inverter Drawer Assembly Replace Inverter Drawer on page 173 

ASY-08871 Fuse Kit for High Voltage 
Generator 

 

ASY-08936 Power Distribution Drawer 
Assembly 

 

PCB-00443 External User Indicator Board  

PCB-00709 Front Panel Feedback Board  

PCB-00964 Remote X-Ray Control Board  

PWR-00200 DC Power Supply (+24 VDC @ 
6.3 Amps, 150 watts, Voltage 
Input 90-264 VAC, Single 
Output) 

 

 
 

Table 13: C-Arm Parts List 

Part Number Description Refer To 

2-230-4001 Belt, Timing 32p 3/32dia 
Linear Pitch .0982, Pitch 
Length Bulk 50ft, Material 
Dacron Core 

 

ASY-04186 Y-Axis Ground Assembly Flex 
Cable 

 

Appendix C 



Affirm Prone Biopsy System Service Manual 
Appendix C: Field Replaceable Units 
 

 
Page 242 MAN-04482 Revision 006 
 

Table 13: C-Arm Parts List 

Part Number Description Refer To 

ASY-06533 Magnetic Rotary Encoder 
Assembly (3 in system) 

Replace the Magnetic Rotary Encoder 
Assembly on page 202 

ASY-07458 Carriage Brake Assembly  

ASY-07569 Filter Wheel Assembly Replace the Filter Wheel Assembly on 
page 196 

ASY-08174 Paddle, Biopsy, Axilla, 5 Cm X 
5 Cm 

 

ASY-08175 Paddle, Biopsy, Standard, 5 
Cm X 5 Cm 

 

ASY-08176 Paddle, Biopsy, Standard, 6 
Cm X 7 Cm 

 

ASY-08642 Stage Arm Smart Window, RH 
Assembly 

 

ASY-08643 Stage Arm Smart Window, LH 
Assembly 

 

ASY-08956 C-Arm Handle Optical Sensor 
Assembly 

 

ASY-08986 Detent In Optical Sensor 
Assembly 

 

ASY-08987 Detent Out Optical Sensor 
Assembly 

 

ASY-09070 Support Arm Interconnect 
Assembly 

 

ASY-09072 High Voltage Resistor, Gen II 
Assembly 

 

ASY-09170 Footswitch with Coiled Cable 
Assembly 

 

ASY-09689 Replacement Filters for Mid-
Field Detector 

 

ASY-09702 Phantom, Brake Actuator 
Motor Assembly 

 

CBL-02006 Tube Arm CAN Cable 1  

CBL-02007 Tube Arm CAN Cable 2  
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Table 13: C-Arm Parts List 

Part Number Description Refer To 

CBL-02397 High Voltage Cable-Resistor to 
Tube Assembly 

 

FAB-10785 Breast Platform, Main Cover, 
Compression Arm 

 

FAB-13473 X-Y Axis Flex Cable  

FAN-00084 Fan, 12vdc 60.4/102.6cfm 
17.7dba 1200rpm 0.20amps 
W/Wire Leads, 17.1lg 
12.7mm(4.72)X120mm(4.72)X2
5mm(1")Thk Axial 

 

MME-02432 Elt, Posidrive, 32 Pitch, 24.740 
Length, Belt Core St Stl, Body 
Polyurethane 

 

MME-02629 Belt, Timing 32p 95pins, Core 
Dia 3/23, Circular Pitch 0.0982, 
Pitch Length 9.327, St Stl 
Reinforced Polyurethane, Blue 

 

MTR-00088 Compression Motor  

OSC-00065 X-Ray Tube, Varian M-119t 
(Affirm Prone Biopsy System) 

 

PCB-00186 Paddle Position Sensor  

PCB-00918 Compression Arm Control 
Board 

Replace Compression Arm Control 
Board on page 199 

PCB-00944 C-Arm Angle Encoder Board  

PCB-00989 Tube Arm Control Board  

PCB-01005 Tubehead Control Board  

PCB-01016 Filament Protect Board  

PCB-01032 Support Arm Flex Board  

PCB-01038 Biopsy (Stage) Arm Control 
Board 

Replace Biopsy (Stage) Arm Control 
Board on page 205 

PCB-01056 Biopsy (Stage) Arm Motor 
Drive Board 

Replace Biopsy (Stage) Arm Motor 
Drive Board on page 197 

PCB-01060 Stage Y-Axis Interface Board  
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Table 13: C-Arm Parts List 

Part Number Description Refer To 

PCB-01078 Table Interconnect Board  

PCB-01081 Compression Arm Flex Board  

PCB-01099 Tube Arm Flex Board  

PCB-01101 Compression Device Flex 
Board 

 

PCB-01118 Support Arm Extension Flex 
Assembly 

 

PCB-01197 Compression Arm Power 
Board 

 

PCB-01281 Stage Arm Flex Board  

PCB-01313 Tube Arm Magnetic Encoder 
Board 

 

PRD-03756-N Mid-Field Image Detector Replace Image Detector on page 207 

SWC-00149 Motor Enable Membrane 
Switch 

 

 
 

Table 14: Gantry Parts List 
Part Number Description Refer To 

PCB-00174 Gantry Service Port Board  

PCB-00923 VTA Control Board Replace the VTA Control Board on 
page 219 

 

Table 15: Acquisition Workstation Parts List 
Part Number Description Refer To 

ASY-09162 X-Ray Handheld Remote  

ASY-09400 AWS Power Distribution  

ASY-11635 Computer (CMP-01560) With 
Software Loaded 

 

CBL-02238 Video Cable [6.6 ft Lg (2.0 
meters) DVI-A (16+1) Male To 
VGA HD 15 pins Male, PVC 
Black] 
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Table 15: Acquisition Workstation Parts List 
Part Number Description Refer To 

CMP-00811 Control Monitor (17" Flat 
Panel Color 1280 x 1024 
Viewing Area, 56-76 Hz) 

Replace Control Monitor on page 
225 

CMP-00819 Mouse (USB & PS/2 3 Button 
Optical w/Scroll Wheel, 6 ft 
cord) 

 

CMP-01560 
(formerly CMP-
01154) 

Computer Replace Computer on page 228 

CMP-01270 Image Display Monitor Replace Image Display Monitor on 
page 225 

MME-02464 Keyboard Transparent Cover  
with Keyboard 

 

MME-02465 Keyboard Transparent Cover 
(alone) 

 

PCB-01011 Video Board for Detector 
(HDT PCIE VLC PCB) 

Located in the computer 

PWR-00246 UPS (120 VAC 50/60 Hz, 420 
Watts, 6 Outlets) 

 

 
 

C.2  Interconnect Cables 
 

Table 16: Affirm Prone Biopsy System Interconnect Cables 

Part Number Description 

ASY-09040 20 Foot Interconnect Cables, Generator to Gantry 

ASY-09041 40 Foot Interconnect Cables, Generator to Gantry 

ASY-09042 60 Foot Interconnect Cables, Generator to Gantry 

ASY-09054 20 Foot Interconnect Cables, AWS to Generator 

ASY-09055 40 Foot Interconnect Cables, AWS to Generator 

ASY-09056 60 Foot Interconnect Cables, AWS to Generator 

ASY-09057 80 Foot Interconnect Cables, AWS to Generator 

ASY-09058 100 Foot Interconnect Cables, AWS to Generator 
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Appendix D   Use in a Mobile Environment 
D.1  General Information 

This appendix describes the Affirm prone biopsy system installed in a mobile 
environment. 

D.2  Conditions for Safety and Other Precautions 
An acceptable, stable, clean VAC power source is required to make sure that the system 
meets all its performance specifications. Where available, shore power correctly supplied 
to the system provides the best performance. If a mobile power generator is used, you 
must keep the specifications for input power during all load conditions. 

 

 
Caution: 
When shore power is unavailable, mobile power sources that provide equivalent 
performance may be employed. (Refer to Specifications for Mobile Use on page 248.) 
Proper system function and performance can only be ensured if continuous true 
sinusoidal VAC power is supplied per the system power input specifications and 
loading characteristics. Intermittently, the power source must provide 65 Amps at 208 
VAC for a minimum of 5 seconds, and 4 Amps maximum continuous otherwise. This 
load must be supported once every 30 seconds. In the event of shore or mobile power 
service interruption, the UPS must be capable of providing the operational power 
described above for a minimum of 4 minutes. Acquisition Workstation and Gantry 
power must be fed on separate dedicated circuits. The use of an uninterruptible 
power supply with active line conditioner is recommended on each power circuit. 
Accordingly, all ancillary mobile coach power should be distributed by other circuits. 
The electrical installation must be verified to meet system power input specifications 
and IEC 60601-1 safety requirements after initial installation and upon each 
relocation of the mobile coach. 

 

   
 

 
Caution: 
The temperature and humidity inside the vehicle must be maintained at all times. Do 
not allow environmental conditions to exceed stated specifications when the unit is 
not in use. 

 

   
 

 
Caution: 
Voltages cannot change by more than ±10% when the x-ray unit or other equipment 
(for example, heating or air conditioning) is operated. 
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Caution 
To avoid image artifacts from occurring: 
• Do not locate or park the mobile coach near sources of high power (such as 

power transmission lines and outdoor transformers). 
• Make sure that any mobile power generator, uninterruptible power supply 

(UPS), or voltage stabilizer is at least 3 meters (10 feet) from the closest point of 
the image detector travel. 

 

 

   
 

 

D.3  Specifications for Mobile Use 
The following system specifications are for mobile use only. For all other specifications, 
refer to the section Specifications on page 231. 

D.3.1  Shock and Vibration Limits 
 

Vibration Limit Maximum of 0.30 G (2 Hz to 200 Hz), measured at the point 
where the system mounts to the coach. 

Shock Limit Maximum of 1.0 G (1/2 sine pulse), measured at the point 
where the system mounts to the coach. An “air ride” coach 
suspension is recommended. 

 
 

   
 

D.4  Prepare the System for Travel 
 

 

Note 
Start preparing the system for travel with the system power on. (Do not power off the 
system until the C-arm is correctly positioned and supported.) 

 

   

1. Push the footrests fully in. 
2. Raise the patient platform to its full height. 
3. Rotate the biopsy arm to 0 degrees. 
4. From the acquisition workstation, select the table icon in task bar and rotate the tube 

arm to 0 degrees. 
5. Rotate the C-arm to +180 degrees. Raise the C-arm above the height needed to place 

the C-arm cradle in position. 
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6. Put the C-arm cradle into position under the C-arm. Confirm that the cradle is 
correctly seated on the circular mounting block. 

 
Figure 191: Set the C-arm Cradle 

7. A height tool is tethered to the C-arm cradle. Use the height tool to set the C-arm 
height in relation to the patient platform. Put the height tool flat on the tubehead. 
Raise the C-arm until there is no space between the tool and the bottom of the 
platform. Remove the height tool. 

 
Figure 192: Set the C-arm Height with the Height Tool 
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8. Use the height tool to lock the biopsy arm in position. Place the tool on the tube arm 
between the biopsy arm and the tubehead. Make sure to use the hook and loop strap 
for extra support. 

 
Figure 193: Lock the Biopsy Arm with the Height Tool 
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9. Put the footswitch into the footswitch channels in the C-arm cradle and secure with 
the hook and loop strap. 

 

 
Caution: 
Make sure that the footswitch cord is positioned safely to prevent damage from 
being compressed between the C-arm and the C-arm cradle. 

 

   

 
Figure 194: Correct Footswitch Storage 

10. While pressing the C-arm Translate button, push the C-arm in completely toward 
the Gantry. 
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11. Continue pressing the C-arm Translate button and adjust the C-arm as needed while 
lowering the patient platform into the C-arm cradle. The marking on the C-arm 
aligns with the support bracket on the C-arm cradle. 

 
Figure 195: Alignment of Markings on the C-arm with the C-arm Cradle 

12. Lower the work surface on the acquisition workstation to the minimum height. 
13. Shut down the system. 
14. Make sure the x-ray switch is secure in its holder. 
15. Put the mouse in the mouse holder on the right of the keyboard tray (see item 2 in 

the following figure). 
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16. Close and lock the keyboard tray. 

 
Figure 196: Mouse Holder (2) and Keyboard Tray Lock Knob (1) 

 

 
Figure 197: Set the Lock Knob to Locked Position 

17. Release the monitor lock knobs to adjust the monitors for transport. Swivel the 
monitors to center position until the lock knobs lock. Tilt the monitors fully forward 
until the lock knobs lock. 

 
Figure 198: Release the Lock Knobs on the Monitors 
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D.5  Prepare the System for Use 
1. Unlock and adjust the monitors. 
2. Adjust the work surface height of the acquisition workstation. 
3. Unlock and open the keyboard tray. 
4. Remove the mouse from the mouse holder. 
5. Power on the system. 
6. Raise the patient platform to its full height. 
7. Remove the footswitch from the C-arm cradle. Follow all safety requirements when 

positioning the footswitch. 
8. Remove the height tool from the C-arm. Store the height tool in the C-arm cradle. 
9. Remove the C-arm cradle and put in a safe storage area. 

 

D.6  Test the System after Travel 
 

D.6.1  Functional Tests After Travel 
Perform the Functional Tests. Refer to the section Functional Tests. 

• Compression Apply and Release 
• C-arm Up and Down 
• Patient Platform Up and Down 
• Patient Platform Up Limit 

 

D.6.2  Quality Control Tests After Travel 
Perform the Quality Control tests as recommended for the non-mobile Affirm prone 
biopsy system. 
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Appendix E  Technical References 
 

E.1  Center of Gravity Specifications for Gantry 
 

 

 
Figure 199: Center of Gravity for Gantry 

 

Without Patient on Table 

Item Measurement 

A 70.1 cm 27.6 inches 

B 34.8 cm 13.7 inches 

C 62.5 cm 24.6 inches 
 

With Patient on Table (Up to 400 lb.) 

Item Measurement 

1 155 cm 61 inches 

2 62 cm 24.4 inches 

3 90.4 cm 35.6 inches 
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E.2  Center of Gravity Specifications for Generator 
 

 
Figure 200: Center of Gravity for Generator 
 

Item Measurement 

A 33.8 cm  13.3 inches 

B 37.1 cm  14.6 inches 

C 23.6 cm  9.29 inches 

D 27.1 cm 10.7 inches 
 

 

E.3  Center of Gravity Specifications for Acquisition Workstation 
 

 
Figure 201: Center of Gravity for Acquisition Workstation 

 

Item Measurement 
A 59.3 cm  23.4 inches 

B 38.1 cm 15 inches 
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E.4  Electromagnetic Compatibility 
This section provides information about the electromagnetic compatibility of system per 
IEC 60601-1-2. 

 

Table 17: Electronic Emissions 
Electromagnetic Emissions 

The system is intended for use in the electromagnetic environment specified below. The customer or the 
user of the system should assure that it is used in such an environment. 

Emissions Test Compliance Electromagnetic environment - guidance 

RF emissions 
CISPR 11 

Group 1 The system uses RF energy only for its internal function. 
Therefore, its RF emissions are very low and are not 
likely to cause any interference in nearby electronic 
equipment. 

RF emissions 
CISPR 11 

Class A Meets Class A Compliance. 
 

The system is suitable for use in all establishments other 
than domestic, and those directly connected to the 
public low-voltage power supply network that supplies 
buildings used for domestic purposes. 

Harmonic emissions 
IEC 61000-3-2 

Class A 

Voltage fluctuations/ 
flicker emissions 
IEC 61000-3-3 

Complies 
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Table 18: Electromagnetic Immunity Part 1 
Electromagnetic Immunity – Part 1 

The system is intended for use in the electromagnetic environment specified below. The customer or the 
user of the system should assure that it is used in such an environment. 

Immunity Test IEC 60601 Test Level Compliance Level Electromagnetic Environment - 
Guidance 

Electrostatic 
discharge (ESD) 
IEC 61000-4-2  

±6 kV Contact 
±8 kV Air 

±6 kV Contact 
±8 kV Air 

Floors should be wood, concrete, 
or ceramic tile. If floors are 
covered with synthetic material, 
the relative humidity should be at 
least 30%. 

Electrical fast 
transient/ burst 
IEC 61000-4-4 

±2 kV for power supply 
lines 
±1 kV for input/output 
lines 

±2 kV for power supply 
lines 
±1 kV for input/output 
lines 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Surge 
IEC 61000-4-5 

±1 kV line(s) to line(s) 
 
±2 kV line(s) to earth 

±1 kV line(s) to line(s) 
 
±2 kV line(s) to earth 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Voltage dips, short 
interruptions and 
voltage variations 
on power supply 
input lines 
IEC 61000-4-11 

<5% Ut (>95 % dip in 
Ut) for 0,5 cycle 
 
40% Ut (60 % dip in Ut) 
for 5 cycles 
 
70% Ut (30 % dip in Ut) 
for 25 cycles 
 
<5% Ut (>95 % dip in 
Ut) for 5 s 

<5% Ut (>95 % dip in 
Ut) for 0,5 cycle 
 
40% Ut (60 % dip in Ut) 
for 5 cycles 
 
70% Ut (30 % dip in Ut) 
for 25 cycles 
 
<5% Ut (>95 % dip in 
Ut) for 5 s 

Mains power quality should be 
that of a typical commercial or 
hospital environment. If the user 
of the system requires continued 
operation during power mains 
interruptions, it is recommended 
that the system be powered from 
an uninterruptible power supply 
or battery. 

Power Frequency 
(50/60Hz) Magnetic 
Field 
IEC 61000-4-8 

3 A/m 3 A/m Power frequency magnetic fields 
should be at l4evels characteristic 
of a typical location in a typical 
commercial or hospital 
environment. 

NOTE Ut is the a.c. mains voltage prior to application of the test level. 
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Table 19: Electromagnetic Immunity Part 2 

The system is intended for use in the electromagnetic environment specified below. The customer or the 
user of the system should assure that it is used in such an environment. 

Immunity Test EN/IEC 60601 Test 
Level 

Compliance 
Level 

Electromagnetic Environment - Guidance 

 
 
 
 
 
Conducted RF 
IEC 61000-4-6 
 
Radiated RF 
IEC 61000-4-3 

 
 
 
 
 
3 Vrms 
150 kHz to 80MHz 
 
3 V/m 
80 MHz to 2.5 GHz 

 
 
 
 
 
[V1] = 3 V 
 
 
[E1] = 3 V/m 

Portable and mobile RF communications 
equipment should be used no closer to any part 
of the system, including cables, than the 
recommended separation distance calculated 
from the equation applicable to the frequency of 
the transmitter. 
Recommended separation distance: 

 
where P is the maximum output power rating of 
the transmitter in watts (W) and d is the 
recommended separation distance in meters (m). 
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site surveya, 
should be less than the compliance level in each 
frequency rangeb. 
Interference may occur in the vicinity of 
equipment marked with the following symbol: 

 

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies. 
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and 
land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted 
theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an 
electromagnetic site survey should be considered. If the measured field strength in the location in which 
the system is used exceeds the applicable RF compliance level above, the system should be observed to 
verify normal operation. If abnormal performance is observed, additional measures may be necessary, 
such as re-orienting or relocating the system. 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.  
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Table 20: Separation Distances for RF Equipment 
Recommended Separation Distances for Portable and Mobile  

RF Communications Equipment and the system 

The system is intended for use in the electromagnetic environment in which radiated RF disturbances are 
controlled. The customer or the user of the system can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the system as recommended below, according to the maximum output power of the 
communications equipment. 

Rated maximum 
output power of 

transmitter 
W 

Separation distance according to frequency of transmitter 
m 

150 kHz to 80 MHz 

 

80 MHz to 800 MHz 

 

800 MHz to 2.5 GHz 

 

0.01 0.12 0.12 0.23 

0.1 0.37 0.37 0.74 

1 1.17 1.17 2.33 

10 3.7 3.7 7.38 

100 11.7 11.7 23.3 

For transmitters rated at a maximum output power not listed above, the recommended separation distance 
d in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P 
is the maximum output power rating of the transmitter in watts (W) according to the transmitter 
manufacturer.  
 
NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people. 
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E.5  Leakage Radiation 
All important x-ray safety features meet 21 CFR, Chapter I, 1020.31, IEC 60601-1-3, and 
IEC 60601-2-45. 

Typical values of x-ray leakage shown are in one hour at a distance of 1 meter from the 
tube focal spot, at maximum kVp, and adjusted for a maximum in use duty cycle of 
0.027. 

Duty cycle comes from a maximum throughput of 12 patients per hour x 4 exposures, or 
48 exposures per hour with a maximum exposure time of 2 seconds. 

The meter measures x-ray leakage in units of mR. The meter reading for a single 2 second 
exposure is multiplied by the total number of exposures per hour to get the correct 
leakage value (Reading for single exposure x 48) and is compared with the maximum 
allowed criteria of 100 mR in one hour. 

 
Figure 202: Leakage Radiation 
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E.6  List of Fuses 
These fuses are located on the Generator fuse panel, on the individual boards in the 
Gantry, and in the Acquisition Workstation. 

Table 21: Fuses 
Description Fuse Rating Circuit Part No. 

Generator Fuse Panel 

 F14 FB 30A 600V 600 VDC Rail 1-070-1119 

 F10, F11 SB 3A 250V Sec 120 VAC 1-070-1076 

 F8, F9 SB 12A 250V Sec 65 VAC 1-070-1327 

 F6, F7 SB 10A 250V Sec 24 VAC 1-070-1275 

 F4, F5 SB 10A 250V Sec 24 VAC 1-070-1275 

 F12, F13 SB 1.5A 250V 3AG Line (PRI) 1-070-1263 

 F15 40A 600V Sec 380 VAC CKB-00027 

 F16 40A 600V Sec 380 VAC CKB-00027 

Gantry Board Fuses 

PCB-01005 F1 1.5A SB 2AG Tubehead Microprocessor 
Board 

1-070-1245 

PCB-00183 F2 10A SB 250V 3AG Power Distribution Board 1-070-1275 

F3 10A SB 250V 3AG  1-070-1275 

F4 0.125A 250V 2AG  1-070-1220 

PCB-00964 F1 1/2A SB 2AG Remote X-ray control 1-070-1242 

PCB-00989 F2 4A SB 2AG Tube Arm Control 1-070-1246 

PCB-01038 F1 3A SB 2AG Stage Arm (Biopsy Arm) 
Control 

1-070-1248 

PCB-00923 F1 4A SB 2AG VTA Control Board 1-070-1250 

PCB-01197 F1 4A SB 2AG Compression Arm Power 1-070-1250 

PCB-00110 
 

F1 FB 25A 600V HV Inverter Drawer 1-070-1118 

F2 FB 8A 600V HV Inverter Drawer - Rotor 1-070-1112 

PCB-00158 F1 0.1A 600V Fast 
Acting Cartridge 

Fast Bleed - Capacitor and 
Bridge Assembly 

CKB-00025 
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Table 21: Fuses 
Description Fuse Rating Circuit Part No. 

Acquisition Workstation Fuses 

ASY-09400 F1 2.5A 250V SB 
3AG 1/4X1-1/4 

AWS Isolation Transformer 1-070-1266 

 F2 2.5A 250V SB 
3AG 1/4X1-1/4 

 

 
 

E.7  PCB Jumpers and LED Configurations 
 

Table 22: Jumper Configuration 
PCB Assembly Jumpers installed Jumpers not installed 

PCB-00918 JP1 JP2 

PCB-00923 JP1 JP2, JP3, JP4, JP5 

PCB-00944 JP1, JP2 JP3 

PCB-00964 JP1 JP2, JP3 

PCB-00989 JP1 JP2, JP3 

PCB-01005 JP1 JP2, JP3, JP4 

PCB-01038 JP1 JP2, JP3 

PCB-01197 JP1  
 

Table 23: LED Information 
PCB 
Assembly 

Run LED Fault LED +3.3V +5V +15V +24V +90V 

PCB-00918 D17 D16 D19 D58 D59   

PCB-00923 D15 D16 D4 D58 D59 D41 D2 

PCB-00944 D1 D2      

PCB-00964 D5 D6 D15 D13    

PCB-00989 D10 D11 D28 D27 D36 D24 D30 

PCB-01005 D2 D1 D2 D5  D1  

PCB-01038 D21 D20 D20 D19 D25   

PCB-01197      D1  
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Appendix F   Checklists and Forms 
Make copies of these checklists and forms for your use during installation and 
maintenance. 

F.1  Installation and Preventive Maintenance Checklist 
The following checklist forms represent the individual pages taken from the Affirm 
Prone System Maintenance Report PDF form (CSD-0042-F20). 

To access the latest electronic version of this PDF form: 

1. From the Hologic intranet (myhologic.com), go to More Links > BigTinCan - Hub. 
2. Navigate to Content > Affirm Prone Biopsy System > Reference Material. 
3. Locate and open the Affirm Prone System Maintenance Report. 

 

F.1.1  Checklist Forms 
 

Appendix F 
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F.2  Compliance Forms 
 

F.2.1  Tube Current/Exposure Time Product Forms 
 

 

Table 24: Tube Current Exposure Time Product Expected Results 
mA 

Setting 
mAs 

Setting 
mAs 

Reading 
at 25kV 

mAs 
Reading 
at 30 kV 

mAs 
Reading 
at 35 kV 

mAs 
Reading 
at 40 kV* 

mAs 
Reading 
at 45 kV* 

mAs 
Reading 
at 49 kV* 

Minimum 
Permitted 

mAs 

Maximum 
Permitted 

mAs 

50 10       9.0 11.0 

100 100       90 110 

150 200       180 220 

200 400       360 440 

170 160       144 176 

150 140       126 154 

140 140       126 154 

200 500       450 550 

*Using Tomo setting 
 
 

 

F.2.2  Peak Tube Potential Form 
 

Table 25: Peak Tube Potential Form  
kVp mA 

Setting 
mAs Setting Tube Voltage 

(kV) 
Minimum 
Permitted 

kV 

Maximum 
Permitted kV 

20 100 100  19.00 21.00 

25 100 100  23.75 26.25 

30 150 200  28.50 31.50 

35 200 400  33.25 36.75 

39 200 400  37.05 40.95 

40* 170 160  38.00 42.00 

45* 150 140  42.75 47.25 

49* 140 140  46.55 51.45 

*Using Tomo setting 
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F.2.3  Linearity Form 
 

 

Table 26: Linearity Expected Test Results 
mAs 

Setting 
mAs Meter 

Reading 
mR 

Quotient 
mR / 
mAs 

Difference [ABS] 
 (Previous Quotient 

- This Quotient) 

Sum 
(Previous Quotient 

+ This Quotient) 

Difference 
/ Sum 

10       

12.5       

16       

20       

32       

50       

100       

200       

320       

400       

500       
 

 

F.2.4  Reproducibility Form 
 

Table 27: Reproducibility Form 
 Meter Reading mR (mR - Mean mR)2 

9 
Test Results: 

1   Standard Deviation 
(/(Sum of Quotients)) 2   

3   

4   

5   

6   Coefficient of 
Variation 

(Std.Dev./Mean mR) 
7   

8   

9   

10   

 Sum (mR Readings) Mean mR (Sum/10) Sum of Quotients 
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Appendix G  Biopsy Arm Hardware Range Calibration 
 

G.1  Hardware Range Calibration 
Perform the hardware range calibration when you replace components in the Biopsy 
Guidance Module, or you cannot reach points specified in the STX calibration. The 
hardware range calibration ensures that the X-axis and Y-axis encoder pots are 
mechanically aligned with the mid-point of the drive screws for the respective X-axis and 
Y-axis assemblies. 

 

G.2  Required Tools 
• Stage Arm (Biopsy Arm) Alignment Dowel Pin (MME-01182) - used for mechanically 

aligning the X-axis and Y-axis encoder pots 
• Digital Multimeter (DMM) - used to find the electrical midpoint of the X-axis and Y-

axis encoder pots 
• CalTool 

 

G.3  Cover Removal to Gain Access 
1. Rotate the Biopsy Control Module so it is perpendicular to the C-arm. 
2. Shut down the system. 
3. Remove the following covers: 

• Biopsy Arm front-end cover (refer to Remove Front-end Cover of Biopsy Control 
Module on page 192)  

• Biopsy Arm rear-end cover (refer to Remove Rear-end Cover of Biopsy Control 
Module on page 193) 

• Biopsy Control Module display covers (both sides, refer to Remove 
Displays/Covers of Biopsy Control Module on page 190 ) 

• Biopsy Control Module display bottom cover (refer to Remove Bottom Cover of 
Biopsy Control Module Display on page 194) 
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G.4  Mechanically Aligning the X-Axis and Y-Axis Encoder Pots 
1. Insert the dowel pin (MME-01182) into the center alignment hole for the X-axis 

assembly (see following figure). 

 
Figure 203: Dowel pin in center alignment hole for X-axis assembly 
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2. With a screwdriver, turn the slotted end of the drive screw for the X-axis assembly 
(see following figure, item 2) so the X-axis dowel pin drops into the center alignment 
slot. (The previous figure shows the X-axis assembly in the center position with the 
dowel pin dropped in the center alignment slot.) 

 
Figure 204: Y-axis assembly drive screw (1), X-axis assembly drive screw (2) 

 
 

 
Caution: 
Do not force the shaft to turn while the dowel pins is in the alignment slot. Doing so 
may cause the X-axis drive gear to become loose and slide off the end of the shaft.  
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3. Locate the X-axis encoder pot (see following figure, item 1). Loosen the setscrew and 
remove the anti-backlash gear (see following figure, item 2) from the pot shaft. 

 
Figure 205: X-axis encoder pot (1) with anti-backlash gear (2) 
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4. Disconnect the harness for the X-axis encoder pot from the Biopsy Module Motor 
Drive Board and do the following (see following figure): 

a. Place the DMM leads on Pin 1 and Pin 3 of the encoder pot and measure the full 
resistor value on the ohms scale. 

b. Keep one lead on Pin 1 and place the other lead on Pin 2. Turn the encoder pot 
shaft so the DMM reads ½ of the measured full resistor value. 

c. Keep one lead on Pin 2 and place the other lead on Pin 3. The DMM measured 
value should be within +/- 0.02 of the value found in substep b. If it does, this 
location represents the center position for the pot. 

d. Repeat substeps a to c if necessary to get the proper readings. 

 
Figure 206: Location of pins 2, 1, and 3 on X-axis encoder 

 

5. Reconnect the harness for the X-axis encoder pot. 
6. Reinstall the anti-backlash gear on the pot shaft. Make sure that you rotate and 

engage the gear three-teeth in the process and tighten the setscrew. The X-axis 
encoder pot should now be aligned. 

7. Remove the dowel pin from the X-axis center alignment hole. 
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8. Insert the dowel pin into the center alignment hole for the Y-axis assembly (see 
following figure). 

 
Figure 207: Dowel pin in center alignment hole for Y-axis assembly 
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9. With a screwdriver, turn the slotted end of the drive screw for the Y-axis assembly 
(see following figure, item 1) until you can push the dowel pin with your finger into 
the center alignment slot. (The previous figure shows the Y-axis assembly in the 
center position with the dowel pin pushed in the center alignment slot). 

 
Figure 208: Y-axis assembly drive screw (1), X-axis assembly drive screw (2) 
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10. Locate the Y-axis encoder pot (see following figure, item 1). Loosen the setscrew and 
remove the anti-backlash gear (see following figure, item 2) from the pot shaft. 

 
Figure 209: Y-axis encoder pot (1) with anti-backlash gear (2) 
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11. Disconnect the harness for the X-axis encoder pot from the Biopsy Module Motor 
Drive Board and do the following (see following figure): 

a. Place the DMM leads on Pin 1 and Pin 3 of the encoder pot and measure the full 
resistor value on the ohms scale. 

b. Keep one lead on Pin 1 and place the other lead on Pin 2. Turn the encoder pot 
shaft so the DMM reads ½ of the measured full resistor value. 

c. Keep one lead on Pin 2 and place the other lead on Pin 3. The DMM measured 
value should be within +/- 0.02 of the value found in substep b. If it does, this 
location represents the center position for the pot. 

d. Repeat substeps a to c if necessary to get the proper readings. 

 
Figure 210: Location of pins 3, 1, and 2 on Y-axis encoder 

 

12. Reconnect the harness for the Y-axis encoder pot. 
13. Reinstall the anti-backlash gear on the pot shaft. Make sure that you rotate and 

engage the gear three-teeth in the process and tighten the setscrew. The Y-axis 
encoder pot should now be aligned. 

14. Remove the dowel pin from the Y-axis center alignment hole. 
15. Replace the: 

• Biopsy Control Module display bottom cover 
• Biopsy Control Module displays (both sides) 
• Biopsy Arm front-end cover  
• Biopsy Arm rear cover 
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Appendix H   Biopsy Device Validation Using Targeting 
Phantom 

 

H.1  Introduction 
This appendix provides information for validating biopsy devices from manufacturers 
other than Hologic factory-verified devices listed in the table on page 296. The procedures 
in this appendix are written for use with the Hologic ASY-08307 Targeting Phantom. 

 
Figure 211: Hologic ASY-08307 Targeting Phantom 

 

H.1.1  Please Read Prior to Performing Calibration 
These procedures are designed to be used in conjunction with (not to replace) the 
procedures in the Affirm Prone Biopsy System Service Manual and User Guide, as well 
as the procedures in the User Guide of any biopsy device that is used with the Affirm 
system. These procedures provide step-by-step instructions for validating biopsy devices 
for use with the Affirm Prone Biopsy System. 

The validation procedures shall only be performed by those who have received training 
on the Affirm Prone Biopsy System before use on patients. Hologic training programs 
address the MQSA training requirements for any Technologist or Physician. Hologic will 
bear no risk for the use of the Affirm Prone Biopsy System with biopsy devices that have 
not been validated using the procedures outlined herein, and does not accept 
responsibility for injury or damage from incorrect system operation. 

Appendix H 
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H.2  Hologic Factory-Verified Biopsy Devices 
   

Table 28: Hologic Factory-Verified Biopsy Devices 

Manufacturer Description Model 

Hologic Affirm QAS Needle ASY-03949 

Hologic ATEC® 9 g x 12 cm, 12 mm (Petite) ATEC 0912-12 

Hologic  ATEC 9 g x 12 cm, 20 mm ATEC 0912-20 

Hologic ATEC 12 g x 12 cm, 20 mm ATEC 1212-20 

Hologic ATEC 9 g x 9 cm, 12 mm (Petite) ATEC 0909-12 

Hologic ATEC 9 g x 9 cm, 20 mm ATEC 0909-20 

Hologic ATEC 12 g x 9 cm, 20 mm ATEC 1209-20 

Hologic ATEC 9 g x 14 cm, 20 mm ATEC 0914-20 

Hologic Brevera® 9 g x 13 cm, 20 mm (Standard) or 
12 mm (Petite) 

BREV09 

Hologic Eviva® 9 g x 13 cm, 12 mm (Blunt Petite) Eviva 0913-12 

Hologic Eviva 9 g x 13 cm, 12 mm (Trocar Petite) Eviva 0913-12T 

Hologic Eviva 9 g x 13 cm, 20 mm Eviva 0913-20 

Hologic Eviva 12 g x 13 cm, 20 mm Eviva 1213-20 

Hologic Eviva 9 g x 10 cm, 12 mm (Blunt Petite) Eviva 0910-12 

Hologic Eviva 9 g x 10 cm, 12 mm (Trocar Petite) Eviva 0910-12T 

Hologic Eviva 9 g x 10 cm, 20 mm Eviva 0910-20 

Hologic Eviva 12 g x 10 cm, 20 mm Eviva 1210-20 
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H.3  Configuring Device and Needle 
 

H.3.1  Add or Edit Biopsy Device Information 
Whether you add a new (or edit an existing) biopsy device, keep each parameter within 
the valid range as stated in the following table. If you believe that a parameter for your 
device is outside the valid range, contact Hologic Technical Support desk for guidance on 
how to proceed. 

Table 29: Biopsy Device Parameters (see also following parameters diagrams) 
Name Description Valid Range 

(in mm) 

Aperture Opening of the biopsy device 0 to 50.0 

Dead Space Distance from needle tip to opening-edge 0 to 20.0 

Needle Diameter Outside-to-outside distance of biopsy device, 
assuming biopsy device is cylindrical 

0 to 25.00 

Needle Front The length from the alignment pin to the front-most 
point of the needle guide (when the needle guide is in 
its most retracted position) 

0 to 120.0 

Needle Length Length of needle, measured from Biopsy Guidance 
Module Locality pin to needle tip in post-fire position 

160 to 300.0 

Needle Offset Needle Offset, measured from Biopsy Guidance 
Module surface to center of needle cylinder 

0.01 to 100.0 

Needle Width The width of the needle body with adapter installed. 
(With some models, the adapter is wider than the 
needle and you need to include this added width as 
part of the needle width dimension.) 

0 to 60.0 

Pre-Fire Pullback Distance between target and pre-fire position of 
aperture center 

-30.0 to 30.0 

Stroke Distance between needle tip position before and after 
firing biopsy device, measured along firing-axis 

0 to 30.0 
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Items to remember 

• Data entry accepts any information. Make sure entries stay within the valid range for 
each parameter. 

• A validity check (range limit met) is not performed immediately upon entry, but only 
after the biopsy device is selected in the Procedure screen. If a parameter is outside 
the range when the needle is selected in a procedure, a Targeting Failed because the 
system has been configured with invalid biopsy device parameters error displays. 

• The stereo pair using the QAS needle acquired in the first steps of this procedure is 
used throughout the procedure. You are closing the patient and returning to the 
patient throughout. Always close "In Progress".  

• It is critically important that the phantom not move during this procedure. Do not 
release compression on the phantom, as that may cause the phantom to move. If the 
phantom moves, the procedure must be restarted. 

• It is important to know how your device operates. When the procedure states that 
the device should be in the extended (post-fire) position, it is assumed the devices are 
in their maximum extended position. However, some devices in the post-fire position 
retract slightly when the aperture is opened. In this case, the aperture should be 
closed for the device to be in their maximum extended position. 

 

 
Figure 212: Biopsy Device Parameters (Diagram 1) 
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Figure 213: Biopsy Device Parameters (Diagram 2) 

 

 
Figure 214: Biopsy Device Parameters (Diagram 3) 
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Figure 215: Biopsy Device Parameters (Diagram 4) 
 
 

 

H.3.2  Needle Validation Process 
 

 

 

Note 
All manual jogs in the following procedure are performed from the Biopsy Control 
Module Target Screen, not from the Service Screen. (This screen affects the target 
numbers.) The Jog is used to move the needle (and target) away from the phantom 
tip, which prevents a collision of the needle tip and phantom tip. This method also 
conveniently provides intuitive results without having to correct for the Jog 
movement. 

 

 
 
 

 

Verify the System is Correct for a Known Needle 
1. Sign on to the Acquisition Workstation as a Service User. 
2. Install a biopsy Compression Paddle. 
3. Position the Targeting Phantom on the breast tray and center it in the Biopsy Paddle 

window (does not have to be exact). 
4. Compress the Targeting Phantom with ~10 pounds/~45 newtons of force. 

IMPORTANT: Do not move the phantom for the remainder of this procedure. 
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5. Install the QAS needle in the extended position. 
6. At the Biopsy Control Module, select a Home position and press and hold the front 

and back Motor Enable buttons. 
7. At the Acquisition Workstation, create a Biopsy test patient. Select a name that is 

easy to remember as you are exiting and entering this patient throughout this 
procedure. 

8. Select Stereo Pair. 
9. Acquire and accept a stereo image pair of the validation phantom using 25 kVp at 

12 mAs. 
10. Select the QAS needle at the Acquisition Workstation. 

 

QAS Needle Verification Procedure 
1. Target on the tip of the needle (not the center of the ball) in each of the two stereo 

images, and then select Accept (Create) Target. 
2. At the Biopsy Control Module, press and hold the Motor Enable buttons to move to 

the target. 
3. Select the Jog button, then the Jog away from the chest wall once. Press and hold the 

Motor Enable buttons. This essentially moves the "target" 0.5 mm away from the 
phantom tip to allow easier positioning of the QAS needle tip. It also avoids a 
collision between the QAS tip with the phantom tip. 

4. Move the Z down to so that the tip of the QAS needle is at the same level as the tip of 
the phantom. 

5. Visually verify the alignment of X and Y. If X or Y appears to be off, press Motor 
Enable to be sure that the motorized movement was completed. Do not make any 
other adjustments. Do not move the phantom. 

6. Inspect the Diff line for ± 1 mm (maximum) X, Y, and Z values on the Biopsy Control 
Module. 

7. Raise the Z and carefully remove the QAS Needle. Do not move the compression or 
the phantom. 

8. Close the procedure "In Progress". 
• To configure a "New" needle, proceed to Obtain Needle Specifications on page 302. 
• To edit an existing needle, proceed to Edit Information for an Existing Biopsy Device 

on page 303 
• To validate an existing needle, proceed to Validate Needle on page 304. 
• To configure a new Wire Localization needle, proceed to Validate Needle on page 

307, "Validate the Wire Localization Needle" on page 305. 
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Configure a New Biopsy Needle 

Obtain Needle Specifications 
1. Record the following technical details from the biopsy device manufacturer: 

Needle Name ______________________________ 

Aperture ______________________________mm 

Dead Space ______________________________mm 

Diameter ______________________________mm 

Length x 2 ______________________________mm 

Per-Fire Pullback (calculate by 
adding dead space + 1/2 aperture, 
then subtract the stroke)  

______________________________mm 

Stroke ______________________________mm 

2. Measure the Offset parameter with the device in the extended (or post-fire) position. 

a. Install the fired device in the holder, and place the holder on a flat surface. 

b. Measure from the flat surface to the estimated center of needle barrel (see the 
following figure). Offset =_____________mm. 

 
Figure 216: Offset Measurement, Device in Extended (post fired) Position 

3. Add a (new) biopsy device to the Acquisition Workstation. 

a. Select Admin; then in the System section, select Biopsy Devices. 

b. Select New. 

c. Enter "0" for Aperture and Dead Space. 

This setting allows the reference to be the needle tip (instead of the center of the 
aperture) for determining accurate needle length (NL). 

d. Enter the remaining biopsy device parameter information. See the table on page 
297 for valid parameter ranges. 

e. Select Add. The measurements are now available on the Acquisition 
Workstation. 
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Edit Information for an Existing Biopsy Device 
1. Select Admin; then in the System section, select Biopsy Devices. 
2. Select the biopsy device from the list. 
3. Select Edit. 
4. Enter "0" for Aperture and Dead Space. 
5. Edit any other parameters for the selected biopsy device as needed. See the table on 

page 297 for valid parameter ranges. 
6. Select Save. The measurements are now available on the Acquisition Workstation. 
7. Continue with Calculate New Needle Parameters. 
 
 

 

Calculate New Needle Parameters 
1. Open the same procedure used earlier with the QAS needle. 
2. Select the same stereo pair acquired earlier. 
3. Select the new Device from the list. 
4. Select OK at the warning message Target outside biopsy aperture. 
5. Select Resend Target. 
6. At the Biopsy Control Module, press and hold the Motor Enable buttons to move to 

the target. 
7. Install the new Needle Guide and device in the extended (post-fire) position. 
8. Jog 0.5 mm away from the chest wall. 
9. Move the Z down to align the needle tip at the same height as the tip of the Phantom 

pin. 
10. Note the Z Diff from the Biopsy Control Module. This number is adjusted to the 

previously entered length in the Acquisition Workstation Biopsy Devices menu in 
the next procedure. 

11. At the Acquisition Workstation, close the patient "In Progress". 
 

Adjust the Needle Length at the Acquisition Workstation 
1. Select Admin; then in the System section, select Biopsy Devices. 

a. Select the Biopsy Device in the list. 

b. Select Edit. 

c. Calculate the "Length". 

       Length = Manufacturer Length x 2 +/- Z Diff 
Length was recorded earlier in Obtain Needle Specifications. 
Z Diff was noted earlier in Calculate New Needle Parameters. 

2. Enter the new calculate Length as the "Length". 
3. Replace the previously entered "0" for the Aperture and Dead Space with the values 

from the manufacturer for Aperture and Dead Space as recorded in Obtain Needle 
Specifications. 

4. Select Save. 
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Validate Needle 
1. Open the same procedure used earlier with the QAS needle and select the previously 

acquired stereo pair. 
2. Select the Device from the list. 
3. Select Resend Target. 
4. If necessary, remove the device and reinstall with the aperture opened. 
5. On the Biopsy Control Module, press and hold Motor Enable until the X and Y 

motion stops. 
6. Jog in 0.5 steps 2 mm away from the chest wall (four steps). 
7. Move the Z knob until the tip of phantom pin is aligned with the center of the biopsy 

needle aperture. 
8. Jog back towards the chest wall the same amount you moved away from the chest 

wall in the earlier step. 
9. Confirm that the X Diff, Y Diff, and Z Diff value reads ±2.0 mm maximum (The 

system and the new needle each contribute 1.0 mm.) 
• If the ‘X’ target value is not correct, recheck the Needle Guide alignment. 
• If the ‘Y’ target value is not correct, recheck the Offset measurement. 
• If the ‘Z’ target value is not correct, recheck needle length, Aperture, and Dead 

Space values. Note: Some Needle Core Biopsy devices retract the biopsy needle tip in the 
pre-fire (open aperture) position. For these devices, the Z diff value may exceed ±2 mm. 
This value is acceptable provided the phantom pin tip lies within the middle one-third of 
the aperture. 

10. Jog the needle away from the chest wall before removing the needle. 
 

 

Note 
Loaner biopsy devices require revalidation. Use professional judgment to 
determine needle validation. Be aware of any changes in devices by 
vendors. 

 

 
 

 

Note 
If you are validating a Wire Localization Needle, also perform the steps in 
Validate the Wire Localization Needle. 
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H.4  Configuring the Wire Localization Needle 
 

H.4.1  Validate the Wire Localization Needle 
 

 

 

Note 
Do not validate needles 7.5 cm or shorter. 

 

 

1. Record the following technical details from the biopsy device manufacturer (all in 
mm): 
• Needle Name ___________________________ 
• Diameter ___________________________mm 
• Length x 2_____________________________mm 

2. Measure the following parameters with the needle installed in the holder. 
Offset 

a. Install the needle in the holder, and place the holder on a flat surface. 

b. Measure from the flat surface to the estimated center of the needle barrel. 
_______________mm 

 
Figure 217: Adapter Surface to the Center of Needle Barrel 

 

Length 

 
Figure 218: Length Measurement 

3. Select Admin; then in the System section, select Biopsy Devices. 
4. Select New. 
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5. Enter the following values; leave all other fields at 0.0: 
• Name 
• Enabled (confirm box is checked) 
• Diameter 
• Length x 2 
• Offset (calculated earlier) 

6. Check the Needle Localization check box. 
7. Select Add. The measurements are now available on the Acquisition Workstation. 

 

H.4.2  Calculate and Confirm the New Wire Localization Needle Parameters 
1. Open the procedure used with the QAS needle, and select the stereo pair. 
2. Select the new Device from the list. 
3. Select Resend Target. 
4. At the Biopsy Control Module, press and hold the Motor Enable buttons to move to 

the target. 
5. Install the new Needle Guides and needle. 
6. Move the Z down to align the tip of the needle with the tip of the Phantom Pin. 
7. Read the Z Diff from the Biopsy Control Module. This number is adjusted to the 

previously entered Length in the Acquisition Workstation Biopsy menu in the next 
procedure. 

         Length = Manufacturer Length x 2 +/- Z Diff 
Length was recorded earlier in Obtain Needle Specifications. 
Z Diff was noted earlier in Calculate New Needle Parameters. 

8. At the Acquisition Workstation, close the patient "In Progress". 
 

H.4.3  Adjust the Needle Length on the Acquisition Workstation 
1. Select Admin; then in the System section, select Biopsy Devices. 

a. Select the Wire Loc needle in the list. 

b. Select Edit. 

c. Enter the new calculate Length in the length field. 

2. Select Save. 
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H.4.4  Validate Needle 
1. Open the procedure used earlier with the QAS needle, and select the previously 

acquired stereo pair. 
2. Select the needle from the list. 
3. Select Resend Target. 
4. At the Biopsy Control Module, press and hold the Motor Enable buttons to move to 

the target. 
5. Move the Z down to align the tip of the needle with the tip of the Phantom Pin. 
6. On the Biopsy Control Module, confirm that the X Diff, Y Diff, and Z Diff value reads 

±2.0 mm. (The system and the new needle each contribute 1.0 mm.) 
• If the ‘X’ target value is not correct, recheck the Needle Guide alignment. 
• If the ‘Y’ target value is not correct, recheck the Offset measurement. 
• If the ‘Z’ target value is not correct, recheck needle length (refer to Calculate and 

Confirm the New Wire Localization Needle Parameters on page 306). 
 

 

Note 
Loaner biopsy devices require revalidation. Use professional judgment to determine 
needle validation. Be aware of any changes in devices by vendors. 
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10:  Glossary of Terms 
ACR 
American College of Radiology 

AEC 
Automatic Exposure Control 

BCM 
Biopsy Control Module 

Collimator 
A device at the x-ray tube to control the x-ray 
beam exposure area. 

DICOM 
Digital Imaging and Communications in Medicine 

EMC 
Electromagnetic Compatibility 

Image Receptor 
Assembly of the x-ray detector and carbon fiber 
cover. 

Lateral Needle Approach 
Biopsy device approach that is parallel to the 
imaging plane and perpendicular to the plane of 
compression. 

MQSA 
Mammography Quality Standards Act 

PACS 
Picture Archiving and Communications System. A 
computer and network system that transmits and 
archives digital medical images. 

ROI 
Region of Interest 

SID 
Source to Image Distance 

Standard Needle Approach 
Biopsy device approach that is parallel to the 
plane of compression and perpendicular to the 
imaging plane. 

Stereo Pair 
The stereotactic image pair acquired from the ±15° 
projections. 

Stroke 
Excursion of needle when the biopsy instrument is 
fired. The Stroke is entered into the system and 
depends on the instrument used. Each instrument 
has a specified stroke. 

Stroke Margin 
The safety margin (in mm) which remains 
between the fired needle position and the breast 
platform. This margin is calculated by the system 
according to the "Z" coordinate, the Stroke, and 
the compression amount. 

Tomosynthesis 
An imaging procedure that combines a number of 
breast images taken at different angles. The 
tomosynthesis images can be reconstructed to 
show focal planes (slices) within the breast. 

UPS 
Uninterruptible Power Supply 

X-axis 
Refers to the horizontal plane across the biopsy 
window. When the Needle Guidance Stage moves 
left of the reference point, the movement in the X 
direction is negative. When the stage moves right 
of the reference point (from the point of view of 
the patient), the movement is positive. 

Y-axis 
Refers to the vertical plane directly above the 
biopsy window. When the Needle Guidance Stage 
moves away from the reference hole (from the 
point of view of the chest wall edge of the biopsy 
paddle), the Y direction movement increases in 
value. When the Stage moves toward the reference 
hole, Y decreases in value. 
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Z-axis 
Refers to the depth through the biopsy window. 
The value of Z increases as the Stage moves 
toward the breast platform, and decreases as the 
stage moves away from the platform. 
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Index 
A 
Acquisition Workstation (AWS) 

cart, monitor arm weight rating - 236 
cart, weight rating - 236 
controls - locations illustrated - 78 
maintenance - overview - 223 

Admin screen, description of buttons and 
functions - 84 

AEC function performance test - 149 
alerts and messages, system - 237, 240 
artifact evaluation test - 149 

B 
Beam Quality Half Value Layer 

test - 143 
Biopsy Arm 

Biopsy Arm hardware range calibration 
- mechanically aligning X-axis and Y-axis 

encoder pots - 286 
- overview - 285 
- required tools - 285 
cover removal - 285 

Motor Drive Board, remove/replace - 197 
motor enable button - location illustrated - 74 
remove top cover - 191 

Biopsy Control Module 
remove bottom cover - 194 
remove displays/covers - 190 
remove front-end cover - 192 
remove rear-end cover - 193 
touchscreen display - locations illustrated - 74 

biopsy device 
validation 

biopsy device validatiion - Please Read 
Prior to Performing Calibration - 295 

biopsy device validation - overview - 295 
biopsy guidance hardware reference points - 152 
body calibration 

front needle guide alignment - 151 
geometry procedure - 152 
interaction - 159 
overview - 150 

Quality Assurance Standard (QAS) test - 159 
required tools and equipment - 150 
STX calibration - 159 

Breast Entrance Exposure, AEC Reproducibility, 
and Average Glandular Dose test - 149 

C 
cables, interconnect - listed - 245 
capabilities of Affirm system - 2 
C-arm 

controls and displays - 74 
dimensions/measurements - 231 
maintenance - overview - 179 
major serviceable components - 180 
overview - illustrated - 8 
Tubehead technical specs - 233 

Cautions, Warnings, and Notes - definition of each 
- 6 

circuit breaker of Generator - location illustrated - 
73 

compliance 
compliance requirements - 13 

compression 
Compression Apply/Release buttons - 

illustrated on Footswitch - 76 
Compression Arm Control Board, 

remove/replace - 199 
Compression Arm, remove rear-end cover - 

189 
remove Detector-end cover - 188 

Computer of AWS, remove/replace - 228 
contraindications - 1 
Control Display Monitor of Acquisition 

Workstation (AWS) 
location illustrated - 78 
remove/replace - 225 

Control Handle of Support Arm 
buttons illustrated and described - 76 
location illustrated - 74 

controls 
Acquisition Workstation - locations illustrated 

- 78 
C-arm - locations illustrated - 74 

cybersecurity statement of Hologic - 4 



Affirm Prone Biopsy System Service Manual 
Index 
 

 
Page 312 MAN-04482 Revision 006 
 

D 
Detector (Image Detector) of Compression Arm 

remove/replace - 207 
specifications - 235 

DVD/CD drive of Acquisition Workstation - 
location illustrated - 78 

E 
electrical input specifications for Generator/Gantry 

and Acquisition Workstation (AWS) - 233 
emergency OFF 

emergency OFF switches (E-Stop) of C-arm - 
locations illustrated - 74 

emergency OFF switches (E-Stop) throughout 
entire system - description - 13 

emergency OFF/X-ray Activation (E-Stop) 
handheld remote of Acquisition 
Workstation - location illustrated - 78 

environment 
general conditions for operation - 232 
general conditions for transport and storage - 

232 
error recovery and troubleshooting, about such 

messages - 237 

F 
Field Replaceable Units (FRUs) - 241 

Parts List, Replaceable - 241 
Filter Wheel Assembly of Tubehead Arm 

Mechanism, remove/replace - 196 
footswitch controls - illustrated - 76 
forms 

Linearity form - 284 
Peak Tube Potential form - 283 
Reproducibility form - 284 
Tube Current/Exposure Time Product forms - 

283 
fuses, list of - 262 

G 
Gantry 

dimensions/measurements - 231 
Gantry/Patient Platform/C-arm, maintenance - 

overview - 179 

major serviceable components - 180 
Generator 

covers removal - 169 
dimensions/measurements - 231 
maintenance - overview - 167 
major serviceable components - illustrated - 

168 
guidance space-target space transform calibration 

- 151 

H 
height, full (Up limit) button for Patient Platform 

(location illustrated) - 77 
High Voltage Multiplier Assembly of Generator, 

remove/replace - 174 

I 
Image Detector of Compression Arm 

remove/replace - 207 
specifications - 235 

Image Display Monitor of Acquisition 
Workstation (AWS) 

location illustrated - 78 
remove/replace - 225 

indications for use - 1 
installation 

exam room layout - 27 
install Acquisition Workstation (AWS) - 54 

configure Isolation Transformer of 
Acquisiiton Workstation (AWS) - 54 

connect Acquisition Workstation cables - 
56 

install Gantry/Patient Platform Assembly - 28 
install armrest - 35 
install footswitch - 36 
install Gantry cables - 37 
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